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Perspective Editions

The chart below summarizes the Perspective features available by edition. For more information on the edition
you're currently running, check your licensing.

Features

Activity Reporting v v v v v v v
Incident Reporting v v v v v v v
Dispatch v v v v
Investigation & Case Management v v v v
Visual Analysis vE v v v v v v
Reporting, Trending & Analysis Tools v v v v v v v
Track losses and financial impact v v v v v v v
Report incidents in a Web Portal v v'E v 7% v v’ v
View metrics with Dashhoard v v v v v v v
Google-like search v v v v v v v
Visualize information on a map v v v v v v v
i0S App v v v v v v v
System configuration v v v v v v v
Workflows v A vE v'E v v v
Open API v v v v v v v
Officer Mobile v'F v v v'E

*0pt In for Additional Cost

m © Resolver Inc. Confidential. Do not distribute. Page 1 of 350
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Welcome to Perspective by Resolver

Welcome to Perspective by Resolver™, the industry leader in Incident Reporting and Investigation
Management software. Perspective by Resolver is an end-to-end Incident Management solution that
covers everything from response and documentation, through to investigation, and analysis. You can
intelligently action and query your data for trending, risk mitigation, and planning. Then, with the ability
to assess what's happening and its potential impact, you can make informed decisions that optimize
performance, and illustrate the effectiveness of your security operation.

This guide was designed for day-to-day users of Perspective. For information about using the
Administration component, see the Perspective Administrator's Guide on the Resolver Support site.

Accessing Perspective

1. Ensure Compatibility View is turned off in Internet Explorer:
a. Click the gear icon in the top right of the browser.
b. Click Compatibility View Settings.
c.  Ensure the Display intranet sites in Compatibility View checkbox is unchecked.

d. Click Close.

m © Resolver Inc. Confidential. Do not distribute. Page 2 of 350
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ﬁ Change Compatibility View Settings

A

Add this website:

| resolver.com

Websites you've added to Compatibility View:

Remove

[ ] Digplay intranet sites in Compatibility View
Uge Microsoft compatibility lists
Learn more by reading the Internet Explorer privacy statement

2. Navigate to your Perspective Services URL:

e  For On Premise customers: https.//<servername>/PerspectiveServices. <servername> refers to

the Perspective Web server installed during the installation of Perspective.
e  For Hosted customers: https.//<businessID>.myincidents.com/perspective/

3. Click the Perspective icon.

m © Resolver Inc. Confidential. Do not distribute. Page 3 of 350
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PERSPECTIVE:

Perspective Dispatch

Dashboard Portal

Incidents & Investigation Personalized Visual Metrics

Managing Events in Real Time Web based Security Central

4. If launching Perspective for the first time:
a. Click Run in the Security Warning window.
b. Configure your login settings:

. For On Premise customers:

i. Click the Specify Server tab, if it's not already open.

ii. If needed, enter the Perspective Services URL (e.g.
https.//<servername>/PerspectiveServices) in the Service Folder field.

iii. If your business ID is different from default, enter it in the Business ID field.

Note: The @ icon indicates that valid information has not yet been entered into

mandatory fields. When the required information has been validated, the ﬁ will
appear next to the fields.

m © Resolver Inc. Confidential. Do not distribute. Page 4 of 350
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PERSPLECTIVE 4 P

powered by RESOLVER Cancel
510

Mylncidents.com Specify Server

Service URL

https://example/perspectiveservices o

Business |ID

DEFAULT L4

Database

Use Default Proxy

iv. Select the database from the Database Name dropdown menu.

V. Click ‘ Back to return to the previous screen.
e  For Hosted customers:

i. Click the MyIncidents.com tab.

ii. Confirm the database selected in the Database Name dropdown is correct.

PERSPLECTIVE 4 P

powered by RESOLVER Cancel

51.0

Mylncidents.com Specify Server

Database Name:

iii. Click ‘ Back to return to the previous screen.

Note: If the Database Name field is missing or login fails, click the Specify Server tab
to confirm the Service URL, Business ID, and Database fields have populated correctly.

m © Resolver Inc. Confidential. Do not distribute. Page 5 of 350
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5. Enter your login credentials:

Note: If your system uses Windows® authentication, the login will be performed automatically. To
switch back to the standard Perspective login, press the F5 key on your keyboard.

a. Ifyou're not logging in using single sign-on (SSO) authentication:

i. Enter your user name and password in the User Name and Password fields.

PERSPLECTIVE ol I

powered by RESOLVER

Settings Close

M rRemember Me

ii. Select the Remember Me checkbox if you want Perspective to remember your

user name.
iii. Click Login.

b. If you're logging in using single sign-on (SSO) authentication:
i. Click Login.

PERSPLCTIVE ol [

powered by RESOLVER

Settings Close

Login with SS0O Provider

m © Resolver Inc. Confidential. Do not distribute. Page 6 of 350



Perspective User’s Guide Welcome to Perspective

ii. Enter your username, password, and any other information required by your SSO
provider to complete the login process. The SSO settings, including the amount
of time your session remains active, are determined by the SSO provider selected
by your Perspective administrator.

Note: If both SSO and Perspective authentication are enabled on your system and
you want to log in using your Perspective credentials, click Login with
Perspective, then enter your user name and password. This option will only appear
on the login screen if both Perspective and SSO authentication were enabled at the
time of installation or update.

Logoff

If you've logged in using single sign-on (SSO) authentication, clicking the X at the top right of the screen
will not log you out of Perspective, Dispatch, or Dashboard. To end your SSO session, click Logoff in the
ribbon.

User Interface

Perspective’s user interface is interactive, which means that it is constructed to match the current working
process (e.g., creating a record, analyzing data, filing a report). While the standard icons of the Ribbon and
the components of the Navigation pane remain constant, the rest of the screen content changes

depending on the currently active Perspective component selected from the Navigation pane.
Perspective’s user interface consists of the following broad parts:

1. The Ribbon: Locates the most frequently used general administration, navigation, help, and search

tools.

In the Data Forms component, the Visual Analysis icon is added. Visual Analysis assists by visually
representing relationships between the records stored in Perspective's database.

In the Analysis Expert component, the Ribbon is populated with an additional set of icons that
perform saving, adding, cloning, deletion, sharing, and execution of queries.

Hide the Ribbon by clicking the & icon on the top right corner (next to the Privacy link). Click the

icon again to show the Ribbon.

To read Perspective’s Privacy Statement, click the Privacy link. To read Perspective’s Legal Notice,

click the Legal link.

m © Resolver Inc. Confidential. Do not distribute. Page 7 of 350
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2. Navigation pane: Consists of the two major parts: the bottom part allows you to select different
Perspective components (Dashboard, DispatchLog, Analysis Expert, Reports, etc.), while the top part
displays the component-specific navigation options. Using the top part of the Navigation pane, you
will be able to control the workflow within the individual Perspective components (e.g., open the
DispatchLog console, modify the view of your Perspective records, customize reports, and specify

query settings). To hide the Navigation pane, click the Toggle Navigation Window icon ¢ | on the
Ribbon. Click the icon again to make the pane reappear.

3. Main screen: Consists of one or more sections and displays the core record data stored in
Perspective (depending on the currently active component). For instance, the main screen in the
Data Forms, and the Gateway components, consists of a Listing pane with a list of records and a
Viewing pane, where data of the record selected in the Listing pane is displayed.

4. Status bar: Contains your system and login information, including your username, role, and your
current Perspective’s system and connection status (e.g., Connected/Disconnected). After performing
an action on a record, check the status bar at the bottom of the screen for a confirmation message.
The status bar will indicate when Perspective is in the process of completing an action (e.g., Loading,
Saving, Deleting) and also specify if an action is complete and successful (e.g., Record is successfully
saved), or unsuccessful (e.g., Please provide required fields before saving).

m © Resolver Inc. Confidential. Do not distribute. Page 8 of 350
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Main System Components

Connected

You can access all of Perspective’s features and functionality from the Navigation pane. Just click on the
buttons to switch between components, and then further explore each component by clicking on the

options displayed.

Note: The components any particular user sees is dependent on that user's privileges and access rights. Refer

to User Privileges and Access Rights section for more information.

Main System Components

Dashboard is Perspective’s opening screen. Use it to track ongoing projects in the

Assignments section, and quickly review selected records’ trends and statistics in

the Charts area.

DispatchLog

Opens a separate DispatchLog console window that assists in centralized

dispatching of officers and organizations. See the Perspective DispatchLog

User's Guide on the Resolver Support site for more information.

Data Forms

Enter, update, and review your Activity, Incident, Case, Item, Person, Organization,

and Vehicle records in Data Forms.

m © Resolver Inc. Confidential. Do not distribute.
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Analyze and Use Analysis Expert to query records for specific data, and then turn your results

Report into a printed grid, spreadsheet, chart, or report. Choose from a number of pre-

Reports to create your own reports.

set reports to generate statistics and analyze trends in your data. Or use Custom

Gateway serves as an inbox for all electronically submitted reports. Selected users

Gateway assess each report before accepting it into Perspective or deleting it from the

system.

Administration

Designated Administrators use this component to manage system settings,
workgroups, roles, users, officers, auditing, languages, some components of the
system interface, and visual alerts. The functions of the Administration
component are described in the Perspective Administrator’s Guide.

Customize visibility of the components by dragging the top border of the component section in the

Navigation pane, or by clicking the configure arrow buttons. This will hide the bottom components one by

one. Click on the pin icon %J to return the hidden component back to the pane.

(/(_) Analysis Expert

% Gateway | 4 Show More Buttons §
¥ | Show Fewer Buttons
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User Privileges and Access Rights

Every Perspective user's visibility and access rights are customized by a user, or users, designated as the
Administrator(s).

Some basic users may only be authorized to read and add new records, without any editing, locking,
unlocking, or deleting privileges. The records they are permitted to read may also be restricted by various
security controls, and some forms may not be visible (e.g., Investigations forms or the Controls tab).
Furthermore, these basic users may be restricted from advanced components, such as Analysis Expert or
Reports. On the other hand, highly advanced users may have full access to all system components, forms,
fields, and functions.

If you are unable to view a particular component or form, or if you are not permitted to perform a certain
function, it may be a result of your assigned user privileges. For more information on how data is
segregated within Perspective and how user visibility and access rights are assigned, refer to the Security

Layer Overview chapter in the Perspective Administrator’s Guide, or, if you possess appropriate access
rights, in the online Admin Help.

Account Settings

Changing Your Password

1. Toinitiate the change of your current account password, click the File icon "Xl on the Ribbon.
2.  Select Change Password.

3. Inthe dialog window, enter your Old Password and your New Password.

4.  Re-enter your new password in the field below to confirm the password configuration.

5. Click OK to save the change and verify your new password.
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 Change Password

"Please enter your old and new passwords, and re-enter the new
password to confirm.”

Old Password | — |
New Password | e |
Re-enter New Password | === |

Dashboard Settings

By default, your Dashboard is set to automatically refresh once every minute. You may set your
Dashboard to automatically refresh less frequently or to require manual reloading.

1. Click the Settings icon » on the Ribbon. The Settings window will open with the General tab open
by default.

2. To modify how often your Dashboard refreshes, ensure the Automatically Refresh Dashboard
Assignments box is checked, and in the field below, specify how frequently you would like the
Dashboard to refresh (from once every minute to once every sixty minutes).

To set your Dashboard to require manual reloading, uncheck the Automatically Refresh Dashboard
Assignments box.

3. Click Save. At any time, you may click Reset to return your Dashboard to its default refresh settings.

4.  Restart Perspective (log out, then log back in) to enforce any changes that you have made.

Settings n

General | Shortcut Keys

Automatically Refresh Dashboard Assignments
Refresh Every

1 3| minutes.

[] Enable Grid Accessibility

Changes require application restart. Reset Cancel
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Shortcut Keys

Shortcut keys enable you to map commonly used Perspective functions to shortcut key combinations for

quick access.

1. Click the Settings icon » on the Ribbon. The Settings window will open.

2. Select the Shortcut Keys tab.

3. For every key you want to change, do the following:

a. Click the function's button.

b. Tap the new key combination you want to use. If the shortcut is being used elsewhere, you'll be

prompted to confirm your selection.

4.  Click Save. At any time, you may click Reset to return your shortcut key settings to their original

system defaults.

The default settings for shortcut keys are as follows:

Shortcut Keys

Function Name Default Key Combination
Global

Navigation Mode Ctrl+ N

Ribbon Menus * Alt/F10

Navigation Keys

Go to Data Forms D

Go to DispatchLog L

Go to Dashboard H

Go to Analysis Expert E

Go to Gateway G
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Go to Administration

Go to Activities

Go'to'Incidents

Go to Cases

Go to Items

Go to Persons

Go to Organizations

Go to Vehicles

List All Records

Open Quick View

Show Saved Views

Focus on List Pane

Hide List Pane

Change Password

Exit Perspective

Admin Help

User Help

Toggle Navigation Pane

Logoff

Settings

Quick Find

Open Visual Analysis
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About Perspective 0
Hide Ribbon Menu Minus
---------------- View-Legal Notice F3
View Privacy Policy F2
Go to Client Site F5
Maps F6
Record Details
Save Ctrl +S
Edit Ctrl+E
Merge Ctrl+ U
Add From Source Ctrl+ G
Delete Ctrl + Minus
Add Ctrl + Plus
Cancel Ctrl + K
Create Incident Ctrl +1
Lock/Unlock Ctrl + L
Print Ctrl +P
Send Ctrl+ M
View Record Audit Info Ctrl+D
Focus on Details Tabs Ctrl+F
Back to List Pane Ctrl+B

List Pane
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Select Top Record Ctrl+T
Print List Ctrl+P
"""""""" Sort tist Ctrl+0O
Next Page Ctrl + Right Arrow
Last Page Ctrl + Down Arrow
Previous Page Ctrl + Left Arrow
First Page Ctrl + Up Arrow
Jump to Page Ctrl+1
Focus on Selected Record Ctrl +L
Add * Ctrl + Plus
Edit * Ctrl+ E
Focus on Details Tabs * Ctrl+F
Delete * Ctrl + Minus
Controls
Link Record: Open List Ctrl+ W
Link Record: Quick View Ctrl+Q
Large Text Field: Spell Check Ctrl+ Q
URL Field: Open URL Ctrl+Q
Interview: Toggle Fields Ctrl+F
Analyze and Report
Reports Ctrl+R
Queries Ctrl+Q
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Custom Reports Ctrl+E

* Not configurable or must be set in another section.

Settings @
St Kers

Global it

Navigation Mode [ Ctrl + W ] ‘E ‘

Ribbon Menus * At/ F10

Navigation Keys

Goto Data Forms

Goto Reports

Goto DispatchLog

Go to Dashboard

Goto Analysis Expert

=

Goto Gateway

[ Reset H Save H Cancel ]

Quick Find Tool

The Quick Find tool is an advanced search that can locate records containing your specified text. The tool
will check text fields across your Perspective database (such as summaries, narratives, and text
attachments) for the words or phrases you enter. The Quick Find attachment indexing supports the
following file formats: .doc, .docx, .docm, xls, xlsx, .pdf, .txt, .text, .rtf, .sms, .log, .msg, .wpd, and .wps.

Note: The Quick Find tool requires an indexed database to function properly. Contact your Perspective
Administrator for further information.

1. Click the Quick Find button “\ on the Ribbon.

2. In the Enter Search String field, type the text you want to find. You can customize your search as
follows:

e To search for an exact matching phrase, enclose it in quotation marks.
e To search for records containing two or more words or phrases, join the words or phrases with

the AND operator. For example, if you want to search for records containing the words black and

coat, use the following search string: black AND coat.
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e To search for records containing either one word or phrase or another word or phrase, join the
words or phrases with the OR operator. For example, if you want to search for records
containing either the word laptop or the word computer, use the following search string: laptop
OR computer.

e Use wildcards to search for words and phrases that start, end, or simply contain particular
characters. Perspective’'s Quick Find supports the * (asterisk) wildcard as a substitute for zero or
more characters. For example, if you want to search for records containing words (numbers,
names, cities, etc.) that start with san, use the following search string: ‘san*. If you want to search
for records with words that contain the pattern ger, use the following search string: *ger*'.

Note: Previews for matching records found with the help of the wildcards will not be displayed.
e Searches can be customized further using the Fuzziness and Phonetic settings.

e Select a Fuzziness setting (default value is zero; maximum value is 10) to determine how broadly
your search terms will be applied. A higher Fuzziness value will return results which are less exact
than your search text. This can help to discover records even if they have typos in them. For
example, a fuzzy search for ‘vehicle’ would include the results ‘vehcile’ or ‘vehickle’. Enabling the
Fuzziness setting may increase the time it takes to perform a search.

e Select the Phonetic checkbox to include search results that sound the same as the search term.
This can be helpful when searching for names that sound the same but have different spellings
(e.g., Aaron/Erin, Smith/Smyth). Enabling the Phonetic setting may increase the time it takes to
perform a search.
3. Click Search.

e Alist of records containing the specified word or phrase will appear in the grid below. The
number of times the word or phrase appears in each record will be noted in the Hits column. As
well, the specific form that the word or phrase was found in will be listed (e.g., Incident Narrative,
Investigation Summary, Person Attachment).

4. To quickly scan the results, select a record in the list.

e A preview of the record segment containing the word or phrase will appear in the pane below.

5. Double-click a record in the list to open it.

m © Resolver Inc. Confidential. Do not distribute. Page 18 of 350



Perspective User’s Guide Welcome to Perspective

e Perspective will advance to the selected record in Data Forms, with focus on the form containing
the word or phrase. (The Quick Find window may still be opened in the foreground; in this case,

minimize the Quick Find window to view Perspective.)

6.  Click the Close [x] button in the top-right corner to close the Quick Find window.

L Quick Find

Enter Search String

edited Search 0 5| Fuzziness [] Phonetic
[ Tyee Hits Details
Cases 1 This was edited for TC1803
Vehicles EditVehicle4766
Persons AutoEditDoe

ltemEditTC1872
EditedltemLoss TC1120
EdittemNelmpactTC1124

ltems

Incident Invelved

Incident Involved

SIS

Additional Information: Automation Edited for TC 47655020

Custom Search Feature

The Custom Search feature allows you to launch the Infoglide Identity Resolution Engine™ (IRE) from

Perspective, to search within several data sources at once.

Note: Custom Search must first be configured in the Perspective Service Manager before it may be accessed
in Perspective. For further details, please see the Perspective Installation Guide.

1. Click the Custom Search icon Liil on the Ribbon.
e The Infoglide Identity Resolution Engine will open in a new window.

2. Following the basic search principles described in the Quick Find Tool section of this chapter,

perform the custom search required.

3. When finished, close the window to return to Perspective.
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Maps

Perspective Maps allows you to quickly see where a Dispatch is occurring, or where an Activity or Incident
has occurred. Perspective’'s mapping tool allows you to quickly access any record you want.

All Dispatches, Activities, and Incidents will appear on the map. You can easily define the records you want
displayed with the filter option.

From the mapping tool, you can see relevant tooltips that contain information like the Class, Category,
Occurred Time, Priority, and Status (the information you are able to see depends on if you are looking at
an Incident, Activity, or Dispatch). From here, you can select the record you want to open and look at it in
more detail.

Note: The Mapping option requires an internet connection.

3

Maps - oIEl

Incidents
Classification

4 Man

4 Accidental

4 External Source
4 Nature
Flood
¥ Criminal

Activities
Call Category
l Al

Priority

4 selected

o Dispatches &
State

I All

Priority
| All

2500 kilometers.
2) - AE
Auto Refresh [ © 2014 Mlcﬁfsaﬁ_ﬁrpomno mage courtesy of NASK Earthstar Geographics 510 (& S0fAfdkE

2013-12-20 2014-01-17 2014-02-14 2014-03-14 2014-04-11 2014-05-09 2014-06-06 2014-07-04 2014-0

Features

Map view: The Aerial map is the default map. To switch to Road map, click the button Aerial/Road button
Aerial 220 on the top right corner of the Maps window.
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Zoom: You can zoom in or out on the map by using the & or == buttons, or by using the scroll button on

your mouse.

Incidents and Activities auto refresh: The map automatically refreshes Incidents and Activities every 15
minutes, but if you want to refresh it sooner, click the refresh button €. Pressing the F5 button will also
refresh the Incidents and Activities.

Dispatches auto refresh: To automatically refresh Dispatches on the map, you need to have the
Auto Refresh checkbox ¥ selected (located in the Dispatches section on the Maps page). If this checkbox
is selected, the Dispatches will refresh in less than one minute.

Note: Dispatch auto refresh only works if the date range is set to the last seven days. If your date range is set
to the last 14 days and you check the Dispatch auto refresh checkbox, your timeline will be reset to the last 7
days, or auto refresh will deselect automatically if you expand your date range to over 7 days with auto
refresh enabled.

Date Range: Use the left and right arrows on the date range to move backwards in time, or drag and
drop the date range bar to the occurred dates of Incidents, Activities, and/or Dispatches you want to see
on the map.

Scale: Your map's scale will be automatically set to go off of your computer’s system settings.
Filters: To filter what you want to see displayed on the map, turn the switch to on « | or off [« WM. For
example, if you only want Incidents to be displayed, turn the Activities and Dispatches filter switch to the

off position. By filtering out Incidents, Activities, or Dispatches, it will make it easier for you to find exactly

what you are looking for.

Incidents

Note: If you do not have privileges for Incidents, Activities, particular Workgroups, etc., those records will not
display in Mapping.

You can search by all Class Rollups, or drill down to only search for specific Classifications (i.e., Criminal

Incidents).
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Incidents
Classification

4 [Jan

4[] Accidental

b External Source

Criminal

Nature

Activities

You can search by all Call Categories and Priorities, or drill down to only search for specific Call Categories

or Priorities.

Activities
Call Category

4 [dan

Alarm
[ Fire Alarm SOP
4 Person To Locate
Contractor

[ soplevelt

Priority

4 selected

Dispatches

You can search by all States and Priorities, or drill down to only search for specific States or Priorities.

O Dispatches
State

‘ 5 selected

Priority

‘AII

Auto Refresh

Tooltips

Tooltips are how you dig deeper into an Incident, Activity, or Dispatch, to determine if it is the one you are

looking for. To look at tooltips, simply hover over the pin @

on the map. A pin is a circle with a number

in the middle, where the number represents how many Incidents or Activities have occurred in that

location, or how many Dispatches are occurring in that location.
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When you hover over the pin, the tooltip will appear. First, you will be shown a count of the number of
Activities, Incidents, and Dispatches that are in that pin.

@ 18 Activities
@ 7 Incidents
O 14  Dispatches

From here, click once on the word Activities, Incidents, or Dispatches, depending on what you want to
look at. For example, if you click on the word Incidents, all the Incidents in that pin will open in greater
detail. To scroll through them, use the scrollbar that appears in the window.

@ 227 da-Incidents
@ QAINCDOD18370 @ QAINCO0D18310

da-Accidental da-Accidental
da-External Source da-External Source
da-MNature da-Mature
da-Flood

da-Open
da-Open

da-Site Level 1 -1
da-Site Level 1 -1

2014-07-25 211201 AM
2014-07-20 9:48:57 AM

Q 13 da-Activities

Once you have found the record you are looking for, click on it, and it will open in Perspective. The map
will remain opened in another window.

§ QAINCO i
i A/T 00118... @
Save ‘jEdit %Add 7 Delete | [ Lock il Print Cancel
< General Involvements Marratives Attachments Links % 4 »
# Details 2
Incident Number Reported Date/Time
QAINCO0011874 2014-08-14 06:04 AM
File Number Occured From Date/Time

2014-02-14 06:04 AM

e-Incident Number Occured To Date/Time

Class Site: Level 1

Accidental MichelleA

Category Building Level 2

External Source MichelleB

Subcategony Location Level 3

Type Section Level 4

P v
< >
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Note: A pin will only go up to 99+. However, you can hover over the pin and the tooltip will open, allowing
you to scroll through all Incidents, Activities, and Dispatches that have occurred or are occurring in that
location. Double click on pin clusters to zoom in.

Exiting Perspective

There are two options to exit Perspective:

o Logoff option: Log off the current user while leaving the Perspective system running. To log off,

click the Logoff key icon o on the Ribbon, or use the keyboard shortcut Ctrl+Shift+L.

o Exit option: Completely exit Perspective, which requires a full system reload upon the next login. To
exit Perspective, close the Perspective window, use the keyboard shortcut Alt+F4 (or click on the File

icon L-2)), and select Exit.
Note: While the Logoff option requires an additional confirmation of your choice to exit Perspective via a
confirmation window, the Exit option will simply terminate the work of Perspective as soon as you choose to

exit.

Before exiting Perspective (regardless of which exit option you choose), you have to press the Save button =l
to save any changes you have made to records while working in Perspective.
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Dashboard

The Dashboard is Perspective's default screen. Like the dashboard of an automobile with its various

gauges and indicator lights, Perspective’s Dashboard keeps users informed about what is happening in

their organization and alerts them of important changes. It helps to track ongoing projects and tasks, and

includes a statistics snapshot section for the incidents the user has access to. The two elements of the

Dashboard are Charts and Assignments.

User Interface

1. Charts: Get a quick overview of incident trends and statistics with the help of up to four selected bar
or pie charts.
2. Assignments: Track activities or projects assigned to you, as well as those you have assigned to
others, from start to finish.
Chart 1 . = Chart3 . =X
s Incidents By Class ® . Incidents By Site ®
Accsss Level 5 B i
Business Disru... 09
W cocoenal
B i N
E— 0
aaaaaaaa oy
LA E N} .c nnnnn - " ...,f
Chart 2 = Chart4 =%
Incidents By Business Unit ® , Incidents By Organizational Rollup ®
3
0 !
o """‘““’ LYY Y]
W_i Dispatchiog Assignments
= View All 7 Export | [@ GoTo | @ ResstLayout | % Clear Filter
E. Data Form: ! Completed? Number Assigned Date. Assigned By Assigned To Due Date Assignment Type Message/Task
Joll Reports
}J Analysis Expert
9, cotewoy
o7

) Resize the individual elements by dragging the borders surrounding them.

) To display/hide one of the Dashboard elements, click Show/Hide Charts, or Show/Hide

Assignments on the Navigation pane.
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Charts

The four pre-set charts on the Dashboard give you a quick overview of trends found in the Perspective

database records you have access to. To select the combination of up to four charts for display on the

Dashboard, follow the steps described below.

1.

Click the Chart Options button on the Navigation pane.

In the Chart Settings window, click on the ON/OFF = | = B switch to display or hide one of the
chart sections.

Within the relevant chart field (e.g., Chart 1), choose the chart you would like to appear in the
selected chart section (e.g., Incident by Class).

For a complete list of available pre-configured charts and their descriptions, see Appendix A:
Dashboard Chart Types.

Depending on the chart specified, a number of further settings will be displayed, which may (or may
not) include the following:

From Last: Select the time period for which you would like to see the statistics on the chart (e.g.,
365 days).

Top: Specify the number of categories you would like to display on your chart (e.g., top 10
classes).

Call Category: Restrict your data to a specific Call Category, making it as narrow as necessary.

Click the plus icon [*#! next to the Call Category field, and select the requirednumber of levels of

category by which you would like to restrict the data in the chart.

Class ID: Restrict your data to a specific Class, making it as narrow as necessary. Click the plus

icon **| next to the Class ID field, and select the required number of class levels (i.e.,
Class/Category/Subcategory/Type) by which you would like to restrict the data in the chart.

Site: Restrict your data to a specific Site, making it as detailed as necessary. Click the plus icon

**| next to the Site field, and select the required number of site levels (i.e.,
Site/Building/Location/Section) by which you would like to restrict the data in the chart.

Category ID: Restrict the Case data in your chart to either Internal or External cases.
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e Year: Select the specific year you want to display your data for (e.g., 2011)

e Chart Type: Choose either the pie or bar chart type.

7 ™
Chart Options — M
Chart 1

Select Chart
Perspective Gauge -

Class ID

Site

w

Chart 2
Select Chart

Incidents By Site -

From Last Top
365 Day= - 10 «

Chart Type
| . e

Chart 3
Select Chart

1 = Incidents By Site =
From Last Top
365 Days - (10 ~
Chart Typs
- -

Select Chart
Incidents By Crganizational Rollup -
From Last Top
365 Days - 0 «
Chart Type
. -

oK || Cancel

5. Click OK to see the results displayed on the Dashboard.

6. At any time, you may change the chart options for each individual chart displayed on the Dashboard
by clicking the corresponding Settings icon @

e This will open the options window for the chart that you chose to modify.

7. Examine one particular chart in detail by clicking the Maximize icon k=l in the upper right corner of
the relevant chart section. To dock it back together with the rest of the charts, click the equivalent
Minimize icon k=il
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8. If the chart you selected is either a uni-coloured bar chart or a pie chart, you may be able to explore
the information contained in the chart further. By clicking on a bar or a pie sector that corresponds to
a specific category, class, organization, or site, you may expand the data that is hierarchically
subordinate to the data currently displayed on the screen. For example, if you are viewing the Incident
By Class chart, you may click on the green pie sector that corresponds to the Criminal class of
incidents to open a pie chart for all incidents contained under the Criminal class (e.g., Assault, Theft,
Fraud). To explore the data even further, you may click on the yellow pie sector that corresponds to
the Assault category of incidents.

The number of subordinate charts corresponds to the number of tiers under the corresponding rollup
(in our example, the Class Rollup). To navigate within the hierarchy, click on one of the dark gray circle
icons displayed below the chart. Each circle represents one tier of the rollup, in ascending order.

Incident By Class Rollup Incident By Class Rollup

Unspecified

. Criminal
Assault
Non-Criminal
. . Break and E_
Policy Viclati, ’
B
o ® Criminal : 52 . Safety
o B -
B ol
Public Order
ceee snee
Incident By Site Rollup Incident By Site Rollup
12 = ] )

10

& Building 1: 10 ’ 4

Location1:7

Bulding 1 Unspecified Buiding2

9. To copy a chart image, right-click the chart and select Copy to Clipboard.

Assignments

When you receive or delegate an assignment to another user, the assignment is displayed on your

Dashboard. You may also receive an email notification about the assignment, and if you are logged on to
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Perspective at the time, a pop-up will appear in the bottom right corner of your screen alerting you to the
email. Incomplete assignments that are past their due date are listed in red font.

Along with your assignment'’s associated Activity, Incident, or Case Number, the Dashboard’s Assignments
section displays the following information:

. Completed: A checkbox indicating whether or not the assignment has been completed.
e  Assigned Date: The date the assignment was delegated to the user.

e  Assigned By: The user who created the assignment.

e  Assigned To: The user who is responsible for completing the assignment.

. Due Date: The date the assignment must be completed.

e  Assignment Type: The nature of the assignment, such as Correction Notice, Follow-up Activity,
Information Request, Investigative Action, or Verification.

o Message: The details of the assignment.

Wiew All 0 Export | [# Go To - PPMI-2009-000260 | 2 ResetlLayout | Clear Filier
[ |

Completed? Number Assigned Date Assigned By Assigned To | Due Date | Assignment Type = Message / Task
CCWwI-2011-02-00057  24/02/2011 St Jean, Clint 111, Admin Follow-up Activity
CCWwI-2011-02-00057  24/02/2011 St Jean, Clint 111, Admin Follow-up Activity
CCWwI-2011-02-00057  22/02/2011 St Jean, Clint 111, Admin Follow-up Activity

» 010 St Jean, Clint 180. Deb F Follow-up Activity
Mark Completed NS Emn St Jean, Clint 180, Deb F Follow-up Activity
] Go to Record 12010 Jabbar, Abdul St Jean, Clint Follow-up Activity
] 1INLLIUUUULIUL |72 vziua2007 Kemper. Dale St Jean. Clint 30112007 Follow-up Activity  Attend court for th:

You may perform a number of assignment-related tasks directly from your Dashboard:

) To add an assignment to your email application’s calendar, select the assignment and click Export

. A window will open allowing you to schedule the assignment using external applications.
e  To open an assignment’s corresponding Activity, Incident, or Case record, double-click the

assignment record, or highlight the assignment and click Go To e, Perspective will leave Dashboard
and advance to the applicable record in Data Forms.
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Once the assignment has been completed, highlight the assignment on the Dashboard, then right-
click and select Mark Completed. A pop-up window will appear asking if you would like to send the
Assigned By person an email notifying them of the assignment’s completion. Click Yes or No.

By default, only incomplete assignments will appear in the Assignments section of the Dashboard. To
display all assignments, complete and incomplete, click View All. Click View All again to hide
completed assignments.

Like the other grids, Perspective provides several sorting options for Assignments:

To reorder the grid columns in the Assignments section, drag the column headings to the desired
location. Drop them into place once the indicator arrows have appeared pointing to the correct spot.
To reset the order of columns to their default position, click Reset  Layout =.

To sort assignments by a particular column (e.g., Incident Number, Assignment Type, Due Date), click
the column heading once. Click the heading again to sort the data in reverse order. Click Clear Filter

to return to the unsorted view.

) To group assignments by Assigned Date, Assigned By, Assigned To persons, Due Date, Assignment
Type, or to group complete and incomplete assignments separately, click the thick vertical bar
located at the top of the Assignments grid and drag the relevant column heading to the Group By
Area. In our example, assignments have been grouped by their status as either complete (True) or

incomplete (False). If necessary, you may build up on internal grouping, dragging additional

headings to the blue field and arranging them in the required hierarchy. For instance, you may

group the complete and the incomplete assignments by Assigned By persons, and so on. Click Clear

Filter to return to the default view.

e —

View All 58 Export

[# GoTo..

2 ResetLayout | Clear Filter

Completed?

=| False (3 items)

) Assigned By I}

Completed? MNumber Assigned Date Assigned By Assigned To  Due Date Assignment Type
(] PPMI-2003-000260 01/10/2010 St Jean, Clint  180.Deb F Follow-up Activity
] LACP-2010-000012  27/08/2070 Jabbar. Abdul St Jean. Clint Follow-up Activity

INCDO000000172 02/08/2007 Kemper, Dale St Jean, Clint  30/11/2007  Follow-up Activity
—| True (4 items)

Completed? MNumber Assigned Date Assigned By Assigned To  Due Date Assignment Type
CCwI-2011-02-00057  24/02/2011 St Jean. Clint 111, Admin Follow-up Activity
CCwI-2011-02-00057  24/02/2011 St Jean. Clint 111, Admin Follow-up Activity
CCwI-2011-02-00057  22/02/2011 St Jean, Clint 111, Admin Follow-up Activity
PPMI-2003-000260 01/10/2010 St Jean. Clint  180.Deb F Follow-up Activity
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Data Forms

Data Forms is the data entry component of Perspective. These data are used for analysis and comparison
to create reports and charts. Information in the Data Forms is organized into sections, so it is easy to find,
review, and update records. The data forms include Activities, Incidents, Cases, Items, Persons,
Organizations, and Vehicles. To access the Data Forms component, select it from the bottom part of the
Navigation pane.

User Interface

The Data Forms interface is divided into three sections: Navigation pane, Listing pane, and Viewing pane.

Incidents1 LR _ .
Y INC-2013-04-00026 (Autolncident617525839) g
Enter filter text. X v 4L = : £ | Criminal/Assault/Injury/No Weapon
Saved Views
Al Records INC-2013-05-00009 (Deletelnci... w Save || Edit R Add X Delete | (5) Lock dsh Print 4 Send Cancel
0 (0) Criminal Open
_ < General Involvements Narratives Attachments Links Losses Investigation < Controls v 4
INC-2013-05-00008 (InitInciden... w
@ (0) Criminal Open SR
INC-2013-05-00006 (Initinciden... w Incident Number Reported Date/Time
@ (0) Criminal Open INC-2013-04-00028 04/0412013 01:14 PM
INC-2013-04-00028 1
......... w Fie Number Oceured From Date/Time
Activities 0 (0) criminal Open Autolncident517526833 040412013 01:14 P L
INC-2013-04-00027 (AutelIncide... 1 F
Incidents H e-ncidert Number Oceured To Date/Time
- 0 (0) Criminal Open
ases
i INC-2013-04-00026 (Autolncide... w
ems
ooreane W{(0) CriminalfAssault/Injury/No Weapon Open . . o
INC-2013-04-00025 (AutoIncide... w Criminal
Organizations
© (0) Criminal Open Catogory Budng Lovel 2
Vehicles INC-2013-04-00024 (Autolncide... m Assault
o~  (0) criminal Open Subcategory Location Level 3
fex? | Dashboard INC-2013-04-00023 (AutoIncide... w Injury
—~ ~ @ (0) Criminal Qpen Type Section Level 4
| Dispatchlog o
L INC-2013-04-00022 (AutoIncide... w No Weapon
Data Forms W (0) Criminal Open
. . INC-2013-04-00021 (AutolIncide... w Summary
WDH Reports @ (0) Criminal Open
INC-2013-04-00019 (Autolncide... w
- Analysis Expert 0 (0) Criminal Open
INC-2013-04-00018 w
Gat:
), Gatemay © (8) Criminal Open
= M4 12 v M| m r

1. Navigation pane: Allows you to move between the various data forms (e.g., Activities, Incidents,
Items). To display a particular record subset in the middle Listing pane, choose a data form from the
Navigation pane and select your record view (i.e., specify a Quick View, view All Records, or select a
view from the Saved Views menu).

2. Listing pane: Provides a list of records that are available for viewing. Once you select a record in the

Listing pane, the corresponding record information will be displayed in the Viewing pane on the
right.

Listing Pane
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Change the orientation of the current component’s (e.g.,
Incidents) Listing pane by dragging it to a different part of the
screen. Display the pane in a separate dialog by double-

clicking it or dragging it outside of the screen. To dock it back
in, double-click the pane.

To hide the Listing pane, click the Auto Hide pin icon. Once
the pane is hidden, access it by clicking the pane’s newly- Incidents IE
created shortcut button on the left side of the screen, and K

el
-
iE

unpin it by clicking the pin icon again.

If Perspective displays a list of entities (e.g., incidents, persons)
that consists of multiple pages, use the left/right navigation
arrows at the bottom of the list, or type a page number in the
Page field, to move through the pages. The total number of M4 TRE W
pages will be provided for your reference. To quickly move to
the first or the last page, click the first arrow 4 or the last

arrow icons Pl respectively.

Incidents a
To print the record list as it appears in the Listing pane, click
PRV AR ]

the Print button located at the top of the Listing pane.

3. Viewing pane: Displays information of a record selected in the Listing pane and provides options for

saving, editing, adding, deleting, (un)locking, printing, sending, and merging individual records.
Note: Merge is only available for the Item, Person, Organization, and Vehicle records.
Every record consists of a set of customized forms and subforms designed specifically for the data

form type. For example, a Person record contains a separate Contact(s) tab, which is absent in such

data forms as Vehicles or Items.

Viewing Pane

m © Resolver Inc. Confidential. Do not distribute. Page 32 of 350



Perspective User's Guide Data Forms

To view a particular segment of a selected record (e.g.,
Narratives), click the appropriate tab at the top of the record.

The diamond symbol appearing on a tab indicates that the tab © Involvements | Namafives|, © Aftac

contains data. Tabs without the diamond symbol contain no
saved data.

View more tabs. If these arrows appear next to a row of tabs in

a form, there are more tabs available than are currently visible ¢ Namalives |G RiRRl _}Eg

on-screen.

. . . . % | Supplemental Details
Expand or collapse a section to view or hide its contents. ']}3 e

To resize a grid column, place the cursor between column
headings. When an arrow appears, drag the column border to | LastName +P*  First Name

I mitis

the desired width. To resize a column to fit its content, double- VWoodcott Jason

click the border of the column.

To reorder the grid columns, drag the column heading to a 4

new position. Drop it into place once the thick arrows have Last Nare [t =

Imiti;

. T
appeared, pointing to the correct spot. Voodeott Jasen

First Name
To sort the grid data by a particular column, click the column R

Woodcock wendy

heading once. Click it again to sort the data in reverse order.
Parker Peter

I mitii

Navigating Data Forms Overview

Every data entry/editing action in Data Forms requires you to first choose one data form type in which

you intend to work in: Activities, Incidents, Cases, Items, Persons, Organizations, or Vehicles.
Navigating the Data Forms component is a logically flowing process:

1. Select the appropriate data form type by clicking the corresponding banner located in the bottom
part of the Navigation pane.

2. Using the Quick View, Saved Views, and All Records buttons located at the top of the Navigation
pane, manage the view of the records displayed in the Listing pane. Here you may choose from
either displaying all records, or a subset of records, with an option to filter and save the view for
future reference.
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3. Select an existing record from the Listing pane, or create a new record for the chosen data form type
(e.g., a new Incident record).

4.  Enter and/or modify the data contained in your active record.

5. Print your record in the form of a report.

The following chapters will address the options available for each of these steps in greater detail.

Select a Data Form

Activities Form

Use this form to create records of dispatched activities, or to manage activities imported from
DispatchLog or Dispatch (See the Resolver Support site for more information on DispatchLog and
Dispatch). Before creating a new record, do a record search to ensure that the information has not
already been entered.

Activities Form

. Specify the category, priority, and location of the dispatched activity.
e  Track the times of the dispatching progress.

. Identify the persons directly involved in the processing of the activity.
. Fill in the user-defined fields required by your organization.

. Post notes on the activity tracking progress.

Responses

Officer Responses

e View, create a new, or edit the details of an existing officer response to the selected activity.

Organization Responses

e  View, create a new, or edit the details of an existing organization response to the selected

activity.

Requests

. Note an action request sent to an organization in response to the selected activity.
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Persons

. Identify all persons involved in the activity.
. Record injuries sustained during the activity.
. Flag the involved person.

Organizations

. Identify all organizations involved in the activity.

Vehicles

. Document all vehicles involved in the incident.

Items

e |dentify all items involved in the incident.

e Attach a file to the Activity record.

Activity Links

e  Link the activity to another activity.

Incident Links

e  Link the activity to an incident.

Controls

Details

. Set security controls and status of the Activity record.
e  Define which workgroups can access the Activity record.

Standard Operating Procedures

. Review the Standard Operating Procedures available for the activity's call category, site, and/or
status.

e Check off complete procedures, view relevant attachments, and access related links.

e  View mass notifications and/or email notifications sent in relation to the activity.
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Assignments

e  Give an activity-related assignment to another user.

Audit History

e  View the history of all changes made to the Activity record. Visibility of Audit History depends on

user permissions.

Incidents Form

Use this form to record the details of an incident and track the progress of its investigation. Every Incident
record is given a unique number so it is easy to find, identify, and organize. Before creating a new record,
do a record search to ensure that the information has not already been entered.

Incidents Form

. Create a new Incident record.
. Indicate which authorities have been notified of the incident.
. Flag the incident.

Persons

. Identify all persons involved in the incident.

e  Record injuries sustained during the incident.

. Record an involved person'’s clothing details.

e  Flag an involved person.

e  Add losses, recoveries, or potential no impact losses associated with an involved person, and

review their summary.

Organizations

. Identify all organizations involved in the incident.

. Note an action request sent to an organization.

e  Log organization response details.

e  Add losses, recoveries, or potential no impact losses associated with an involved organization,
and review their summary.

Vehicles

. Document all vehicles involved in the incident.
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e  Add losses, recoveries, or potential no impact losses associated with an involved vehicle, and

review their summary.

Items

e |dentify all items involved in the incident.
e  Add losses, recoveries, or potential no impact losses associated with an involved item, and

review their summary.

. Add procedure summaries (e.g., Executive Summary, Follow-up, or Interview) to the Incident
record.

. Attach a file to the Incident record.

. Link the incident to another incident.

. Link the incident to a case.
. Link the incident to an activity.

. Record losses (i.e., Losses, Recoveries, and No Impact losses) involved in an incident.
e  View a summary of losses involved in the incident.

Investigation

Details

e  Open a new incident investigation.
e  View a summary of the incident’s key investigative data.
e  Assign an investigator to the incident’s investigation.

Summaries

. Summarize the incident’s investigation.

Logs

e Log investigative tasks and expenses for the incident.

Interviews

o Document investigation interviews for the incident.

Evidence/Property
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e  Track investigation evidence for the incident, including the evidence chain of custody.

Controls

Details

. Set security controls and status of the Incident record.
e  Define which workgroups can access the Incident record.

Outcome

. Describe the incident's causes and subsequent policy changes or corrective actions.

Reviews

. Document an incident-related review.

Assignments

e  Give an incident-related assignment to another user.

Audit History

e  View the history of all changes made to the Incident record. Visibility of Audit History depends
on user permissions.

Cases Form

Use this form to record the details of a case, track the progress of its investigation, and access information
on its linked incidents. Every Case record is given a unique number so it is easy to find, identify, and
organize. Before creating a new record, do a record search to ensure that the information has not already
been entered.

Cases Form

o Create a new Case record.
e  Assign an investigator to the case’s investigation.

o View a quick summary of the case’s key data.

Persons, Organizations, Vehicles, and Items

o View all persons, organizations, vehicles, or items involved in the case’s linked incidents.
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. Summarize the case or an incident linked to the case.

. Attach a file to the case or an incident linked to the case.

. Link the case to an incident.
. Link the case to another case.

e  View a summary of losses, recoveries, and no impact losses involved in the case’s linked
incidents.

Investigation

Details

e  View key investigative data from the case’s linked incidents.

Summaries

. Summarize the case’s investigation or the investigation of an incident linked to the case.

Logs

e  Log investigative tasks and expenses for the case or an incident linked to the case.

Interviews

e  Document investigation interviews for the case or an incident linked to the case.

Evidence/Property

e  Track investigation evidence for the case or an incident linked to the case.

Controls

Details

. Set the security controls and status of the Case record.
o Define which workgroups can access the Case record.

Reviews

. Document a case-related review.

Assignments
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e  Give a case-related assignment to another user.

Audit History

e  View the history of all changes made to the Case record. Visibility of Audit History depends on

user permissions.

Items Form

Use this form to record the details of an item. Before creating a new record, do a record search to ensure
that the information has not already been entered.

Items Form

° Create a new Item record.

History

. View the incidents the item has been involved in.
. Add an incident associated with the item into a case.

. Attach a file to the Item record.

Controls

Details

. Set security controls for the Item record.
e  Define which workgroups can access the Item record.

Audit History

e View the history of all changes made to the Item record. Visibility of Audit History depends on

user permissions.
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Persons Form

Use this form to record the details of a person. Every person, from general maintenance users to suspects

and officers, must have their own record. Records can be created for persons who have the same name, as
well as for persons who are unknown. Before creating a new record, do a record search to ensure that the

information has not already been entered.

Persons Form

e  Create a new Person record.

e  Note the person's unique features or distinguishing marks.
o Record the person’s identification details.

. Document the person'’s trespass details.

. Flag the person.

Contact(s)

o List the person's known addresses, phone numbers, and email addresses.

. Link the person to another person.
. Link the person to an organization.
o Link the person to a vehicle.

History

e  View the incidents the person has been involved in.
e Add an incident associated with the person into a case.

. Attach a file to the Person record.

Controls

Details

. Set security controls for the Person record.
e  Define which workgroups can access the Person record.

Audit History

e  View the history of all changes made to the Person record. Visibility of Audit History depends on
user permissions.
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Organizations Form

Use this form to record the details of an organization. Before creating a new record, do a record search to
ensure that the information has not already been entered.

Organizations Form

e  Create a new Organization record.

Contact(s)

. List the organization's known addresses, phone numbers, and email addresses.

Links

. Link the organization to a person.
. Link the organization to another organization.

e  Link the organization to a vehicle.

History

e  View the incidents the organization has been involved in.
e Add an incident associated with the organization into a case.

e  Attach a file to the Organization record.

Controls

Details

. Set security controls for the Organization record.
. Define which workgroups can access the Organization record.

Audit History

. View the history of all changes made to the Organization record. Visibility of Audit History
depends on user permissions.
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Vehicles Form

Use this form to record the details of a vehicle. Before creating a new record, do a record search to ensure
the information has not already been entered.

Vehicles Form

. Create a new Vehicle record.

o Link the vehicle to a person.
o Link the vehicle to an organization.

. Link the vehicle to another vehicle.

History

. View the incidents the vehicle has been involved in.
. Add an incident associated with the vehicle into a case.

. Attach a file to the Vehicle record.

Controls

Details

. Set security controls for the Vehicle record.
e  Define which workgroups can access the Vehicle record.

Audit History

e  View the history of all changes made to the Vehicle record. Visibility of Audit History depends on

user permissions.

Common Record Functions

Although most data entry operations are specific to the individual data forms and will be described under
the corresponding sections (e.g., Incidents, Activities, Items), some functions are identical for a number of
data forms, and these will be described only once and then cross-referenced throughout this guide. For
instance, as you proceed through the Case data form, you will notice that procedures for some operations
for cases are identical to the ones that are available for incidents. Whenever this is so, the Cases section
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will provide cross-references to the relevant chapters in the Incidents section instead of the full
descriptions of the corresponding operations.

The common record functions/forms include the following:

. Recording related contact information (the Contact(s) tab).

o Specifying all involvements of an occurrence (the Involvements tab).
. Reviewing related record’s involvements (the History tab).

. Linking a record to another record (the Links tab).

. Attaching a file to a record (the Attachments tab).

. Setting major record’s control options (the Controls tab).

e  Auditing the changes made to a record (the Audit History tab).

o Merging records’ duplicated data (the Merge button).

Manage Record Views

Display All Records in the Listing Pane

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents).

2. Todisplay all of the entity's records in the Listing pane, with no filters applied, click All Records.

Quick View

Saved Views

All.Records
ﬂ—

Access a Saved Record View

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents).
2. Click Saved Views and select the particular record view that you want to access.

e The record view will now appear in the Listing pane.
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Quick View

Saved Views

Workgroup A - Open Records
Waorkgroup B - Open Theft Last Month |

[F  QuickEdit..
% Refresh

Create and Save a New Record View

1. In the Navigation pane, choose the record entity you intend to work with (e.g., Incidents).
2. In the view menu, click Quick View.

e The Record Views window will open. This is where you specify the parameters of your record
view.

3. Click the Add button in the Saved Views section.
4.  Type a name for your customized view in the active Enter View Name field.
5. Customize your desired view starting with the Workgroups section.
e By default, the All Workgroups box is checked to include records for all workgroups in your

customized view. If you want to restrict your view to the records of a particular group, uncheck
the All Workgroups box and proceed to select the desired workgroups.
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ozl grd Views

Saved Views

Workgroups

Page Results 25 Records

6.  Specify the Criteria for your view:

]| 4] Page

Enter View Name Al Workgroups
Export Via Email
P
Workgroups ABC. Open Theft Last Morth [ Administrator - PPM2000 Workgroup - Do not delete
[T Set as default view
Cancel ] [ Save ] [ Impart View ]
Criteria
Field Name Operator Value
Case Number v] [;
@ Mone © And © or
Order By
[ - ) Ascending [ Include Archived Records
@ Descending
Row Nu [Case N |Case N | Status Status |Case |Case |Acces |Access |Org Rellup Org Rel | Attach | Case Category Case C | Lock|
p 1 CASE- | 18031 | 7fb3d0c/-0929-4aec | Open | 2013 ] Level 5 ] b2bféfca-f21d-deBe- | Interna 3
2 CASE- | Inite21 | 7fb3d0c7-0929-4aec | Open | 2013 5 Level 5 o b2bfdfca-f21d-4eBc- | Interna
3 CASE- | 18022 | 7fh3d0c7-092%-4aec | Open |2013 3 Level 5 ] b2bféfca-f21d-4eBe- | Interna
4 CASE- | 18032 | 7fh3d0c7-092%-4aec | Open |2013 3 Level 5 ] b2bféfca-f21d-4eBe- | Interna
5 CASE- | Init220 | 7fh3d0c7-082%-4aec | Open | 2013 5 Level 5 ] h2bféfca-f21d-4eBe- | Interna
6 CASE- | 18025 | 7fh3d0c7-0829-4aec | Open |2013 5 Level 5 ] h2bféfca-f21d-4eBe- | Interna
7 CASE- | 18031 | 7h3d0c7-0829-4aec | Open |2013 5 Level 5 ] h2bféfca-f21d-4eBe- | Interna
CASE- | Init199 | 7fb3d0c7-092%-4aec | Open | 2013 3 Level 5 ] b2bféfea-f21d-d4ele- | Interna
9 CASE- | TestC | 7fb3d0c7-0925-4aec | Open 12013 5 Level 5 ] b2bféfea-f21d-d4ele- | Interna

o2 (][] [ sdext | [ View |

[ Cancel ]

a. Inthe top Field Name lookup list, select the field that you want to set as the main criterion for

narrowing your record view.

b. Choose an Operator for the field (e.g., equal (=), greater than (>), less than or equal to (< =),
starts with, like).

¢. Enter the compared criterion Value. If the Selector button = is available, click it to display a

tree of Value options in a separate window. For example, if you are creating a Saved View of

Incident records and your chosen Field Name is Access Level, you may select an Operator of

equal (=) and a Value of Level 2, in order to restrict your view to only those records with an

Access Level 2.

Note: You may choose any node of the tree as the defining criterion, making your comparison

value as narrow hierarchically as you want. For example, when specifying a Value for the Class

Rollup, you may select any node in the Class Rollup hierarchy, ranging from the broadest category

values, like Criminal, to the narrowest sub-class type values, like Company Property/Over $1000.
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10.

11.

12.

If you choose to select a date field in the Field Name lookup list, you have the option of using a
floating date (e.g., Yesterday), rather than a fixed date to narrow your record view by. The
Floating Date checkbox is only visible once a date field has been selected. For example, if you
want your view to display incident activity that occurred during a floating period of a previous
month, choose Occurred From Date/Time as Field Name, equal (=) as the Operator, and then
check the Floating Date box and select Previous 30 Days as your Value.

d. If you want to include an additional field in your record view criteria, select the And or Or radio
buttons and complete the Field Name, Operator, and Value fields below. You may include up to
four fields in your record view criteria.

To specify a static date range, specify two temporal criteria (e.g., one for the greater than (>),
and one for the less than or equal to (<=) Operator), using the And logic between them to

combine the criteria into a set date range.

Choose a display order for your record view by selecting a field from the Order By lookup list (e.g.,
order records by Incident Number, Access Level, Status).

Select either the Ascending or Descending radio button to further define the record order.

e The ascending radio button lists the records according to the chosen Order By field in
alphabetical order, or from lowest number to highest. The descending radio button lists the
records according to the selected Order By field in reverse alphabetical order, or from highest
number to lowest.

Include archived records in your record view by checking Include Archived Records.

Click the Preview button to generate a list of records meeting your set criteria in the order specified.

e The number of records found will be provided under Page Results.

To quickly view a particular record in read-only mode, select the record in the Preview list and click

View.

e A separate window will open with the record details displayed.
If you want to save the record view for future use, complete the Saved Views section. Otherwise,

proceed to the next step. Perspective provides three saving options for your newly created view:

e To save your record view for future use in Perspective, click Save. Your newly-created record

view will now be available under the Saved Views menu.
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13.

14.

e If you want to set this customized view as your default view (the record view that will
automatically load each time you enter this data form), click the Set as default view box, and

click Save again.

e To save your record view as an XML or TXT file, click Save View As and select the location for the
export. The record will be assigned an automatically generated number.

To return to the Data Forms window and transfer your record view to the Listing pane, click the

Select button.
Click on a record in the Listing pane to display it in the Viewing pane.

e If you clicked on a particular record in the Record Views window prior to clicking Select, the
record will be highlighted in the Listing pane and will already be opened in the Viewing pane.

Edit an Existing Record View

In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents).
Expand the Saved Views menu.
Select Quick Edit. The Record Views window will open.

If you have not yet opened a saved record view and your Listing pane is blank, select an existing

view you want to edit under the Saved Views menu.

e lts settings will be displayed. However, if your Listing pane displays a selected record view, the
Record Views window will open with the active record view's parameters displayed.
Quick View

Saved Views

Workgroup A - Open Records
Workgroup B - Open Theft Last Month

LY QuickEdit..
& Refresh

Modify the parameters as required. For options, see the Create and Save a New Record View

section in the current chapter.

To save the view replacing the parameters previously set, click Save.

To save the modified record view as a new view, complete the Saved Views section, as follows:
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a. Click Add. A pop-up will appear asking you if you want to clear the current view criteria.

b. Click No to save the criteria specified. If you click Yes, the view will be reset to its original
settings.

c. Type a name for your edited view in the active Enter View Name field. This way, when you save

your new view, it will not overwrite the original view.
d. Click Save. Your newly-created record view will now be available in the Saved Views menu.
If you do not want to save the modified view, proceed to the next step.

6. To return to the Data Forms window and transfer your record view to the Listing pane, click the
Select button.

7.  Click on a record in the Listing pane to display it in the Viewing pane.

e If you clicked on a particular record in the Record Views window prior to clicking Select, this
record will be highlighted in the Listing pane and will already be opened in the Viewing pane.

@ If you opened an existing view in the Listing pane, made changes to it, saved it, and
then re-opened the modified view, you may need to click the Refresh button %l in

the Saved Views menu to refresh the view of your Listing pane with the new settings.
Import a View
1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents).
2. Click Quick View in the Navigation pane.

3. In the Record Views window, click the Import View button and browse for the file that contains the

view in XML or TXT format that you want to import.
e Once you import the view, its settings will be displayed.
4.  Optionally, modify the parameters of the newly imported view and/or save them under a new view

name. For editing and saving options, please see the Create and Save a New Record View section

in the current chapter.
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5. Click the Select button to transfer your record view to the Listing pane.
6.  Click on a record in the Listing pane to display it in the Viewing pane.

e If you clicked on a particular record in the Record Views window prior to clicking Select, this
record will be highlighted in the Listing pane and will already be opened in the Viewing pane.

Email a Record View

1. In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents).
2. Click Quick View in the Navigation pane.

3. Inthe Record Views window, specify the settings of a new record view and save them, as described
above, or select an existing view you want to email in the Saved Views menu.

4.  Click the Export Via Email button.
e A Send Message window will open with your view specifications formatted as an XML
attachment.
5. Edit the text of the original message, review attachments, and set the message priority, as needed.
6.  Specify the recipient’s email address.
7. You may type in a recipient’s email address directly into the To and/or CC fields, or import a contact
from Perspective’s database by clicking To and/or CC and selecting a person from the displayed

Entity List.

e The Entity List will be populated with user records that contain an email address with the

Primary Email box checked.
8.  Click Send.

9. Close the Record Views window to return to the Data Forms window.
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4 Send Message

Send Mail

=% @ Yv 0‘76 Ll_l ILI A§ g To | perspective@gmail.com

cc
Send | Attachments Prierity | Cut Copy Paste | Spellcheck
- Subject | Emailing: Workgroups ABC Open Theft Last IMonth xml

This email was generated by Perspective with the following file or Tink attachments: -
workgroups ABC Open Theft Last Month.xm]

Delete a Record View

1.

In the Navigation pane, choose the record entity you intend to work on (e.g., Incidents).

Expand the Saved Views menu

Click Quick Edit. The Record Views window will open.

If you have not yet opened a saved record view and your Listing pane is blank, select an existing

view you want to edit under the Saved Views menu.

e |ts settings will be displayed. However, if your Listing pane displays a selected record view, the
Record Views window will open with the active record view's parameters displayed.

Click the Delete button.

In the Delete confirmation box, click Yes.

Close the Record Views window to return to the Data Forms window.

Select a Record from the List

If the record database displayed in the Listing pane exceeds three pages, you may consider further

filtering the record list using the following sorting options:

Use the A to Z sorting icon located at the top of the Listing pane to switch the record list view in
the Listing pane between the ascending and the descending alphanumeric order.
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Note: If you are using a Quick View or a Saved View and want to re-sort your records list, you must use
the Order By and Ascending/Descending options available in the Record Views window.

o If you know a part of the name or number of the required record(s), enter a string of alphanumeric
characters in the filter field at the top of the Listing pane. Since this function only filters text in the
record name (e.g., the incident number, person name, vehicle license plate number), the filter string
must correspond to a supposed part of the record number that you require (e.g., INCDOO or 18 for

the record numbers INCD00000187, INCD00100185). To apply the filter, click the checkmark icon ¥

. To remove the filter, click the clear icon |* ' and then the checkmark icon, to view the original list.

o Use the visual cues provided for each record entry to select the record that best suits your needs. In
the Listing pane, records are displayed as either locked from editing ) unlocked from previous
locking {-., or as unaltered - the latter meaning that the record has never been locked before. The
number of files attached to a record is displayed in parentheses. The status of the record may be
displayed as either Closed or Open. Drawn from the Controls tab, a record’s Closed status generally
means that the record has been processed up to a point where no further action is required. By

default, records are created as Open.

Incidenis ks

INCD Kiv | 3 i

INCD-2011-02-00021 b L1l

{0) Non-Criminal Open
%) INCDO000000187
(1) Policy Viclation Closed
" INCDO000000186 Ll

(3) Non-Criminal/Security & Safety Syste Closed

Once you have found the record you would like to work with, click on the record entry in the Listing pane
to display it in the Viewing pane.

Note: If you clicked on a particular record in the Record Views window prior to clicking Select, this record will
be highlighted in the Listing pane and will already be opened in the Viewing pane.

Enter and/or Edit Record Data

Depending on the data form that is currently open and on your user privileges, a variety of buttons are

available on the Viewing pane toolbar, allowing you to perform a number of record functions.

Viewing Pane Toolbar

A Save Saves changes made to a record.
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.F Edit

Switches a record into the edit mode. After clicking Edit, select the field
you want to edit and make the necessary change.

gF Add

Creates a new record from scratch.

¥ Delete

Removes an entire record from the database.

3 Lock

Bars a record from editing.

51 Unlock

Makes a record available for editing. (This button will only appear if the
record is currently locked.)

=  Print

Prints, displays, or saves the PDF copy of a record in the report form. After
clicking Print, specify which part of the report you would like to print. On
the Report Visibility form, specify which record sections you would like
included in the report and whether you want to download attachments,
and then click OK. Finally, choose to either view a printable copy of the
report (Open) or save a copy of the report to the location of your choice
(Save).

Send

(Activity, Incident,

Emails record details. After clicking Send, a new email window will open
with general record details included in the body of the message. To
format the message details in plain text rather than the default HTML

= table, click the Format icon. Specify the user or email address you would
and Case forms . . . . .
like the message to be delivered to, review the message details, and click
only) Send. For further details on operating the Send Message editor, consult
Appendix B: Text Editor Navigation at the end of this guide.
& Merge Merges partially duplicate records that correspond to a single physical
referent that is an item, a person, an organization, or a vehicle. The
"
& (Items, Persons, function is represented by the Merge Items, Merge Persons, Merge
- Organizations, . . . L
3 Organizations, and Merge Vehicles buttons on the respective Viewing
- and Vehicles pane toolbars. For details on merging of records, see the Merge Records
&2 forms only) .
section.
k4 Cancel Switches the record from edit to read-only mode without saving changes.
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@ To find out who created the record (Created By) and who last modified it
(Last Modified), click the record’s top shield icon. To access similar

Audit information for one of the record’s entities (e.g., a specific Narrative or an
Involved Person entry), select the appropriate entity in the grid and hover
your mouse over the bottom shield icon. You may also click the icon to

view the information in a pop-up window with added detail.

Some tabs consist of sub-tabs for further grouping of the data contained within. Whenever data in tabs is
further subdivided into sub-tabs, Perspective enables editing of the sub-tabbed data (e.g., Involved
Persons) with an additional sub-tab-specific toolbar. The quantity and the names of the functions included
in this toolbar vary depending on the type of information contained in the sub-tab, although they may be
similar to the ones performed by the buttons included in the Viewing pane toolbar.

= save || 7 Edit gfpadd < Delete | (3) Lock d=hPrint [ISend | €) Cancel |

< (General % |mvolvements % Marratives < Attachments < Links < Loss Summary < Investigal 4 p

Persons  Organizations \ehicles ltems

| = Add New = Edit = Remove = Goto

Involved Person: 4

Ld Linked Person Last Name First Name Initial Involvement Type Date of Birth
Rebarski, Dana  Rebarski Dana Reported By Fe

To start editing details inside the record, you have to first put the record into the edit mode by clicking
Edit .7 on the Viewing pane toolbar. Then, to apply changes to a record’s entity (e.g., an Involved Person),
select the entity in the grid and use the functions displayed in the sub-tabbed toolbar. The following table
presents the common functions that are available in all data form types (the rest of the buttons that you
may encounter in a sub-tabbed toolbar will be discussed in sections that describe the specific entities in
detail).

Common Data Form Functions

Opens a pop-up form that contains the data of the entity. Make necessary
Edit changes to the fields (or plain text) in the form and click OK (or Accept &
Return) to return to the main record.

Add New Creates a new entity within a record (e.g., a new Involved Person entity).

Remove Removes an entity within a record (e.g., an invalid Involved Person entity).

m © Resolver Inc. Confidential. Do not distribute. Page 54 of 350



Perspective User's Guide Data Forms

Go To

Opens an entity’s corresponding record, typically, in a different data form
component. For example, going to the Involved Person entity involves opening
the associated editable Person record in the Persons component of Perspective.
In order to return the original data form (i.e., Incidents), select the required
component from the Navigation pane. The views of both forms will be
preserved.

Read/View

The Read and View options function similarly to Go To, with the only difference
being that they open the entity in a read-only mode, where you may be able to
zoom its contents, and/or print it, but not edit it. View allows an attachment to
be saved to your computer, or opened and viewed in an appropriate
application (i.e., an attached .doc file would open in Microsoft Word). You may
scroll through the other entities of the same type (e.g., narratives, investigation
summaries), without leaving the pop-up window, using the Previous and Next
buttons.

Seal/Unseal

Removes/restores editing rights from/for an entity.

Note: Once you seal the entity, and then save and leave the corresponding record,
it can never be unsealed. A new entity must be created in order to record
amendments to the original one. Even if an entity is left unsealed, the Author is
the only user authorized to edit the entity, unless special privileges have been
granted to another user to do so. (If this button is not visible to you, your
Administrator has not granted you the right to seal entities.)

History

To see the history of incidents in which a particular case-involved person,
organization, vehicle, or item has been involved, select the entity of interest in
the grid and click History. A new window will appear that displays a table of the
entity’s involvement in the incidents stored in your organization’s Perspective
database. For further details, see the View All Case’s Involvements section.

In a new data form, field with red titles are required to be completed (Figure 3.2.9). If you save the record

before completing all required fields, the system will display a system message requesting completion of

these fields. To see the classification and navigation of the available field types, see Appendix C: Data

Field Types at the end of the guide.
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Incidert Mumber Reported Date/Time
0314/201310:50 M = EHH X

File Mumber Occumed From Date/Time
081420131050 AM = EH X

e-Incidert Number Occured To Date/Time

B izci 4
Note: Your organization's data forms may contain additional fields, the so-called User Defined Fields.

Usually, they appear under a separate like-named section. These fields will require entering additional pieces
of information that may not be covered in this guide.

Incidents

Create a New Incident Record

Note General Details of the Incident

1. Click the Add button 5 in the Viewing pane toolbar.
e Perspective will automatically assign an Incident Number when the record is  saved. The e-
Incident Number field is reserved for electronic reports that have been accepted from the
Gateway into Perspective. Once the report is accepted as a valid Incident record, it is
automatically assigned a new Perspective Incident Number, while its original e-Incident Number
is preserved for cross-referencing purposes.
2. If applicable, input a file or reference number under File Number.

3. Indicate when the incident was reported to supervisors under Reported Date/Time.

4. Note when the incident began under Occurred From Date/Time and when the incident ended
under Occurred To Date/Time.

e The Incident Duration will automatically be calculated when the record is saved.
5. Identify the incident's classification using the Class, Category, Subcategory, and Type lookup lists.
e These fields are hierarchical, meaning that the option selected in the first field (i.e., Class)

determines the options that are available in the second field (i.e., Category) and so on. The

options that appear in these lists have been customized by your organization.
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e Specify where the incident occurred by making selections from the Site, Building, Location, and
Section lookup lists.

e Like the fields in the incident’s classification section, these fields are hierarchical.

6. Identify which business unit the incident affected by selecting options from the Level 1 to Level 4
lookup lists, if applicable.

7. Type a brief overview of the incident in the Summary box.

e To enter a more detailed description of the incident, outline the sequence of events under the
Narratives tab.

bk,

/Ir { New Incidentx9 } @

‘Al Save T Edit Add Delete Lock Print Send | &3 Cancel

| Involvements Narratives Attachments Links Losses Investigation < Controls F 4 )
# Details 'S
Incident Mumber Reported Date/Time
ADMI-2013-000174 08142013 1153 AM  + EH X
File Mumber Occumed From Date/ Time
TH-3012-B 08132013 1125 AM  + EH X
e-Incident Number Occured To Date/Time Incidert Duration

081372013 12:02PM 2 [EH X

Class Site Level 1

Criminal - Engineering | | APAC -

Category Building Level 2

Aszsault - Production - Corporate Office -

Subcategory Location Level 3 =
Injury - Internal Components | | Amazon -

Type Section Level 4

Mo Wweapon - Circuit Boards - -

Summary

On the above mentioned date and time, the complainant, Kathy Howard, reported to security that during her
lunch break, she was assaulted while in her cubicle.

She was grabbed roughly by her arm, pushed to the floor, and the man fled the building.
Currently, there are no suspects in this incident. The only available witness is Sandy Smith, who is se_ated in

the cubicle section three rows over, and could only say that the lant was male. In
Follow-up to be completed.

¥ Supplemental Details
¥
¥

Flags

4 I 2

Indicate Which Authorities Have Been Notified of the Incident

1. In the Supplemental Details section, check the Reported to Police box if the police have been

notified of the incident, and then input the Police File Number.
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2. If another division in your organization has been notified of the incident, check the Reported to
Division box and specify the Division Reported To.

3. If you reported the incident to your supervisor, check the Reported to Supervisor box. Then, select
the name of your supervisor from the Supervisor Reported To pick list. If no relevant Person record
is found in the database, use the Quick Add function to create one.

4.  If the incident requires follow-up, check the Follow-up Required box and enter the Follow-up
Date.

< General Involvements Narratives Attachments Links Losses Investigation 4 Controls 4P

¥ Detais

% Supplemental Details

Police File Number

V| Reportedto Police OCC-131-54
Division Reported To
V| Reported to Division Security -
-Supervisor Reported To
V| Reported to Supervisor 8 Brown, Joe ‘{,5 x
Follow-up Date
V| Follow-up Required 08252013 cHE X
¥ Flags
Flag the Incident
1. In the Flags section, select each flag's Status (i.e., Yes, No, or Unknown), depending on whether or

not the flag applies to the incident.
e Examples of flags include Hate Crime, Drugs/Alcohol Involved, and Weapon Involved.

2. Add any applicable notes under Flag Notes.
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< General < |mvolvements < Narratives & Attachments < Links % Losses % Investigation 4 )
¥ Details

¥ Supplemental Details

A Flags
Description Status

v V' Workplace Violence Mo -

v@ K Suspect Known to Victim Unknown =

" H Hate Cime No -

@ D Drugs/Alcohal Involved Mo -

i N DHS No -

Flag Motes

The incident did not involve violence. -
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Identify All Involved Persons

Note General Details of an Involved Person

1.  Select the Involvements tab.
2. Select the Persons sub-tab.
3.  Click Add New. A pop-up window will open.

4.  Select the involved person’s record from the Linked Person pick list. If a Person record does not
already exist for this individual, use the Quick Add function to create one.

e The First Name and Last Name fields will now automatically populate with the linked person’s
name. Depending on the data available, some additional fields may also populate with
information drawn from the linked person’s record.

5. From the Involvement Type lookup list, choose the appropriate description.

6.  Enter the person’s Initial, Title (e.g., Mr.) and Designation (e.g., Chartered Accountant).

7. Specify the involved person’s Date of Birth, Gender, and Marital Status.
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8.

9.

10.

11.

12.

13.

14.

& Add New Record = | = 52
0K Cancel
Linked Person Involvement Type Associated Losses
= s Wit -
‘d\ é} IIness E,q,asure
[] Interviewed? [] Injured Averted Loss
[] First Aid Administered? [] Person Hospitalized? Total Loss
Total Recovered
MNet Loss

View Losses and Recoveries

Details

1,

First Name Last Name Initial Title
Jeff Brown L Mr. -
Date of Bith Designationis) Gender
03071974 TEX Male -
Hair Color Eye Color Marital Status
Brown - | | Brown hd -
Height Weight Employee Number

5117 200 Ibs 28671 Employee?

Notes
The only available witness is Jeff Brown, whao sits in the cubicle section (ADMIN-77) three rows over from Kathy,

Identify the person’s physical characteristics, including Hair Color, Eye Color, Height, and Weight.

If the person is an employee of your organization, check the Employee? box and enter the
Employee Number.

If the person was interviewed regarding the occurrence, check the Interviewed? box.

If the person received first aid, or was injured or hospitalized as a result of the occurrence, check the

First Aid Administered?, Injured, and/or Person Hospitalized? boxes.
Enter notes about the person’s involvement in the occurrence in the Notes text box.
To add a photo of the involved person to the record, click the Add icon %+ in the image box.

Locate the image file in the browser window and click Open.

Add the Involved Person’s Clothing Details

1.

2.

Open the Click to Add Clothing Details link.

Choose the Clothing Type and Color from the lookup lists.
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3. Enter a detailed description of the item in the Description box.

4.  Repeat for as many articles of clothing as necessary.

& Click to Add Clothing Details
B X

Clething Type Caler

Description

Record the Involved Person’s Sustained Injuries

1. Open the Click to Add Injury Details link.
2. Specify the Injury Cause and Severity.

3. Include a detailed description of the injury in the Description text box.
CSJ Click to Add Injury Details
E X

Injury Cause Severity

Description

4.  Repeat for as many injury entities as necessary.
Flag the Involved Person

1. In the Flags section, specify the Status (i.e., Yes, No, or Unknown) as well as the Severity of each flag
(e.g., Critical, High, Low).

e Flags may include such descriptions, as Trespasser, Violent, Infectious, Escapee, Wanted, etc.
2. Enter comments in the Flag Notes section.

3. Click OK.
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=7 Add New Record r=x B[
« 0K | &3 Cancel
% Flags i
Description Status Severity Flag Notes
Jeff Brown is the anly witness of the incidert |
¥ W Wanted Yes - || Critical -
WV Vidlent Ifarm < 2
\'_— T Trespasser Yes || Low -
‘\) I Infectious MNe - -
v R Escapee N - -
A A Amed and Dangerous Mo - - E

4. Asyou click OK, the newly created entity will be displayed in the Involved Persons list, each entity
occupying a single row in the list.

e To display the entity’s general information in the bottom Viewing pane, select the corresponding

row in the list.

¢ General | Involvements | Narratives Attachments Links  Losses Investigation < Controls  Audit History - 4 )

Persons | Organizations  Vehides  Ttems -
Involved Person: 1

= Add New

- Edit - Remove = GaTo

14 Lastlame  Linked Person  First Name Initial Involvement Type  Date of Birth Gender Employes? Interviewed?  Person Loss?  Notes
Brown deif L Wiiness 030711874 Male | Il The only availab.

Title. First Name Intial Last Name Involvement Type
Mr. Jeff L Brown Witness

Date of Bith Gender Marital Status Designationis)
371974 Male

Hair Color Eve Color

Brown Brown es: 0

Clothing: 1

Notes
The only available witness is Jeff Brown, who sits in the cubicle section
(ADMIN-77) three rows over from Kathy.

Add Losses and Recoveries Associated with an Involved Entity

1. Before you continue with entering losses or reviewing their summary, make sure that you saved the
involved entity’s sub-record by clicking OK and that you saved the Incident record by clicking Save.
This will update the calculations the system stores on the previously recorded losses.

2. Double-click the involved entity in the list that you want to associate a loss with (e.g., the Jeff
Brown’s Person record).

¢ In the Associated Losses section in the top right corner you will see the summary of the losses

previously associated with the open entity, including a summary of the entity’'s recovery

(Exposure and Averted Loss), Total Loss, Total Recovered loss, and Net Loss.
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Exposure $ 000
Averted Loss $ 0.00
Total Loss $ 300.00

Total Recovered $ 5000

Net Loss $ 25000

View Losses and Recoveries

To review the details of the losses associated with the entity, click on the View Losses and
Recoveries button under the Losses Associated To summary grid.

e A new window will open where you will be able to see the Date a loss was recorded, the Type of
the loss, the Method/Status/Cause the loss was or could have incurred, and the relevant value

of the loss.
-
Losses Associated To: Brown, Jeff l- g
e —
oK Close Add Loss Add No Impact Edit Remove
Date Type Method/Status/Cause Loss Recovery Mo Impact
OF 43073 Direct 6000 UED
081472013 | Recovered S 50.00 USD
il

To add a loss, select one of the following three options:
e To add a loss that has occurred, click Add Loss.

e To add a loss that has occurred and has been recovered, click Add Recovery.

e To add a potential exposure loss or an averted loss that is associated with the involved entity,
click Add No Impact.

Depending on the option you choose, a new screen will display a subform designed for the type of
loss you selected. Fill out the form’s fields following the guidelines in the Record Losses Involved in
an Incident and View Their Summary section.
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6. Click OK.

e Once the changes are saved, the recorded loss data will populate the relevant columns of the
Losses Associated To grid.

7. Add as many loss entries as necessary, repeating steps 4 - 6. Then, click OK to save the associated
losses on the involved entity’s record and see updated summary calculations in the Associated
Losses section of the subform:

e Exposure: The total value of the Exposure No Impact loss associated with the involved entity.
e Averted Loss: The total value of the Averted No Impact loss associated with the involved entity.
e Total Loss: The total value of the Loss amounts associated with the involved entity.

e Total Recovered: The total value of the Recovery loss associated with the involved entity.

e Net Loss: The value determined by subtracting the Total Recovery amount from the Total Loss.

Losses Associated To: Brown, Jeff !
= e ] a -— )
oK Close Add Loss Add No Impact Edit Remove
Date Type Method/Status/Cause Loss Recavery No Impact
BT Diret § 300007
087472013 | Recovered S 5000 USD

8.  Click OK on the main involved entity’'s subform.
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e The entity’s entry in the list will be updated with a checkmark under the
Person/Organization/Vehicle/Item Loss? Column. The loss will also be recorded as a separate
entry under the Losses tab.

9.  Click Save to synchronize the recorded data across the Perspective’'s components.

Person Loss?

Identify All Involved Organizations

Note General Details of an Involved Organization

Select the Involvements tab.
Select the Organizations sub-tab.
Click Add New. A pop-up window will open.

Hwn o=

Select the involved organization’s record from the Linked Organization pick list. If an Organization

record does not already exist, use the Quick Add function to create one.
e The Organization Name field will now automatically populate with the linked organization’s
name. Depending on the data available, some additional fields may also populate with
information drawn from the linked Organization record.
5. Specify how the organization became involved in the occurrence by selecting a description from the
Involvement Type lookup list.

6. If applicable, input the organization'’s file, ID, or other tracking number in the Organization Number
field.
Select an Organization Type from the lookup list.

8.  Specify the means by which the organization has been notified of the occurrence in the Notified By

lookup list.

9. If there is any documentation associated with the organization's involvement in the occurrence (e.g.,

a work order), note the associated tracking number in the Reference Number field.
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10.

11.

12.

13.
14.

&k Add New Record = [ B S
oK Cancel |
Linked Organization Crganization Mame nvolvement Type A iated Losses |
J_i Metropolitan Police EDJ P Metropolitan Police Service Responding ServicelAgency - Bposure

R Organization Number Organization Type Averted Loss

C-5870-D Municipal A -
unicipal Agency -
N Motified By Reference Mumber
7 Total R d
' l\dego?olltan ' Control Center ~| [He870 2 Recovere
MNet Loss

\nl 0 Ice - Contact Person Cortact Phone =

{ eBervices ; & Armando, Luis 5P X | [7805550123 View Losses And Recoveries

Comments
Responding Officer: James T. Dole, Badge 445

Select the name of the organization’s primary contact from the Contact Person pick list. If a Person
record does not already exist for the individual, use the Quick Add function to create one.

Enter the contact person’s phone number under Contact Phone. Ensure that you use a consistent
format when entering phone numbers.

Enter notes in the Comments box.

To add the organization’s logo to the record, click the Add icon % in the image box.

Locate the image file in the browser window and click Open.

Note an Action Request Sent to the Involved Organization

vk W=

Open the Click to Add Request Details link.

Choose the appropriate description for the requested action from the Request Type lookup list.

If there is a tracking or other ID number, enter it in the Reference Number field.

Enter the date the request was made in the Assigned Date field.

Select the record of the person who has been administered the request from the Request Assigned
To Person pick list. If a Person record does not already exist for the individual, use the Quick Add
function to create one.

When the action is complete, input the Completed Date.

Add any necessary Notes.

m © Resolver Inc. Confidential. Do not distribute. Page 67 of 350



Perspective User’s Guide Data Forms

EBJ Click To Add Reguest Details
- %

Reguest Type Tracking Mumber

Reguest Assigned To Person

& * X

Notes

Log the Involved Organization’s Response to the Incident

1. Open the Click to Add Response Details link.

2. Select the record of the person in the organization who responded to the incident from the
Responding Person pick list. If a Person record does not already exist for the individual, use the
Quick Add function to create one.

3. Select the record of the person who called the organization from Notified By Person.

4.  Enter the date and time the organization was contacted in the Called Date/Time field.

5. Enter the date and time the organization arrived on site in the Arrived Date/Time field.

6.  When the organization's response is complete and they have vacated the site, enter the completion
date and time in the Cleared Date/Time field.

7. Click the Calculate Time link to determine how long it took the organization to respond (Response

Time) and how long they remained on site (Time On Site).
8.  Add any useful Response Notes.

9.  Click OK.
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10.

&P Click To Add Response Detsils

B
Called Date/Time Responding Person
. r@E¥%x &
Amived Date/Time Notified By Person
JJ_____  :1@E¥X| B
Cleared Date/Time
i cEX
Calculate Time Response Notes
Response Time: 0 Hrs. 0 Min.
Time On Site: 0 Hre. 0 Min

W X
& X
& X

As you click OK, the newly created entity will be displayed in the Involved Organizations list, each

entity occupying a single row in the list. To display the entity’s general information in the bottom
Viewing pane, select the corresponding row in the list.

< General < Invol Narratives Attachi < Links < Losses Investigation < Controls Audit History

Persons  Organizations  Vehicles  ftems
Involved Organizations: 2

s AddNew = Edi = Remove = Goto

Linked Organization Organization Name  Involvement Type  Organization Number ~ Organization Type ~ Nefificd By Commenis Organization Loss?
Cape Breton Regional Police Cape Ereton Regiona.. Responding Servic. Municipal Agency  Investigator ]
Metropolitan Polics Service  Metropoliten Police S Responding Servic.  C-9870-D Municipal Agency  Control Center  Responding Offi r

Organization Name
Wetropolitan Folice Service

Reference Number

Metropolitan H-8870
!\ POliCe ) o

Contact Phone
780 555 0123

Resporses: 0

Request: 0

Organization Number
C-9870-D

Invlvement Type

Services 7 Wunicipl Agency Responding Service/Agency
° Notfied By Contact Person
Control Center Armando, Luis

ﬂ -

Add Losses and Recoveries Associated with the Involved Organization

Complete the operation, as described in the Add Losses and Recoveries Associated with an Involved
Entity sub-section in the Identify All Involved Persons section.

Document All Involved Vehicles

Note General Details of an Involved Vehicle

1.

Select the Involvements tab.

Select the Vehicles sub-tab.

Click Add New. A pop-up window will open.
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Select the involved vehicle from the Linked Vehicle pick list. If a Vehicle record does not already
exist, use the Quick Add function to create one.
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10.

11.

12.

13.

14.

15.

e The License Plate field will now automatically populate with the linked vehicle's license plate
number. Depending on the data available, some additional fields may also populate with
information drawn from the linked vehicle's record.

Indicate how the vehicle became involved in the occurrence by selecting a description from the
Involvement Type lookup list.

Select the most appropriate description of the vehicle’s current status from the Disposition lookup
list (e.g., Seized, Stolen, Released to Owner).

Specify the vehicle's Year, Make, Model, Style, and Color. Your selection in the Model field will
depend on the value recorded in the Make field.

If known, enter the vehicle’s VIN and approximate Vehicle Value.

If the vehicle belongs to your organization, check the Company Vehicle? box.

If known, indicate where the vehicle's license plate is registered in the Country and State/Province
fields.

If the vehicle's driver was identified, check the Driver Identified box. Then, select the driver's name
from the Vehicle Driver pick list. If a Person record does not already exist for the individual, use the
Quick Add function to create one.

Enter any applicable notes under Comments.

To add a photo of the vehicle to the record, click the Add icon %# in the image box.

Locate the image file in the browser window and click Open.

Click OK.
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-
& Add New Record o i ]
0K Cancel
Linked Vehicle License Plate Involvement Type A iated Losses | F
&, UDKg85 aP X [uDksss Suspect Y [ Epere
Disposition Year
Towed/Impounded - 2008 - Averted Loss
Total Lo
Make Style 3 toss
Honda - 4 Door Sedan = Total Recovered
Model Colar Net Loss =
Ridgeline - Red -
Wiew Losses And Recoveries
VIN Vehicle Value
[l Company Vehicle? 4LUKPI22272M33333 $ 40.000.00 USD
Country
Canada - bl Driver Identified
State'\Province Vehicle Driver =
Alberta - & Brown, Rosie % ~
Comments
Abandoned on premises. Stolen items found inside | -

16. As you click OK, the newly created entity will be displayed in the Involved Vehicles list, each entity
occupying a single row in the list. To display the entity’s general information in the bottom Viewing
pane, select the corresponding row in the list.

< General @ Involvements Marratives Aftachments ¢ Links & Losses Imvestigation < Controls Audit Histary 4
Persons  Organizations  Vehicles  Iltems
Involved Vehicles: 1

= Add Mew = Edit = Remove = Goto

Linked Yehicle License Plate  Involvement Type  Year Make/Model  Vehicle Loss? Comments

EUDKBGS— Honda/Ridgeline LUDKBES Indirectly Involved 2007 Honda/Ridgeline v LAbandoned on premizes. Stolen items.
License Plate Style
LIDKEEE 4 Door Wagen
ear Disposition
2007 Towed/Impounded
Involvement Type Color
Indirectly Inveolved Red
VIN Vehicle Value
4LUKPI222222M333333 $ 40,000.00 USD

'ﬁ CB: keith - 2/24/2012 1:33:46 PM - LM: keith - 2/24/2012 1:33:46 PM

Add Losses and Recoveries Associated with the Involved Vehicle

Complete the operation, as described in the Add Losses and Recoveries Associated with an Involved

Entity sub-section in the Identify All Involved Persons section.
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Identify All Involved Items

Note General Details of an Involved Item

1.

Select the Involvements tab.

Select the Items sub-tab.

Click Add New. A pop-up window will open.

Select the involved item’'s name from the Linked Item pick list. If an Item record does not already

exist, use the Quick Add function to create one.

e The Item Name field will now automatically populate with the linked item’s name. Depending on

the data available, some additional fields may also populate with information drawn from the

linked item’s record.

If known, enter the serial or ID number of the item in the Serial Number field.

Select the most appropriate description of the item'’s current status from the Disposition lookup list

(e.g., Seized as Evidence, Destroyed, Returned to Owner).

& Add New Record

G x

oK Cancel

Lirked tem Hem Name
&, Laptop Computer 5P < ptop Computer

" Serial Humber
XTP-4005
I Disposition
_— ) Seized As Evidence -
L CE— tem Value
%] s s 213500 USD
[ hemis Evidence?
tem Category frem Maks
Corporate Property i Dell -
tem Type frem Model
Laptop - Inspiran E1705 -
] Owner Identiied/Knovn?
Orgarization Owned By Person Owned By

& TML Inc g X & Howard, Kathy 5P %

Notes
Located at the cubicle ADMIN-78.

Losses

Expasure
Averted Loss
Total Loss

Total Recoversd

Net Loss

View Losses And Recoveries

Enter the item’s exact or estimated value in the Item Value field.

If applicable, check the Item is Evidence? box.

Identify the general classification of the item by making selections from the Item Category and

Item Type lookup lists. These fields are hierarchical.
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10. Specify the Item Make and Item Model. These fields are hierarchical.

11.  If the item's owner is known, check the Owner Identified/Known? box. Then, select the name of the
organization or person that owns the item from either the Organization Owned By or Person
Owned By pick lists. If an Organization or a Person record does not already exist, use the Quick Add
function to create one.

12.  Add comments about the item in the Notes field.

13. To add a photo of the item to the record, click the Add icon &# in the image box.

14. Locate the image file in the browser window and click Open.

15.  Click OK.

16. As you click OK, the newly created entity will be displayed in the Involved Items list, each entity
occupying a single row in the list. To display the entity’'s general information in the bottom Viewing

pane, select the corresponding row in the list.

< General < Involvements Marratives Attachments Links Losses Investigation < Controls Audit History 4 »
Persons  Organizations  Vehicles  ltems

Invalved tems: 1

= Add Mew = Edit = Remove = Goto
Linked ltem ltem Name Category / Type Disposition ltem is Evidence?  ltem Loss?  Notes
Laptop Computer Laptop Computer Corporate Property/Laptop  Seized As Evidence 3 r Located at the cubicle...

ltem Name Category / Type

Laptop Computer Carporate Property/Laptop
ltem Value Make / Model
2,135.00 | Dell/Inspiren E1705
B Disposition Serial Number
s Seized As Evidence KTP-4005

Add Losses and Recoveries Associated with the Involved Item

Complete the operation, as described in the Add Losses and Recoveries Associated with an Involved

Entity sub-section in the Identify All Involved Persons section.

Summarize an Incident or a Case

1.  Select the Narratives tab.
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2.

Click the appropriate Add link. The Narrative Editor window will open.

Choose the applicable description from Narrative Type (e.g., Executive Summary, Original Narrative,
Follow-up). By default, your name will appear in the Author field.

Type your narrative in the text box.

e For details on operating the Narrative Editor, consult Appendix B: Text Editor Navigation at
the end of this guide.

When finished composing your narrative, click Accept & Return. The Narrative Editor window will
close, and the new narrative record will populate the Narratives grid.

< General < Involvements Marratives Attachments 2 Links ¢ Losses Investigation < Contrels Audit History 4 »

Total Namatives: 2
" AddNew = Edt = Remove = Seal = Read
Sealed Created By Date/Time = Narrative Type Author
[ 25111/2010 5:25:07 PM  Original Narrative Davis. lan

[ 25111/20105:30:34 PM  Follow-up Remnyakova, Svetlana A

November 25, 2010

On the 23rd of Movember, 2010, security received a call from the complainant Kathy Howard. Howard stated that her corporate laptop had been stolen during a break the
previous day, 22nd of November, 2010, while she was away from her desk.

Officer Davis responded and spoke with Kathy Howard who advised that she left her cubicle which is located in section 4Bof the administration office at approximatety 04:20PM
and went to the cafeteria. When she left her cubicle her comporat... |

W CB:remnyakova - 25/11/2010 5:25:07 PM - LM: remnyakova - 25/11/2010 5:25:07 PM

Attach a File to a Record

Select the Attachments tab.

Select the Files sub-tab.

Click the applicable Add link. A pop-up window will open.

Add attachments by either dragging and dropping or clicking Browse.

For each attachment, do the following:

a. The Attachment Title field will automatically populate with the name of the attached file. If
necessary, modify the name.
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b.  From the Attachment Type lookup list, select the appropriate designator for the attachment
(e.g., Document, Picture, Video, Voice Recording).

c.  Give an overview of the attachment in the Description text box.

d. Forimage files (e.g., .bmp, .gif, .jpg, .png), check the Include when Printing? box to have a
copy of the image included with every print-out of the record.

e. Click Remove to remove any unwanted attachments.

6. Once you are finished working with attachments, click OK.

i} Attachment Manager e = | |
Drag and drop fs below cor-
Remove Atachment Ttle Attachment Type m::;;‘“?” Description

Remove
Attachment Tt
Aachment Type
- 7] Include when prining?
Deseription
| i
File Name l
File Extension
Fie Size
0K Cancel
Ready

7. To preview an attachment, ensure the attachment is highlighted in the grid and click View.
8.  Once the attachment is loaded, click Open. The attachment file will open in a separate window.

9. Close the window to return to the record.

© General © |nvolvements © Marratives ¢ Aftachments @ Links © Losses Investigation © Controls Audit History 4 »
= Add New = Edit = Hemove = View

Total Attachments: 2

Attachment Title  Attachment Type File Name File Extension File Size Description
Origingl narrative  Document orig_narrative et 1 KB Original narrative of the incident (by Kathy Howard).
Dell Inspiron E1705 Picture dell_inspiron_e1705 irg 28 KB Photo of the stolen laptop.

remnyakowva - 48 - LM: remnyakova - 07
W cB nyak 26/11/2010 10:48:06 AM - LM: remnyak 26/11/2010 11:07:45 AM

View Attachments

There are two ways to view attachments in Perspective.
The first way to view an attachment is the following:

1. Select the Attachments tab.
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2. Select the Files sub-tab.

3. Click the file name you want to view from the list of attached files.

4.  Click the View link.

5. Click Open.

The second way to view an attachment is the following:

1. Select the Attachments tab.

2. Select the Pictures sub-tab. Thumbnails of attached files will be visible.

3. Left-click the thumbnail for a full screen view of the attachment.

4.  To close the full screen view of the attachment, click the X icon in the top right corner.

a. Right-click the thumbnail to view the title and description of the attachment. Right-click to go
back to the thumbnail.

Link the Incident to an Activity
1. Select the Links tab.
2. Inthe Activity Links section, click Add New. A pop-up window will open.

3. Specify how the incident and activity are related in the Link Type field (e.g., Common Call Source,

Common Location).
4.  Select the appropriate activity from the Linked From Activity pick list.

5. Indicate the date that the incident became associated with the activity in the Link Effective Date
field.

6. Type any additional information about the link in the Notes field.

7. Click OK.
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Link Effective Date

24/08/2011 cH X

Notes
Common Call Source: Phone 780 555 6677 (Officer D. Clark)

& 7 Add New Record =3I
oK Cancel
Link Type Linked From Activity
Commen Call Source - g ACT-2011-000129 ‘{I,J

8.  Click Save, after which this link will be automatically cross-referenced in the linked activity's record

under the Links tab.

< General % Involvements Marratives Attachments
Case Links
Incident Links

# Activity Links

«

Add New Edit

Remove Goto
MNumber of Linked Activities: 2

Linked From Activity Link Type Link Effective Date

ACT-2011-000015 Escalated to Investigation 18/05/2011

< Links

< Losses

MNotes

Investigation

< Controls

Audit History

4

EACT-ZD‘I‘I-DDD‘IZB Commeon Call Source 24/0872011

Commen Call 5.

Q -

Link an Incident to Another Incident

1.  Select the Links tab.

2. Inthe Incident Links section, click Add New. A pop-up window will open.

3. Select the appropriate incident from the Linked To Incident pick list.

4.  Specify how the two incidents are related in the Link Type field (e.g.,, Common Suspect, Similar

Description).

5. Indicate the date that the two incidents became associated with each other in the Link Effective

Date field.

6. Type any additional information about the link in the Notes field.

7. Click OK.
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57 Add New Record ==
" 0K | &9 Cancel
Link Type Linked To Incident
Same Class and Location - J_j. INCDO000000148 {',3
Link Effective Date
26/1112010 CEX
Notes

The linked incidert iz also a Company Property Theft and occumed at the Site A, .
Building 1, Location 1)

8.  Click Save, after which this link will be automatically cross-referenced in both Incident records under
the Links tab.

< General < Imvalvements Marratives Attachments < Links ¢ Losses Investigation < Controls Audit History 4 »
¥ Case Links
# Incident Links

= Add Mew = Edit = Remove = Addto Case = Goto

Number of Linked Incidents: 2

Linked To Incident Link Type Link Effective Date Notes

INCDODDD000148  Same Class and Location 26/11/2010 The linked incident is also a Company Property Theft and occurred at..

INCDODDD000057  Commeon Suspect 271172010 Commeon Suspect and M.O.

W CB:remnyakova - 26/11/2010 11:07:45 AM - LM: remnyakcova - 26/11/2010 11:07:45 AM

¥ Activity Links

To link all incidents in the grid and then open Incident record to a case, follow the procedures described

below:
1. Click Add to Case. A pop-up window will open.

2. Specify how the incidents are related to the case in the Link Type field (e.g., Common Person,
Related Incidents).

3. Select the appropriate case from the Linked To Case pick list.

4. Indicate the date that the incidents became associated with the case in the Link Effective Date field.
5. Type any additional information about the link in the Notes field.

6. Click OK.

7. A confirmation message will notify that links were created successfully. Click OK. These links will be

automatically cross-referenced in the linked Case record under the Links tab.
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Add Mew Record

« 0K | &9 Cancel

Link Type Linked To Case

Related Incidents ~| | CASE-2009-000005
Link Effective Date

10/12/2010 EX

MNotes

The incidents have identical involved persons and location |

Link an Incident to a Case

—_

Select the Links tab.

2. In the Case Links section, click Add New. A pop-up window will open.

3. Specify how the incident and case are related in the Link Type field (e.g., Common Person, Related

Incidents).

4.  Select the appropriate case from the Linked From Case pick list.

5. Indicate the date that the incident became associated with the case in the Link Effective Date field.

6. Type any additional information about the link in the Notes field.

7. Click OK.

&7 Add New Record
& 0K | &3 Cancel
Link Type Linked From Case
Commaon Person - -ﬂ. CASE-200%-000058
Link Effective Date
2211212010 g

Nates
The case is built around a common person.

[F=5 Kol =3

8.  Click Save, after which this link will be automatically cross-referenced in the linked case’s record

under the Links tab.
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< General < Involvements Marratives Attachments < Links < Losses Investigation < Controls Ludit History 4 »
% Case Links
= Add New = Edit = Remove = Goto
MNumber of Linked Cases: 3
Case Number Link Type Link Effective Date  Motes
CASE-2010-000027 Commeon Organization 01122010 Similar theft pattern

ADMC-2005-000124 Commen Organization 07012011 The case contains related incidents that occurred in the commen organization

CASE-2009-000058 Commen Person 2222010 The case is built around a commaon person.

W CB:remnyakova - 26/11/2010 12:31:22 PM - LM: remnyakova - 26/11/2010 12:31:22 PM

¥ Incident Links
¥ Activity Links

Record Losses Involved in an Incident and View Their Summary

The Losses tab within an Incident record can be used to add the following types of incident losses:
o Loss: A monetary loss that occurred in the course of the incident.

o Recovery: A loss amount associated with an incident that has been restored or regained as a result
of an action that had been implemented after the incident took place.

) No Impact Loss: A loss that has been associated with an incident that has either been prevented or
remains a potential loss and, hence, does not impact the Net Loss amount.\

1. To add a loss, open the Losses tab and click on the Add Loss, Add Recovery, or Add No Impact
hyperlink, depending on the type of loss that you want to record. Depending on the option you

choose, a new screen will display a subform designed for the type of loss you selected.

Note: Some of the following fields may not be available on the form that you see on the screen; those
fields will be supplied with additional directions.

2. Inthe process of adding a loss, you may choose to either associate the loss with the broader
Incident record or with one of the incident’s existing involvements (i.e., an involved person,
organization, vehicle, or item). To specify the type of data you want to associate your loss entry with,

select one of the options from the Associated Type lookup.

Note: If you want to add a loss associated with an incident’s involvement that has not been recorded
yet, you must first create an involved record under the Involvements tab before creating the loss record.
For a detailed description of the procedure of adding involved persons, organizations, vehicles, or items
to an Incident record, see the Identify All Involved Persons, Identify All Involved Organizations,

Document All Involved Vehicles, and Identify All Involved Items sections.
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10.

11.

12.

If you chose to associate the loss with any of the incident's involvements (e.g., Person Involvement),
select the specific unit of involvement that has been previously recorded under the Incident form
from the Associated To lookup (e.g., Brown, Jeff).

Note: The options available on the lookup have been cross-populated from each of the involvement's
sub-tabs and can only contain involvement records that had been created and saved prior to adding
the loss.

The same function is available under each of the involvements’ sub-tabs. For details, please see the
Add Losses and Recoveries Associated with an Involved Entity section.

Enter the Date that is associated with the loss (e.g., a date when the loss or the recovery occurred, or
a date when the no impact loss is most probable).

Enter the number of loss units, as well as the approximate value of each unit in the Unit(s) and
Value Per Unit fields. The Total field below will automatically calculate the total value of loss
multiplying the Unit(s) by the Value Per Unit values.

Identify the nature of the loss under Loss Type (e.g., Direct or Indirect, Averted, or Exposure).

If applicable, specify the reason for the actual or the potential loss you are recording under Loss
Cause (e.g., Accident, Deliberate, or Unintentional Act).

If you are recording a loss that has actually occurred, determine the current state of the lost unit(s)

under Loss Status (e.g., Compromised, Lost, Stolen, or Damaged).

Under Method, select a descriptor that best defines the way in which the loss occurred or can

potentially occur (e.g., Wired Transfer or Cash).
For actual and no impact losses, select the name of the person who recovered the loss or defined
the incident as incurring potential loss from the Recovered/Determined By Person pick list. By

default, the field will contain the name of the person recording the loss.

If you are recording a recovery, also complete the Recovered From Person and the Recovered
From Organization fields, as applicable.

Enter any additional comments under Notes.
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13. Click OK. Once the changes are saved, the recorded loss data will populate the relevant columns of
the Losses grid. For optimal analysis, you may arrange the loss entries by a column header (e.g.,
Associated To, Date, or Type) and change the position of the columns in the grid.

14. Click Save to synchronize the recorded data within the relevant involvement records and update the
summary calculations displayed to the right of the grid.

e Total:

Total Exposure: The total value of the Exposure No Impact loss associated with the incident and
the involved entities.

Total Averted: The total value of the Averted No Impact loss associated with the incident and
the involved entities.

Total Loss: The total value of the Loss amounts associated with the incident and the involved
entities.

Total Recoveries: The total value of the Recovery loss associated with the incident and the
involved entities.

Net Loss: The value determined by subtracting the Total Recoveries amount from the Total Loss.
e Losses: The total values of Loss amounts arranged by Loss Type (e.g., Direct or Indirect).

e Recoveries: The total values of Recovery amounts arranged by Recovery Type (e.g., Physical or

On-line Purchase).

¢ No Impact: The total values of Recovery amounts arranged by No Impact Type (i.e., Averted or
Exposure).
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< General < Involvements Marratives Attachments < Links < Losses Investigation < Controls Audit History 4
% Loss And Recovery Details Total

Total Exposure % 2.125.00 USD
Incident Loss S 7 Llosses:3 R ies: 2 No Impact: 2
ncident Loss Summary: 3588 ecoveries o Impa Total Averted < 790.00 USD
= Add Loss = Add Recovery = Add No Impact = Edit = Remove Total Loss % 8.442 00 USD
Date | Associated To Type Method/Status/Cause Loss Recovery Mo Impact Total Recoveries $ £80.00 USD
H Net Loss $ 7.762.00 USD
i 011972012 Inc.dents Direct ACH/Stolen/Deliberat  $ 2.432.00 US 0
OSSES
02152012 hem Invelvem  Wallet Direct ‘wired Transfer/Lost/A  § 3.22500 US Direct $ 5.717.00 USD
01/25/2012 Organization| Cape Breton Re  On-line Purcha  Merchant Credit S B80.00 USD Indirect $2.725.00 USD
- . . Recoveries
01/30/2012 Organization|  Sydney Police S Exposure Chegue/Stolen/Intenti § 2,125.00 USD
Fhysical $ 600.00 USD
0172572012 Person Involve  Brown, Jeff Indirect ACH/Lost/Intentional $ 272500 US Onine Purchase $ 80.00 USD
0272372012  Person Involve Hatfield, Carme  Averted CashiUnintentional - § 790.00 USD|] MNolmpact
Exposure % 2.125.00 USD
24/, i ol Vs A =
02/24/2012 Vehicle Invelve UDKEES Physical ‘wiright-off $ &00.00 US Averted £ 790.00 USD

Record Incident Investigation Data

Note General Details of an Investigation

1.

Select on the Investigation tab.

Select on the Details sub-tab.

In the General section, select the name of the person who ordered the investigation from the

Investigation Initiated By Person pick list. If a Person record does not already exist for the

individual, use the Quick Add function to create one.

Enter the date the investigation was initiated under Investigation Start Date.

If the investigation has undergone a review, enter the applicable date in the Investigation Last

Review Date field.

When the investigation is complete, enter this date in the Investigation Closed Date field.

Input general notes in the Investigation Comments box.
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< General % Involvements < Marratives < Attachments < Links < Losses < |nvestigation < Controls Audit History 4 »

Details  Summaries  Logs  Interviews  Evidence/Property

# General

Investigation Initisted By Person

), Davis. lan {:3 X Total Time Spent: 0 Hrs.
Investigation Start Date Total Expenses: $ 0.00UsD
2311112010 . BB X Total Evidence 0
Investigation Last Review Date Number of Interviews 0
09/12/2010 cEX

Number of Investigators 0
Investigation Closed Date
151122010 TH X Investigation Duration 3 dayls)

Update

Investigation Comments
The investigation was initially assigned to Officer Mairon Alvarez. Then, it was passed on to Officer lan -
Davis.

¥ Investigators

Assign an Investigator to an Incident’s Investigation

1. In the Investigators section, click Add New. A pop-up window will open.

2. Specify the applicable role of the investigator in the Investigator Type field (e.g., Lead Investigator,
Assisting Investigator, Forensic Specialist).

3. Select the record of the investigator from the Investigator pick list.

4. Inthe Assigned Date field, enter the date and time the person was assigned to the investigation
team.

5. If the investigator is removed from the investigation team at some point, you may enter the
applicable date and time in the Completed Date field.

6.  Enter any relevant notes in the Comments box.

7. Click OK.
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25 Add New Record [= ===
o OK | &) Cancel
nvestigator Type nvestigator
Lead Investigator - _ﬁ, Davis, lan Eﬂﬂ b
- g Completed Date
23ivzo01200PM D OEE K| oy o EX
Commerts
The investigation was passed on to Davis on the same date asthe -

incident was reported |

8.  Add as many investigators to the Investigators list as necessary.

& General @ Involvements < Marratives < Attachments < Links < Losses < |nvestigation < Controls

Details  Summaries  Logs  Interviews  BEvidence/Property

¥ General
% Investigators

= Add Mew = Edit = Remove

Total Investigators: 3

Assigned Date  Investigator Type Investigator Completed Date  Comments

Audit History 4 p

23112010 Lead Investigator Davis, lan The investigation was passed on to Davis on the same dat..

16/08/2011  Assisting Investigator Adams, Abbott

241112010 Assisting Investigator Campbell, Keith 260112010 Officer Campbell's invalvement in the investigation was ter_.
¥ CB:remnyakova - 26/11/2010 3:16:58 PM - LM: davis - 26/11/2010 3:43:24 PM

9.  Click Save. An Auto Notification pop-up window will appear.

e To send an email notification of the assigned investigation to the investigator, ensure the

appropriate checkbox is selected and click Send. Notifications are automatically sent in HTML.

Deselecting the Send Formatted box, prior to clicking Send, will format the notification details

in plain text rather than the default HTML table.

o |If the investigator does not have a primary email address entered in the system, an error

message appearing beside the investigator's name will indicate that an email cannot be sent. In

this case, click Close to exit the window.

m © Resolver Inc. Confidential. Do not distribute.

Page 85 of 350



Perspective User's Guide Data Forms

« Auto Netification [
Record changes have been saved. To send any of the folowing autonctifications to
“| the emal addresses ksted, ensure the appropiate checkboxes are selected and diick Send
Othernise, click Close to edt this window without sending any information
Type Sand Notification To
4| Assigned Investigation Davis. lan (idavis@ppm2000.com)

Assigned Investigation ¥ Campbell, Keith (Email cannct be sent)

Select A Desslect Al - Send Fomatted |V Cose ] Send..

Summarize an Incident’s or a Case'’s Investigation

1. Select the Investigation tab
2. Select the Summaries sub-tab.
3. Click the appropriate Add link. The Summary Editor window will open.

4.  In the window, choose the applicable description from the Summary Type lookup list (e.g.,
Investigation Summary, Follow-up). By default, your name will appear in the Author field.

4. Type your summary in the text box. For details on operating the Summary Editor, consult Appendix
B: Text Editor Navigation at the end of this guide.

5. When finished with your summary, click Accept & Return. The Summary Editor window will close,
and the Summary's grid will populate with the new investigation summary.
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< General < Involvements Marratives Attachments < Links < Losses Investigation < Controls 4 b

Details Logs  Interviews  Evidence/Property

Total: 2

= Add New = Edit = Remove = Seal = Read

Sealed Created By DateTime Author Summary Type
v 26/11/2010 4:55:58 P.. Dawvis, lan Executive Summ...
r 26/11/2010 4:55:59 P.. Davis, lan Follow-up

This record was sealed by davis on 26/11/2010 3:38:52 PM
November 28, 2010

On the 26th of November, 2010, a report was received from Marie Walsh, an employee in Support Services. Marie had called the security hotline advising that she had spoken
to another employee who she would not name.

Walsh advised that the unknown person states that Jeff Brown was the once inveolved in the thefts and that he had one of the stolen PDAs in his desk drawer.

On Movember 27th, 2010, Officer Davis called Jeff Brown to the security office. Brown amived at the se...

W) CB:davis - 26/11/2010 4:55:59 PM - LM: davis - 26/11/2010 4:55:59 PM

Log Investigative Tasks and Expenses

—_

Select the Investigation tab.

2. Select the Logs sub-tab.
Click the appropriate Add link. A pop-up window will open.

4.  Specify the nature of the task in the Task Type field.
5.  Select the name of the person who completed or must complete the task from the Task Done By
Person pick list. If a Person record does not already exist for the individual, use the Quick Add

function to create one.

6. If applicable, specify the date the task was finished under Task Date, and the time it took to
complete under Time Spent.

7. If there is an expense associated with the task, enter the Expense Type and the total Expense
Amount.

8.  Check the Follow-up Required? checkbox, if applicable.

9.  Enter any additional information about the task under Log Notes.
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57 Add New Record =] o =)

« 0K | & Cancel

Task Type Task Done By Person

General Investigation g Davis, lan {,‘3 P
Expense Type Task Date

Administrative - 26/11/2010 D E K
Expense Amourt Time Spent

§ 12050 CON 10 Hrs. 3014 Min.

[ Follow-up Required?

Log Motes
Background checks -

10. Click OK. The investigative task and/or expense will be added to the Logs grid.

& General 2 Imvolvements < MNarratives < Attachments < Links % Losses & |Imvestigation < Controls Audit History 4
Details  Summaries  Logs  Interviews  Evidence/'Property

= Add New = Edit = Remaove

Total: 3
Follow-up Required? Task Date Task Type Task Done By Person Time Spent Expense Type Expense Amount
v 251172010 General Investig.. Campbell, Keith 8.0hrs % 0.0 USD
v 26112010 Interview Davis, lan 2.0hrs Administrative $ 55 UsSD
I 2611172010 General Investig. Davis, lan 10.5 hrs Administrative $ 1205 USD
Background checks. -

W) CB:davis - 26/11/2010 4:55:59 PM - LM: davis - 26/11/2010 4:55:53 FM

Document Investigation Interviews

1. Select the Investigation tab.
2. Select the Interviews sub-tab.
3. Click the appropriate Add link. The Interview Editor window will open.

4.  In the window that appears, choose the applicable description from the Interview Type lookup list

(e.g., Interview or Interrogation).

5. Select the name of the person who was interviewed from the Subject of Interview pick list. If a

Person record does not already exist for the individual, use the Quick Add function to create one.
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6.  From the Subject’s Involvement Type lookup list, specify the nature of the interviewee’s

involvement in the occurrence.

7. Select the name of the person who conducted the interview from the Interview Conducted By pick
list. If a Person record does not already exist for the individual, use the Quick Add function to create

one.
8.  Specify the Start Date/Time and the End Date/Time of the interview.
9.  State where the interview was conducted in the Location of Interview field.
10. ldentify the person who formally witnessed the interview in the Witness field.

11.  Check the Interview Recorded? box, if applicable.

12. Type the interview transcript in the text box. For details on operating the Interview Editor, consult

Appendix B: Text Editor Navigation at the end of this guide.

] g = Interview Editor CEmx
/
Interview Import/Export Tools Spelling
w g@ ! |:| [ Undo B I 0|= E ® Sealed
W l_l | 4 Redo
Accept& Cancel & Cut Copy Paste Normal Page Style Float Show'Hide
Return Return Fields
Document Edit Text Style Interview Details
Interview Type Subject of Interview Subject’s Involvement Type Interview Conducted by
Interview - ) Brown, Jeff L ‘-{b X Subject of Interest - & Davis, lan "{b »
Start Date / Time End Date / Time Location of Interview Witness
2712010 10:30AM B X 2neoi0iz3opm D E X Security office, Interview room #1 Whie, Pamela - Badge 335 [ Interview Recorded?
Aial Namow -1 » 1= | 1= [ T 100% v [Nomal] -
1 2 2 4 5 1 7 13 ]
Bl B B B BT B ,
Interview Report =
Date of Interview: November 27, 2010
Time of Interview: 10:30 AM =
Location of Interview: Security office, room #1
Interviewer: lan Davis
Interviewee: Jeff Brown
Interview Narrative:
Davis: Jeff, we have information from another employee that say vou were involved in the thefts from Section 1 in Building A this month. Is this true? =2

13.  When finished composing the transcript, click Accept & Return. The Interview Editor window will

close, and the new interview record will be entered in the Interviews grid.
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< General & Involvements < Marratives < Attachments < Links < Losses <% |nvestigation < Controls Audit History 4 p
Details ~ Summaries Logs  Interviews — Evidence/Property

= Add Mew = Edit = Remove = Seal = Read

Total: 1
Sealed  Interview Type = Subjectof Interview Subject's Involvement Type Interview Cenducted by Start Date / Time Interview Recorded?
r Interview Brown, Jeff L Subject of Interest Davis, lan 271172010 10:30 AM v

Interview Report -

Date of Interview:
Movember 27, 2010
Time of Interview:
10:30 AM

Location of Interview:
Securty office, room #1
Interviewer:

lan Davis

Interviewee:

Jeff Brown 2

m

W CB:davis - 26/11/2010 5:17:05 PM - LM: davis - 29/11/2010 2:56:45 PM

Track Investigation Evidence

10.
11.

Select the Investigation tab.

Select the Evidence/Property sub-tab.

Click the appropriate Add link. A pop-up window will open.

Input the item name under Evidence/Property Name.

Choose the applicable description from the Evidence/Property Type lookup list (e.g., Found,
Recovered, Seized).

If known, select the name of the organization or person who owns the item from the Owner Name
Organization or Owner Name Person pick lists. If an Organization or Person record does not
already exist, use the Quick Add function to create one.

Specify the date and time the item was found/seized in the Found/Seized Date/Time field.
Describe where the item was found or seized in the Found/Seized Location field.

Select the person who seized the item from the Seized By Person pick list.

Indicate who the item was seized from by making a selection from the Seized From Person pick list.

Type any additional information about the item in the Notes textbox.

To add an image of the item to the record, click the Add icon '=# in the image box.
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12. Locate the image file in the browser window and click Open.

13. In the Current Status section, choose the appropriate descriptors from the Evidence Status and

Disposition lookup lists.

14. If the item is secured, enter the current location of the item in the Secured/Storage Location field.

15. Select the person who is currently in possession of the item from the Person In Possession pick list.

16. Input the applicable number in the Evidence/Property Tag field.

Edit Record
+" 0K | & Cancel

Details

Evidence / Property Name
Recovered Missing PDA

Evidence / Property Type

Owner Name Organization
ﬁ Advanced Security Inc. % )‘(

Owner Name Person

Person In Possession Evidence / Property Tag
3 Howard, Katheri &P 7|  D6-T4563

Chain of Custody

Status Changed Date/Time Evidence Status Disposition

Recovered -

Found / Seized Date,/Time
7111/2010 12:00 PM CHE X

Found / Seized Location
Desk of Jeff Brown, ADMIN-77

Seized By Person

fi Davis, lan % )‘

Seized From Person

ﬁ Howard, Katherine M % >< fi Brown, Jeff L % )‘
Notes
PDA seized from Jeff Brown's desk drawer. Retumed to owner. -
Current Status
Evidence Status Disposition Secured / Storage Location
Unsecured ~| |Released to Owner -

= Print % Update Chain of Custody
Storage Location Person In Possession

Evide *

17. Click OK to save the entity in the Evidence/Property grid.
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< General % Involvements < Marratives % Attachments < Links % Losses < Investigation % Controls Audit History 4 p
Details  Summaries  Logs  Interviews  Evidence/Property

= Add New = Edit = Remove
Total: 1

Evidence / Property Name Evidence / Property Tag Evidence / Property Type Found / Seized Date/Time Disposition Evidence Status

éReDmrered Missing PDA  06-T4563 Found 27112010 12.00PM  Released to Owner Unsecured

Evidence / Property Name
Recovered Missing PDA

Notes
PDA seized from Jeff Brown's desk drawer. Returned to owner.

W CB: davis - 29/11/2010 5:38:19 PM - LM: remnyakova - 25/08/2011 4:57:46 FM

If you need to update the evidence's current standing, you have to open the relevant evidence entity in

the edit mode, make the necessary changes to the fields listed under Current Status, and follow the
procedures described below:

1. Click the Update Chain of Custody link. A pop-up window will open indicating that one or more of
the status fields have been changed.

2. By default, the current date will appear in the Status Changed Date/Time field. Modify this if the
item'’s status actually changed at an earlier date.

3. Explain the change to the item’s status in the Reason for Status Change textbox.

4% Chain of Custody Details (=3

One or more of the status fields have changed.Enter the date of when
the changed occurred and why.

Status Changed Date/Time
231120101200 PM S EH X

Reason for Status Change
PDA released to owner.

¢ 0K |6 Cancdl |

4.  Click OK. A new entry will now appear in the evidence record’s Chain of Custody section, detailing,
among other things, when and why the change was made.

5. If you want to print the Chain of Custody grid, click the Print hyperlink.
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Note: The Chain of Custody is not included in the Investigation Report. Therefore, this printing option is

only available via the Evidence/Property sub-tab.

Edit Record
" OK | &3 Cancel

Details

Found / Seized Date/Time
2711172010 12:00 PM cH X

Current Status

Evidence Status Disposition

Secured - Released to Owner A

Secured / Storage Location

Person In Possession Evidence / Property Tag
B Howard, Katheri 59 2| 06T4563

Chain of Cust )
Chain of Custody o= Print.. | % Update Chain of Custody

Status Changed D Evidence Status  Disposition  Storage Personn Pos  Bvidence /P Reason for Status Change

. ecored Mg POA.
! - . ) !
’ %vvv‘? PO OOV FFPOIOre

p i 291712010 Unsecured Released t. Howard, Kath. Ob-T4563 FPDA released to owner.

07/06/2011 . | Secured Released t.

Howard, Kath. |D&-T4563 The evidence has been re-clai.. .

View an Incident’s Key Investigative Data Summary

1. Select the Investigation tab.

2. Select the Details sub-tab. The incident’s key investigative data will be displayed in the form of a

table next to the general details of the investigation:

Logs sub-tab.

Total Time Spent: The total number of hours spent on the investigation to date, drawn from the

e Total Expenses: The total cost of investigation to date, drawn from the Logs sub-tab.

e Total Evidence: The total number of evidence pieces that investigators have collected to date,

drawn from the Evidence/Property sub-tab.

¢ Number of Interviews: The total number of interviews that investigators have conducted to

date, drawn from the Interviews sub-tab.
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e Number of Investigators: The total number of investigators examining the incident, drawn from
the Investigators section of the Details sub-tab.

¢ Investigation Duration: The length of the investigation, based on the time elapsed from the

Investigation Start Date to the Investigation Closed Date (or current date if the investigation is
not yet closed).

3. To refresh the information in the summary table, click the Update link.

4.  Every time a review of the investigation is conducted, make sure to change the Investigation Last
Review Date field.

5. Once the investigation is completed, enter the relevant date in the Investigation Closed Date field.

< General < |mvolvements < Marratives % Attachments % Links < Losses < Investigation 4 p

Details  Summaries  Logs  Interviews  Evidence/Property

% General
Investigation Inttizted By Person
&, Davis. lan g0 X || Total Time Spert: 205 Hrs.
Investigation Start Date Total Expenses: % 126.00CDN
23011/2010 - B X Total Evidence: 1
Investigation Last Review Date Number of Intervisws: 1
08122010 PE X
e Number of Investigatars: 4
Investigation Closed Date
1501212010 = Investigation Duration: 22 dayls)
Update

Investigation Comments

The investigation was initially assigned to Officer Mairon Alvarez. Then, it was passed on to Officer lan
Davis.

¥ Investigators

Control a Record’s Processing Options
Set the Security Controls and Status of a Record

1. Select the Controls tab; the Details sub-tab will open by default.

2. Inthe Controls section, fill out the Org Level fields to set the record visibility settings for the various
groups within your organization. Organizational rollups are hierarchical, so the option you select in

the Org Level 1 field will determine what options are available in the Org Level 2 field, and so on. As
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you move down the hierarchy, organizational rollups become more specific, naming groups within
your organization that are increasingly specialized by company division or region.

Only users with organizational rollups corresponding to or higher than the organizational rollup you
select for the record will have access to it. For example, if a record’s rollup is North
America/Canada/Alberta, the user whose organizational rollup is North America or North
America/Canada/Alberta will have access to the record, while the user whose organizational rollup is
North America/Canada/Alberta/Edmonton will not.

3. Inthe Access Level field, set the security level from 1 to 5. Each security level corresponds to a
specific security description, such as Classified. Only users with the same security Access Level as the
one you select (or higher) will be able to view the record.

4.  If you want to archive the record making it unavailable for users to access, check the Archive
(Record is not visible) box.

5. Set the Status of the record to Open or Closed. Meanings of open and closed are dependent on
your organization’s definition of these statuses. Generally, an open record means that it is actively
being worked on or, possibly, is inactive for a finite amount of time. The closed status in this case
would mean that the record is no longer being worked on due to completion or inactivity for an
indefinite amount of time.

6.  Select the most appropriate description of the record’s current standing in the Disposition field
(e.g., Inactive, Pending Court, Waiting for Approval).

7. If any policy, legislation, or business rule pertinent to your organization's procedures requires
information about the record, or the persons involved in the record, to be kept for a certain length
of time, enter the end date of that period in Expiry Date.

Note: No information will automatically be deleted on this date; it is for tracking purposes only.
8.  From the Record Owner pick list, select the Person record that corresponds to the individual who is

responsible for the closing the record. If a Person record does not already exist for this individual,
use the Quick Add function to create one.

m © Resolver Inc. Confidential. Do not distribute. Page 95 of 350



Perspective User's Guide Data Forms

< General < Inveolvements < Marratives < Attachments < Links % Losses < Investigation i)

Details Outcome Reviews  Assignments

% Controls

Org Level 1 Access Level

Morth America - Level 3 | [ Archive (Record iz not visible)
Ong Level 2 Status Record Owner

Canada - Open - Ed Abrame, Temy CDJ >
Org Level 3 Disposition

Alberta 7 Under Investigation -

Ong Level 4 Expiry Date

Edmonton T | 24n120m cE X

¥ Wworkgroup Visibilities

Define Which Workgroups Can Access a Record

In the Workgroup Visibilities section, give one workgroup the ability to read and modify the record
by selecting them under Owner Workgroup (Full Rights). Initially, the field will contain the name of
your default workgroup. Once you attempt to change it, the system will display a confirmation
dialog asking you if the Full Access rights that belong to the original owner workgroup should be

transferred to the workgroup you have chosen.
Click OK if the change was intentional.

Determine the access right for All Other Workgroups, selecting from the Read, Update, or None

access right options.

To set customized access for a workgroup that does not conform to the other control settings
specified, click Add Exception(s). A pop-up window will open.

Select the workgroup and then select the workgroup’s visibility for this record (Read, Update, or

None). Continue to customize workgroup visibility for as many workgroups as you like.

Note: Workgroup visibility exceptions override the access settings assigned under All Other

Workgroups.
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" X
Workgroup Update None *
Workgroup A =
Workgroup B =
Weorkgroup C [
»7 Workgroup D [
\Warkgroup E =] 0 -
[ ok ][ Cance |

Click OK. The selected workgroups and their corresponding modified access settings will be
transferred to the Workgroup Visibilities grid.

< General & Involvements Marratives Attachments % Links & Losses Investigation < Controls Aw 4 p

Details | Ouicome  Reviews  Assignments

% Controls
4 Workgroup Visibilities
Owrer Workgroup (Full Rights) All Other Workgroups
Ontario - Read hd

% Add Exceptionis) >( Remove

\Workgroup Read Update
» ]
Advanced Users [}

Describe the Incident’s Causes and Consequences

1.

© Resolver Inc. Confidential. Do not distribute.

Select the Outcome sub-tab.

If any polices or procedures were implemented, breached, or affected as a result of the incident,
note this by checking the Policy Affected box and entering the Policy Name.

Once you have established why the incident occurred, select your conclusions from the Primary
Cause lookup list and, if applicable, the Secondary Cause lookup list.

Add new policy information or action taken in the Corrective Action Summary text box.

Data Forms
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< General < Involvements < Narratives < Attachments < Links

Details 'Outcome Reviews Assignments

Palicy Name

Corporate IT Security Policy [l Policy Affected

Primary Cause Secondary Cause

Unintentional Act - Careless Actions hd

Comective Action Summary
Complainant did not have the "desk lock" on the laptop, as required by TSD-121
Motice sent out to all staff to ensure use of desk locks when not attending desk

Document a Record-Related Review

1.  Select the Reviews sub-tab.

2.  Click Add New. A pop-up window will open.

3. Choose the applicable description from the Review Type lookup list.

4. By default, your name will appear in the Reviewed By Person field. If you are not the person who

conducted the review, select the applicable person from the pick list.

5. Enter the date and time that the review was completed in the Review Date field.

6.  Enter observations, results, notes, or other details pertaining to the review in the Comments box.

Review Date

10122010 01:20 PM - EH X

Comments
Final review. Investigation closed.

E1 Add New Record = o=
" OK | &9 Cancel
Review Type ved By Person
Departmental Review +| |, Davis. lan E:}l

7. Click OK. The review entry will be added to the list of existing reviews in the main window.
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& General < Involvements < Marratives < Attachments < Links < Losses < |nvestigation
Details Outcome Reviews Assignments

= Add New = Edt = Remove

Total Reviews: 2

Review Date Review Type Reviewed By Person

101272010 Departmental Review Davis, lan

< Controls

Audit History 4 p

26/11/2010  Departmental Review Davis, lan

Give a Record-Related Assignment to Another User

1. Select the Assignments sub-tab.

2. Click Add New. A pop-up window will open.

3. Choose the applicable option from the Assignment Type lookup list.

4. By default, your name will appear in the Assigned By Person field. If you are not the person who

created the assignment, select the applicable person from the pick list.

5. Select the user who must complete the assignment from the Assigned To Person pick list.

6. Complete the Assigned Date, and enter the date the assignment must be completed under Due

Date.

7. When the assignment is finished, check the Completed? box and enter the appropriate date in the

Completed Date field.

8. Enter notes or instructions in the Message/Task text box.
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5P Add New Record F=RESE=T
o OK | &9 Cancel
Assignment Type Assigned By Person
Information Reguest - _f.& avis, lan EDZ'
Assigned Date Aszsigned To Person
2411201010:008m D B X i} Campbell, Keith gk
Due Date
25/11/2010 11:00 AM P E X bl Completed?
Completed Date
25/11/2010 01:00 PM D E X
Message / Task
Background check on Jeff Brown. -

9.  Click OK. The new assignment will be added to the Assignments grid.

< (General % Involvements < Narratives < Aftachments < Links < Losses < |nvestigation < Controls Audit History 4 p
Details  Outcome Reviews  Assignments
= Add New = Edit = Remove = Notify

Total Assignments: 3 Completed Assignments: 1

Completed? Lszsigned Date Assignment Type Assigned By Person Lszsigned To Person  Message / Task

r 13122010 erification Davis, lan Eaker, Susan Flease, verify the necessary data has b..
r 231172010 Follow-up Activity Eaker, Susan Davis, lan Flease, interview the complainant and o_.
v 24/11/2010 Information Reguest  Davis, lan Campbell, Keith Background check on Jeff Brown.

W) CB:davis - 01/12/2010 12:55:45 PM - LM: davis - 01/12/2010 12:55:45 FM

10. Click Save. An Auto Notification pop-up window will appear.

e To send email notifications of the assignments to the Assigned To Persons and/or of the
completed assignments to the Assigned By Persons, ensure the appropriate checkboxes are
selected and click Send. Notifications are automatically sent in HTML. Deselecting the Send
Formatted box prior to clicking Send will format the notification details in plain text rather than
the default HTML table. Once the notifications are sent, the Dashboards of the persons involved

in the assignment will be populated with relevant Assignment records.
e |If the person does not have a primary email address entered in the system, an error message

appearing beside the person’s name will indicate that an email cannot be sent. In this case, click

Close to exit the window.
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11.

12.

«+ Auto Notification
Record changes have been saved. To send any of the following auto notfications to
“| the emal addresses ksted, ensure the approprate checkbaxes are selected and ciick Send
(thernise, chick Close to exdt this window without sending any irformation
Type Sand Notification To
V| Assigned Investigation Davis. lan (idavis@ppm2000.com)

Assigned Investigation ¥ Campbell, Keith (Email cannct be sent)

Select Ml Desslect Bl - Send Fomatied |V Cose [_u Send...

Every time you add a new assignment to the Assignments list or edit the old one and click Save, the

system will automatically prompt you to send an email notification about the changes made.
However, if you want to send an email notification of any of the record’s old unedited assignments,
you will need to select the specific assignment in the list and click Notify. An email message will

open that contains the assignment and the record details.

Check the message details, adding any other information that you think is necessary, and then click

Send.
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a5 Send Message
Mail

=3 = ¥

Send | Attachments Priority

Assignment Details
Assigned By
Assigned To
Assigned Date

Due Date
Completed?
Completed Date

Message / Task

ED:I To: | ian_davis@advancedsecurity.com;

gF CC

Subject: | Assignment Reminder (Incident Number: ADMI-2010-00

L A
oIV
Cut Copy Paste | Check
A L

[ L

Davis, lan

Campbell, Keith
24/11/2010 10:00:00 AM
25/11/2010 11:00:00 AM
Yes

25/11/2010 1:00:00 PM

Background check on Jeff Brown.

s

Format

CEL L

m

Incident Details for ADMI-2010-000124
Criminal/Theft/Company Property/Over $1000

Track Changes Made to a Record

1.

Select the Audit History tab.

Click Get Audit History to view all modifications made to the record since its creation. The Viewing

pane will display entries for each change made to the record. Among the available data categories

are the following:

. DateTime indicates the time when the change was made in GMT.

. UserlD reveals who made the change.

. Record Action describes what type of change was made.

. Control Changes displays any modifications made under the Controls tab.

) Machine Info specifies which computer was used to make the change.
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< Involvements < Marratives < Atachments < Links < Losses < Investigation < Controls Audit History 4
i @ Get Audit History
) w———— ~ Before: (NULL)
e ——— A DL R - After: 7003821128864
Ll DateTime (GMT) UserlD Record Action Control Changes ~ Machine Info Investigator;.%ssignedDate
- Before: (MULL)
2011/06/07 10:35:05 remnyakova Update 192.168.1.94 i After: 11/23/2010 12:00:00
Investigator TypeLookup|D
2011/06/07 09:00:16 remmnyakova Update 152.168.1.34 i..- Befare: (NULL)
- After: 76d61bd8-3b70-4500
2011/06/07 08:20:12 remnyakova Update 152.168.1.594 = InvestigatorType
e - Before: (NULL)
2011/06/07 08:20:00 remnyakova Update 192.168.1.94 ‘.- Mter: Lead Investigator
ORINT 0219 . - InvestigatorPersonlD
2011/06/07 08:19:58 remnyakova Update 192.168.1.94 e Before: (NULL)
201106107 08:13:37  remnyakova Update 192.168.1.84 - After: 8500dd38 Goff 45d8-
=3 Iljvestigator
2011/06/0702:19:09  remnyakova Update 192.168.1.94 - Before: (NULL)
- Mter: Davis, lan
2011/06/07 08:15:01 remnyzkova Update 152.168.1.594 =) Comments
. -~ Before: (NULL)
2011/06/07 08:18:56 remnyzkova Update 152.168.1.94 i Mter: The investigation was
] 1
Summary - ADMI-2010-000124
Record Count: 3
User: remnyakova
Record Action; Update
Date/Time
Yours: 07/06/2011 2:18:56 PM
Users: 07/06/2011 2:18:56 PM
GMT: 07/06/2011 8:18:56 FM
] 1 k

3. Select an entry to view further details in the Audit tree displayed on the right.

4.  Expand the nodes of the audit tree to see exactly what the data value was Before and After the
change was made.

5. To group entries of the Audit History by one of the column headers, drag the header to the field at
the top of the grid. The black arrows will indicate a legitimate place for dropping the header. The
entries will be grouped under the criteria available in the column, each criterion corresponding to a

single group of entries.

6.  If you want to further subgroup the entries in the available groups, drag the next column header to
the grouping field. In this case, the first column header will remain the main grouping option, while

all the subsequently added headers will create an internal grouping hierarchy within the main

grouping.

7. You may invert the hierarchy at any time by dragging the corresponding column header to the

appropriate node in the grouping tree.
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< Involvements < MNarratives < Attachments < Links < Losses < Investigation < Controls Audit History 4

€3 Get Audit History

& Control Changes : -
hs D Before: (NULL)
5 = | Control Changes After: 7e038211-2886-4a%
stigatorAssignedDate
DateTime (GMT) Record Action ~ Machine Info Before: (NULL)
= UserlD : remnyakova (1 item) After: 11/23/2010 12:00:00
[l Control Changes : (9 items) & Invegté?oa:;r':'mel_LLo}okuplD
2011/06/07 10:35.05 Update 152.168.1.94 After: 76d61bd8-370-4900
[=- Investigator Type
2011/06/07 09:00:16 Update 152.168.1.94 Before: (NULL)
- i Mter: Lead Investigator
2011/06/07 08:20:12 Update 152.168.1.94 vestigatorPerson|D
Before: (NULL
2011/06/07 08:20:00 Update 152.168.1.94 PﬁeDrTEESIEDddE}S—BcﬂﬂﬁdE—
e - Investigator
2011/06/07 08:15:58 Updat 152.168.1.94
e B Befors: (NULL)
2011/06/07 08:19:37 Update 192.168.1.84 Ater: Davis, lan
[=)- Comments
2011/06/07 08:19:09 Update 152.168.1.94 Before: (NULL)
i Mfter: The investigation was
2011/06/07 08:19:01 Update 152.168.1.94 a -
2011/06/07 08:18:56 Update 192.168.1.94 Summary - ADMI-2010-000124

Record Count: 9

User: remnyakova

Record Action: Update
Date./Time

Yours: 07/06/2011 2:18:56 PM
Users: 07/06/2011 2:18:56 PM
GMT: 07/06/2011 8:18:56 PM

Cases

A case is a convenient tool that organizes multiple incidents that have a common reference subject or
object (e.g., a common subject of interest, a similar organization where incidents took place) into a single
entity that is designed for a more effective investigation process. Multiple incidents can make up one
case. Therefore, many operations implied in completing a Case data form require you to choose if you
would like to add data to the currently open Case record, or to an Incident that is linked to the currently

open Case record.
This choice is controlled by the relevant functions on the Viewing pane:
. Click Add to Cases to connect a data entry operation to the currently open case.

o Click Add to Incident and select the appropriate incident from the pick list to connect the data entry
operation to an incident linked to the currently open case.
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Create a new Case record

1. Click the Add button LT on the Viewing pane toolbar.

2. Give the case a descriptive Case Name.

3. Identify the general classification of the case under Case Category.

4. Indicate when the case was opened under Case Start Date.

5. If the case has undergone a review, enter the applicable date in the Last Reviewed Date field.
6.  When the case has been closed, enter this date in the Case Closed Date field.

7. Select the name of the Case Manager, as well as the Case Supervisor, from the applicable pick list
fields.

8.  Type a very brief overview of the case in the Case Description box. To enter a more detailed
description of the case, use the Narratives tab.

9.  Perspective will automatically assign the case a Case Number when the record is saved.
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CASE-2009-000002
Jeff Brown Restraining Order

Save |[F Edit g5 Add X Delete | (5] Lock s Print <] Send Cancel

< General @ Involvements @ Narratives © Attachments < Links < Losses < nvestigations < Caontrols
# Details

Case Number Case Start Date

CASE-2009-000002 04/01/2011 12:00 AM

Case Name Last Reviewed Date

Jeff Brown Restraining Order

Case Category Case Closed Date

Criminzl Events

Case Manager Case Supervisor

Link New Incident Link New Case

Case Description
Test

% Investigators
Total Investigators: 1
Add New Edit Remave

Assigned Date  Investigator  Investigator Type Completed Date  Comments

432009 Glade, George Lead Investigator Imvestigating a p.

Assign an Investigator to a Case’s Investigation

Audit History

m

% Case Summary

Status Open
Case Duration 1yearls) 6 morthis) 30 day(s)
Number of Case Investigators 1
Number of Linked Incidents 10
Initial Incident Occumed 8/11/2010 4:18:03FM
Disposition

# Investigation Summary

Total Time Spert 39 hris) 30 min(s)
Total Expense 5 436.00CDN
Total Evidence 1
Number of Interviews 3
Number of Incident Investigators 4
Total Investigation Duration 1324.09 Day(s)
Number of Incidents Investigated 3
Inciderts Not Investigated 7
2 Involvement Summary

Number of Persons 27
Number of Organizations 4
Number of fems 9
Number of Vehicles 2
2 Loss Summary

Total Exposure $ 0.00CDN
Total Averted S 20.00CDN
Total Loss $ 109583.00 CDN
Total Recoveries 5 154500CDN
Net Loss S 108,044.00CDN

Ready @ Connected

1. In the Investigators section of the General tab, click Add New. A pop-up window will open.

2. Specify the applicable role of the investigator in the Investigator Type field (e.g., Lead Investigator,

Assisting Investigator, Forensic Specialist).

3. Select the name of the investigator from the Investigator pick list.

4. In the Assigned Date field, enter the date and time the person was assigned to the investigation

team.

5. If the investigator is removed from the investigation team at some point, you may enter the

applicable date and time in the Completed Date field.

6.  Enter any relevant notes in the Comments field.
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57 Add New Record r=nEoR==
" OK | & Cancel
nvestigator Type nvestigator
Assisting Investigator - _l_i Campbell, Keith '553 >
Aszsigned Date Completed Date
241120101200 PM 5 EH 24| | 2611172010 1200PM 3 EH X
Comments
Officer Campbell has been dismissed due to the corflict of interests | -
7. Click OK and proceed to enter as many investigators as necessary.
< General < |mvolvements < Marratives < Attachments < Links < Losses < Investigation < Controls Ludit History
¥ Details # Case Summary
# Investigators Status Open
u Add New = Edit = Remaove Case Duration 5 month(z) 13 dayls)
Mumber of Case Investigators 2
Total Investigators: 2
Number of Linked Incidents 3
edBaic) e e e oiogl e feonniied el e ommens Intzl Incidert Occured 13/10/2009 5:32:04 PM
241112010  Campbell. Keith Assisting Investigstor  26/11/2010 Officer Campbell has been disr Disposition Active
231172010 Davis, lan Lead Investigator
# Investigation Summary
Total Time Spent 65 hour(s) 50 minute(s)
Total Expense 5 42600 USD
Total Evidence 2
W) CB: davis - 01/12/2010 5:51:07 PM - LM: davis - 01/12/2010 5:51:07 FM Number of Interviews 3
8.  If you save the Case record changes at the time of entering a new Investigator, an Auto Notification

pop-up window will appear.

e To send an email notification of the assigned investigation to the investigators, ensure the

appropriate checkboxes are selected and click Send. Notifications are automatically sent in

HTML. Deselecting the Send Formatted box prior to clicking Send will format the notification

details in plain text rather than the default HTML table.

o |If the investigator does not have a primary email address entered in the system, an error

message appearing beside the investigator's name will indicate that an email cannot be sent. In

this case, click Close to exit the window.
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+» Auto Motification (=3

Record changes have been saved. To send any of the following auto-notifications to
="| the email addresses listed, ensure the appropriate checlkboxes are selected and click Send.
Ctherwise, click Close to exit this window without sending any information.
Type Send Notification To

[ Assigned Investigation :¥ Campbell, Keith (Email cannot be sent.)

Assigned Investigation éDavis. lan (ian_davis @advancedsecurity com)

Select Al Deselect Al Send Formatted [ Close I l_l Send... ]

View All Case’s Involvements

1. Select the Involvements tab.

2. Depending on the type of involvement data required, select the Persons, Organizations, Vehicles,
or Items sub-tab. A list of all corresponding entities contained in the case’s linked incidents, as well
as their essential details, will appear in form of a grid.

3. Select an entity in the grid to display its details in the form at the bottom of the window.

4.  To view the history of the entity’s involvements, select the entity in the grid, and click History. All

incidents the entity has been involved in will be displayed in a pop-up window.

History =]
&9 Close

IncidentNumber FileMumber ClassName Class Category OccurredDateTime SiteName  IncidentStatus  InvolvementType  InvestigationStartDate
ADMI-2010-0001... ' TH-3073-B  Criminal/Th...: Criminal: Theft 2211112010

ADMI-2011-01-00.. Criminal/Th... Criminal Theft 200017201 Acme Univ.. Dpen Witness
INCDO00D000183  ABC Criminal/Fire Criminal Fire 08/03/2009 Site AVBuil.. Closed Complainant 28/04/2009

5. To transfer to an entity’s main record, select the entity in the grid and then click Go To
Persons/Organizations/Vehicles/Items. To return to the Case record, select Cases in the

Navigation pane.
6. To transfer to an entity’s Involvement subform within its Incident record that is linked to the

currently open Case record, select the entity in the grid and click Go To Incidents. To return to the

Case record, select Cases in the Navigation pane.
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< General % Involvements < MNarratives < Attachments < Links < Losses % |nvestigation < Controls Audit History
Persons  Organizations  Vehicles  ltems

= Histany = (Go to Persons = Goto Incidents
Involved Personis): 3 Employeeis): 3 Interviewed: 3
Incident Number Last Name First Name Involvement Type Birthdate Gender Employee Interviewed
ADMI-2010-000124 Howard Katherine Victim 030611983 Female v v
INC-2009-000265 Anderson Peggy Sue Reported By Female i~ [
EADMI-ZD1D—DDD124 Brown Jeft Witness 26/03/1980 Male v v
Title First Name Initial Last Name Involvement Type
Mr. Jeit L Brown \Witness
Birthdate Gender Marital Status Designation(s)
26/03/1980 Male Divorced
Hair Color Eye Color
Brown Blue

Notes

The only available witness is Jeff Brown who is seated in the cubicle
section (ADMIN-77) three rows over Kathy Howard.

Interviewed?
Employes?

[[] First Aid Administered?
[E] Injured

[[] Person Hospitalized?

Note: If an involvement is added to multiple incidents and then you create a case with one of those

incidents, the Linked Incidents tab will display all incidents with the involvement.

Summarize a Case or an Incident Linked to a Case

Open the Narratives tab and complete the operation, as described in the Summarize an Incident or a

Case section in the Incidents chapter.

Attach a File to a Case Record

Open the Attachments tab and complete the operation, as described in the Attach a File to a Record

section in the Incidents chapter.

Link an Incident to a Case

Note: This function is also accessible via Link New Incident

1. Select the Links tab.

e

2. Inthe Linked Incidents section, click Add New. A pop-up window will open.
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3. Specify how the incident and the case are related in the Link Type field (e.g., Common Suspect,
Similar M.O.).

4.  Select the appropriate incident from the Link Incident To Case pick list.

5. Indicate the date that the incident became associated with the case in the Link Effective Date field.

6. Type any additional information about the link in the Notes field.

7. Click OK.
25 Add New Record = | E S
Cancel
Link Type Link: Incident To Case
SRL: o
Link Effective Date
I s EX

Notes

8.  After saving, the created link will be automatically cross-referenced in the linked Incident record
under the Links tab.

Note: The data contained in the linked Incident record (including Involvements, Narratives,
Attachments, Investigation, and Loss Summary) will be automatically imported into your Case record.
This will be reflected in the Summary section on the right side of the Viewing pane under the General
tab.
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< General < Involvements < Marratives < Attachments < Links ¢ Losses < Investigation < Controls Audit History

# Linked Incidents
= Add Mew = Edit = Remove = Goto

Number of Linked Inciderts: 3

Link Incident To Case Link Type Link Effective Date  Notes

ADMI2010-000124  Commen Organization 01122010 Similar theft pattern.

ADMI-2009-000234  Related Incidents 0212/2010
INC-2005-000265  Commeon Organization 01122010 Advanced Security Ltd., Human Resources

W CB: davis - 01/12/2010 5:19:25 PM - LM: davis - 01/12/2010 5:19:25 PM

¥ Linked Cases

Link a Case to Another Case

Note: This function is also accessible via Link New Case L4k under the General tab.

1. Select the Links tab.

2. Inthe Linked Cases section, click Add New. A pop-up window will open.

3. Specify how the two cases are related in the Link Type field (e.g., Common Suspect, Similar M.O.).
4.  Select the case that you want to link to the open case from the Linked To Case pick list.

5. Indicate the date that the two cases became associated with each other in the Link Effective Date
field.

6. Type any additional information about the link in the Notes field.

7. Click OK.
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&b Add New Record = |
Cancel
Link Type Link Incident To Case
] & %

Link Effective Date

I :j}{

8.  After saving, the created link will be automatically cross-referenced in both Case records under the

Links tab.

< General % Involvements < Marratives < Attachments < Links % Losses % Investigation
¥ Linked Incidents
# Linked Cases

= Add New = Edit = Remove = Goto

Number of Linked Cases: 2

Linked From Case Linked To Case Link Caze Name Link Type Link Effective Date  Notes
CASE-2010-000028 CASE-2010-000027 Internal Thefts Common Suspect 02/12/2010

Audit History

ECASE-ZD‘ID—DDDDZ? ADMC-2010-000016 4534534

Same Class and Location 01122010 Both cases involve theft atthe s..

W) CB: davis - 01/12/2010 5:19:25 PM - LM: davis - 01/12/2010 5:19:25 PM

View a Summary of Losses Involved in a Case

1.  Select the Losses tab.

2. Ifinvolvement losses have been recorded for any of the case’s linked incidents, the Loss and

Recovery Details grid will display each recorded loss entry arranged by Incident ID and supplied with
such information as the Date the loss was recorded, the record or sub-record type the loss has been
Associated To, the Type of loss, and the relevant value of the loss by loss category (i.e., Loss,

Recovery or No Impact). For optimal analysis, you may arrange the loss entries by a column header

(e.g., Associated To, Date, or Type) and change the position of the columns in the grid.

3. Click Save to update the summary calculations displayed to the right of the grid:

e Totals:
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Total Exposure: The total value of the Exposure No Impact loss associated with Incident records
linked to the case.

Total Averted: The total value of the Averted No Impact loss associated with Incident records
linked to the case.

Total Loss: Total value of Loss amounts associated with Incident records linked to case.

Total Recoveries: The total value of the Recovery loss associated with Incident records linked to
the case.

Net Loss: The value determined by subtracting the Total Recoveries amount from the Total Loss.

e Averages:

Average Exposure: The average value of the Exposure No Impact loss across the Incident
records linked to the case (i.e., Total Exposure divided by Total Incidents).

Average Averted: The average value of the Averted No Impact loss across the Incident records
linked to the case (i.e., Total Averted divided by Total Incidents).

Average Loss: The average value of the Loss amount across the Incident records linked to the
case (i.e., Total Loss divided by Total Incidents).

Average Recoveries: The total value of the Recovery loss across the Incident records linked to
the case (i.e., Total Recoveries divided by Total Incidents).

Average Net Loss: The value determined by subtracting the Average Recoveries amount from
the Average Loss.

< General < Involvements < Narratives < Attachments < Links < Losses < Investigation < Controls Audit History

% Loss And Recovery Details Totals
Total Exposure $ 2.125.00 USD
. \ . . .
Total Incidents:4 Incident With Losses:2 Losses:4 Recoveries:2 No Impact:2 Total Averted < 790.00 USD
= Go To Incident Total Loss $9.753.78 USD
IncidentID Date ¥  Associated To Type Loss Recovery Mo Impact jatelbcon=ice SEEiEy
g MNet Loss $9.073.78 USD
i INCDODDDOOO167 0111972072  Incidents Direct $ 249200 USD
- Averages
SHI-2011-000018 01/27/2011 Hem Involvement Car Stereo Direct $ 131178 USD Average Exposure $ 531.25 USD
- - Average Averted $ 197.50 USD
INCDODDDO00TE7 021572012 lem Involvement  \Wallet Direct § 322500 USD Average Loss $2.438.45 USD
INCDO0DD000167  01/25/2012 Organization Inv.. Cape Breton Re.. On-line Purc... $ 80.00 USD Average Recoveries $ 170.00 USD
Ay Net Lo: $ 2.268 45 USD
INCDOODD000167  01/30/2012  Organization Inv.. Sydney Police S.. Exposure § 2.125.00 USD EEss = S
INCDOO0DO00167 0112572012 Person Involve..  Brown. Jeff Indirect § 2.725.00 USD
INCDOO0DO00167 02232012 Person Involve..  Hatfield, Carmen  Averted $ 790.00 USD
INCDODODO00167 02242012 Vehicle Involve.  UDKBES Physical $ 600.00 USD
< r

m © Resolver Inc. Confidential. Do not distribute. Page 113 of 350



Perspective User's Guide Data Forms

View and Record Case Investigation Data

View Key Investigative Data From a Case’s Linked Incidents

Select the Investigation tab, and then select the Details sub-tab.

The General section lists all incident investigations that have been linked to the case, including such
details as Incident Number, name of the person who initiated the investigation (Initiated By), and
Investigation Start Date, Review Date, Close Date, and Duration.

In the Linked Incident Investigators section, you will find a list of all the investigators of incidents linked to
the case. The grid lists such details as Incident ID, Investigator Type, date, and time the investigator was
assigned to the incident (Assigned Date), date the investigator was removed from the incident’s
investigation (Completed Date), and Comments.

Note: Do not confuse the Linked Incident Investigators with the Investigators that are assigned to the
currently open case added under the case’s General tab.

< General < Involvements < MNarratives < Attachments < Links % Losses < Investigation < Controls Audit History

Details Summaries  Logs  Interviews  Evidence/Property

% General

[&! Gato Incidents

Total Mumber of Investigations: 2 Total Duration: 58.57 dayis) Average Duration: 4928 dayl(s)
Incident Mumber Start Date Initiated By Review Date Close Date Investigation Duration
» ADMI-2010-000124 2371172010 Davis, lan 09/12/2010 18122010 22.0 day(s)
MPDI-0000000085 241032011 Smith, Jane 76.57 dayl(s)

# Linked Incident Investigators

Total Mumber of Investigators Assigned: 5 Mumber Investigators Involved: 4

Incident|D Aszzigned Date  Investigator Type Investigator Completed Date  Comments
ADMI-2010-0001 . 241172010 Asszisting Investigat.. Campbell, Keith 26/11/2010 Officer Campbell's involvem..
ADMI-2010-0001 . 231172010 Lead Investigator Davis, lan The investigation was pass_.

ADMI-2010-0001 07/06/2011 Lead Investigator Remnyzkova, Sv.

ADMI-2010-0001 . 231172010 Lead Investigator Davis, lan The investigation was pass_..

Summarize a Case’s Investigation or the Investigation of an Incident Linked to a Case

Select the Investigation tab, the Summaries sub-tab, and complete the operation, as described in the

Summarize an Incident’s or a Case’s Investigation section in the Incidents chapter.
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Log Investigative Tasks and Expenses for a Case or an Incident Linked to a Case

Select the Investigation tab, the Logs sub-tab, and complete the operation, as described in the Log
Investigative Tasks and Expenses section in the Incidents chapter. The summary of all tasks and
expenses data associated with the related records will be calculated above the grid.

Document Investigation Interviews for a Case or an Incident Linked to a Case

Select the Investigation tab, the Interviews sub-tab, and complete the operation, as described in the
Document Investigation Interviews section in the Incidents chapter.

Track Investigation Evidence for a Case or an Incident Linked to a Case

Select the Investigation tab, the Evidence/Property sub-tab, and complete the operation, as described
in the Track Investigation Evidence section in the Incidents chapter.

Control a Case Record’s Processing Options

For control options available for Case records, refer to the Control Record’s Processing Options section.

Note: The option to describe an occurrence’s causes and consequences under the Outcome sub-tab is only
available within the Incidents component, and is absent on a Case form.

View a Quick Summary of a Case’s Key Data

As you open your Case record, click the General tab. Key information, summarizing data from a number

of forms within the Case record, will be collected along the right side of the Viewing pane.
Case Summary

. Status: The status of the case (e.g., Open or Closed), drawn from the Controls tab.
. Case Duration: The length of the case, based on the time elapsed from the Case Start Date to the
Case Closed Date (or current date if the case is not yet closed), drawn from the General tab > Details

section.

) Number of Case Investigators: The total number of investigators assigned to the case, drawn from

the General tab > Investigators section.

. Number of Linked Incidents: The total number of incidents linked to the case, drawn from the Links

tab > Linked Incidents section.
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Initial Incident Occurred: The earliest date and time that any of the incidents linked to the case
occurred (i.e., the earliest Occurred From Date/Time), drawn from the Links tab > Linked Incidents

section.

Disposition: The current standing of the case (e.g., Active, Pending Court, etc.), drawn from the
Controls tab.

% Case Summary

Status Open
Case Duration 6 month(s) 14 day(s)
Mumber of Case Investigators 2
Number of Linked Incidents 2
Initial Incident Occumed 2241142010 4:20:00 PM
Disposition Active

Investigation Summary

The data for the Investigation Summary section is drawn from the Investigation tab.

Total Time Spent: The total number of hours spent on the case’s investigation to date, plus the
investigations of all incidents linked to the case, drawn from the Logs sub-tab.

Total Expense: The total cost of the case’s investigation to date, plus the investigations of all
incidents linked to the case, drawn from the Logs sub-tab.

Total Evidence: The total number of evidence pieces collected in the case’s investigation to date,

plus the investigations of all incidents linked to the case, drawn from the Evidence/Property sub-tab.

Number of Interviews: The total number of interviews conducted in the case’s investigation to date,

plus the investigations of all incidents linked to the case, drawn from the Interviews sub-tab.

Number of Incident Investigators: The total number of investigators assigned to the case’s linked

incidents, drawn from the Details sub-tab > Linked Incident Investigators section.

Total Investigation Duration: The total length of the investigations of all incidents linked to the
case, based on the time elapsed from each of their Investigation Start Dates to their Investigation
Close Dates (or current date if an investigation is not yet closed), and drawn from the Details sub-tab

> General section.

Number of Incidents Investigated: The total number of incidents linked to the case that are
undergoing (or have already undergone) investigation, drawn from the Details sub-tab > General

section.
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o Incidents Not Investigated: The total number of incidents linked to the case that are not
undergoing (or have not undergone) investigation, determined by subtracting the Number of
Incidents Investigated (stated above) from the Number of Linked Incidents (listed in the preceding
Case Summary section).

% Investigation Summary

Total Time Spent 71 houris) 15 minute(s)
Total Expense & 242600CDN
Total Evidence 3
Number of Interviews 3
Mumber of Incident Investigators D
Total Investigation Duration 98.57 days
Mumber of Incidents Investigated 2
Incidents Mot Investigated 0
Involvement Summary

The data for the Involvement Summary section is drawn from the Involvements tab.

. Number of Persons: The total number of involved persons from all the incidents linked to the case,
drawn from the Persons sub-tab.

o Number of Organizations: The total number of involved organizations from all the incidents linked
to the case, drawn from the Organizations sub-tab.

. Number of Items: The total number of involved items from all the incidents linked to the case,

drawn from the Items sub-tab.

. Number of Vehicles: The total number of involved vehicles from all the incidents linked to the case,

drawn from the Vehicles sub-tab.

% Involvement Summary
Mumber of Persons
Mumber of Crganizations

MNumber of tems

(RS I = B LS N %)

MNumber of Vehicles

Loss Summary

The data for the Loss Summary section is drawn from the Losses tab > Totals section.
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# Loss Summary

Total Exposure £ 212500 U5D
Tatal Averted § 790.00 USD
Total Loss £ 975378 USD
Total Recoveries § 680.00 USD
Met Loss § 9.07378UsD

Track Changes Made to a Case Record

Open the Audit History tab and complete the operation, as described in the Track Changes Made to a
Record section in the Incidents chapter.

Activities

Create a New Activity Record

Generally, activities are created and dispatched using the DispatchLog module embedded in Perspective
or Dispatch, the separately managed application. (See the Resolver Support site for more information on
DispatchLog or Dispatch). Once an activity is closed in DispatchLog or Dispatch, it is transferred to the
main Activities database in Perspective, maintaining any information that has been recorded in
DispatchLog or Dispatch. The information that is imported from DispatchLog or Dispatch includes general
activity details, location and responsible persons, officers’ and organizations’ responses, involvements,
attachments, activity notes, and the basic Controls options (i.e., Activity Status, Owner Workgroup, Access
Level, and Workgroup Visibilities). However, if required, an Activity record may be created from scratch
within the centralized database in Perspective.

1. Click the Add button dk in the Viewing pane toolbar.

2. Indicate when the activity was reported to supervisors under Reported Date/Time. By default, the
field will populate with the current date and time.

3. Indicate when the activity call was assigned to an officer or organization under Assigned
Date/Time.

4.  Select the activity category under the Level 1, Level 2, and Level 3 lookups. These fields are
hierarchical, meaning that the option selected in the first field (i.e., Level 1) determines the options
that are available in the second field (i.e,, Level 2), and so on. The options that appear in these lists

have been customized by your organization.
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5. Depending on the category specifications selected for the activity, the system will build the

appropriate activity Code. Alternatively, you may quickly enter the code to auto-populate the activity
category Levels.

6.  Specify the Priority for the activity, selecting from the lookup options. The default value in the
Priority field is determined by the category specifications/code selected for the activity.

7. If the activity has been closed, enter the date of its closure in the Closed Date/Time field. For the
Activity records that have previously been closed within the DispatchLog or Dispatch, this field will
already contain the date of closure.

% Details

Activity Number
ACT-2011-000022

Repored Date/Time Code Level 1 Priority

19/05/2011 12:01 PM . EH X 3008 Aarm *| | Intemediate -
Assigned Date/Time Level 2

19/05/2011 10:00 M  [EH X i -

Closed Date/Time Level 3

19/05/2011 11:30AM @ [ X -

8.  Specify the location of the activity by making selections from the Site, Building, Location, and
Section lookup lists.

9.  The address fields (i.e., Address, Address 2, Postal Code, Country, State/Province, and City) will
automatically populate according to the site specifications entered. Alternatively, you may enter/edit
the address manually. If the activity took place off site, mark the corresponding checkbox and enter

the exact address of the off-site activity location.

10. In the Description text field, type in a detailed description of the activity.
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4 Location
Site Address Country
Acme University - 1 Main Street Canada -
Building Address 2 State'\Province
Administration Building - Alberta -
Location Postal Code City
East Wwing - T5H 1Y6 Edmanton -
Section
Front Entrance - 1 of site
Description
The fire alarm sounded at 9:58 am. Most staff had evacuated the building by 10:20 am. -

Employees working in Level 7/Section 2 discovered that their fire exit was locked, so they had to walk
to the other side of the building to find an exit. This delayed their evacuation by 10 minutes.

11.  In the Supplemental Details section, select the Call Source for the activity (e.g., Alarm, External Caller

- Cell).

12. Click the corresponding Add icons &P and select the names of the following responsible persons:

e Call Taken By—The user who is responsible for recording the call. Usually, the call taker is the

person who creates the original Activity record.

o Initiated By—The user who initiated the call and provided basic information for creation of the

activity. Enter the initiator's Contact Number in the field on the left.

o Dispatched By—The person who dispatches officers/organizations for the activity.

# Suplemental Details

Call Source Call Taken By
Externzl Caller - Cell - -ﬁ Baker, Gordon
Contact Number Initizted By

780 555 4444 ) Zeyen, Jeff

Dispatched By

d}' 7~ & Davis. lan ‘-{:3 7

% %

13. To enter a brief update to the activity's disposition or status, type the notes in the Activity Notes

text box and click Add Notes. Each note will be supplied with a date stamp and the user name of the

reporting person.

Note: Perspective will automatically supply the Activity record with an Activity Number when the

record is saved.
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Record an Officer’s Response to an Activity

1. Select the Responses tab.

2. Select the Officer Responses sub-tab.

3.  Click Add New. A pop-up window will open.

4.  Select the responding officer’s record from the Officer Name pick list.

5. The Call Sign field will auto-populate with the selected officer’s call sign abbreviation.

6.  Track the temporal progress of the officer's response specifying the following time points:

e Assigned Date/Time—The date and time the officer was dispatched for the activity.

e Abandoned—Check the Abandoned box if the officer has been assigned to the activity, but did
not manage to carry out the response tasks due to the reassignment for another activity, or if
they did not arrive at the site of the activity.

e Start Date/Time—The date and time the officer started to respond to the activity.

e Arrived Date/Time—The date and time the officer arrived on the activity's site.

e Cleared Date/Time—The date and time the officer completed the activity and vacated the site.

7. Once the appropriate dates and times have been entered, the system will calculate how long it took

the officer to respond (Response Time) and how long they remained on site (Time On Site).

8.  Enter any additional information about the officer’s response in the Officer Response Notes text
box.
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5P Add New Record = =]
" OK | &3 Cancel

Officer Name Call Sign

Morton, John g K |130C -
Assigned Date/Time

19052011 1000 AM - ] X Abandoned

Start Date/Time

19052011 1000 AM - ] X

Anived Date/Time

190052011 1005 AM ; [E@ X Response Time Dirednm
Clearcd Date/Time
190052011 11.00AM ; E@ X Time On Ste D

Officer Response Notes
Conducted evacuation of staff from the building

9. Click OK. The new officer's response entity will be saved as an entry in the Officer Responses grid.

© General < Responses © Requesis © |nvolvements Attachments @ Links < Controls Audit History
Officer Responses  Organization Responses

= AddNew = Edt = Remove

Total: 2

Officer Name Cazll Sign Assigned Date/Time  Start Date/Time  Arrived DateTime  Cleared Date/Time = Response Time Time On Site
Nerton, John 130C 19/05/2011 10:00 AM 19/05/2011 10 19/05/2011 10:05.. 19052011 11:00.. 0.08 hrs 0.52 hrs
Durov, Alex 1354 190052011 11:30 AM 19/05/2011 12 190052011 1220, 19/052011 1250. 0.17hrs 0.5 hrs

Conducted evacuation of staff from the building.

l) CB: remnyakova - 24/05/2011 12:58:23 PM - LM: remnyakova - 24/05/2011 12:58:23 PM

Record an Organization’s Response to an Activity

1. Select the Responses tab.
2. Select the Organization Responses sub-tab.
3. Click Add New. A pop-up window will open.

4.  Select the responding organization’s record from the Organization pick list. If the corresponding

Organization record does not already exist, use the Quick Add function to create one.

5. The Organization Name field will now automatically populate with the linked organization’'s name.
Depending on the data available, some additional fields may also populate with information drawn
from the linked Organization record.

6. To add the organization’s logo to the record, click the Add icon ¥ in the image box.

7. Locate the image file in the browser window and click Open.
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10.

11.

12.

13.

14.

15.

15.

Specify the category of the organization’s response (e.g., Emergency Service, Responding
Service/Agency, Indirectly Involved) by selecting a description from the Involvement Type lookup
list.

If applicable, input the organization’s file, ID, or other tracking number in the Organization Number
field.

Select the applicable Organization Type from the lookup list.

Specify the mode by which the organization has been notified of the activity in the Notified By
lookup list.

If there is any documentation associated with the organization’s response to the activity (e.g., a work
order), note the associated tracking number in the Reference Number field.

Select the name of the organization’s primary contact from the Contact Person pick list. If a Person
record does not already exist for the individual, use Quick Add to create one.

Enter the contact person’s phone number under Contact Phone.

Select the record of the person in the organization who responded to the activity from the
Responding Person pick list and the record of the person who called the organization from the
Notified By Person pick list. If a Person record does not already exist for the individual, use the
Quick Add function to create one.

Track the temporal progress of the organization’s response by specifying the following time points:

e Called Date/Time—The date and time the organization was contacted about the activity. Check
the No Responses box if the organization did not respond.

e Arrived Date/Time—The date and time the organization arrived on site.

e Cleared Date/Time—The date and time the responding organization vacated the site after

having had completed the response.
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57 Add Mew Record

o OK | €3 Cancel

Organization

[, Metropolitan Firean gjp X

Responding Person
_fi Dalton, Treveor
Called Date/Time
19/05/2011 10:20 AM
Amived Date/Time
19/05/2011 10:30 AM
Cleared Date/Time
19/05/2011 11:30 AM

dr X

Crganization Response MNotes
Amived at 10:30, checked the building and left at 11:30.

Crganization Mame

Metropolitan Fire and Rescue Servic:

Organization Mumber
C-9571-L

Notified Type
Cantrol Center

Contact Person
i Dalton, Trever

Notified By Person
_fi Baker, Gordon

Mo Responses

Responze Time

Time On Site

Involvement Type

[F=3(ECE|=>3

Rezponding ServicelAgency =

Crganization Type
Municipal Agency

Feference Number
FR-378

Contact Phone
gp X 780585 7777
& X
0 hiriz) 10 minis)

71 hris) O minis)

16. Once the appropriate dates and times are entered, the system will calculate how long it took the
organization to respond (Response Time) and how long they remained on site (Time On Site).

17. Enter any additional information about the organization’s response in the Response Notes text box.

18. Click OK. The new organization’s response entity will be saved as an entry in the Organization

Responses grid.

< General < Responses < Reguests < Involvements Attachments < Links < Controls Audit History

Cfficer Responses  Organization Responses
= Add Mew = Edt = Remove

Total: 2

Organization Type Organization Name Inveolvement Type  Called DatelTime  Arnived Date/Time = Cleared Date/Time  Response Time  Time On Site

Municipal Agency  Public Security Ser.. Responding Serv_. 19052011 10:1.. 0.0 hrs 0.0 hrs

Municipal Agency  Metropolitan Fire a.. Responding Serv.. 19/052011  10:2.. 15052011  10:30. 19052011 11:30.. 017 hrs 10hrs
Amived at 10:30, checked the building and left at 11:30.

Q CB: remnyakova - 20/05/2011 11:39:58 AM - LM: remnyakova - 204052011 11:35:58 AM
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Note an Action Request for an Activity

1.

10.

11.

12.

13.

14.

Select the Requests tab.

Select Add New. A pop-up window will open.

Select the requested organization’s record from the Organization pick list. If the corresponding
Organization record does not already exist, use the Quick Add function to create one.

The Organization Name field will now automatically populate with the linked organization’s name.
Depending on the data available, some additional fields may also populate with information drawn
from the linked Organization record.

To add the organization’s logo to the record, click the Add icon % in the image box.

Locate the image file in the browser window and click Open.

Specify the type of services offered by the requested organization selecting a description from the
Involvement Type lookup list.

If applicable, input the organization’s file, ID, or other tracking number in the Organization Number
field.

Select the applicable Organization Type from the lookup list.

Specify the mode by which the action has been requested in the Notified Type lookup list (e.g., via

Perspective DispatchLog, Investigator, or Control Center).

Note the organization’s associated Reference Number.

Select the name of the requested organization’s primary contact from the Contact Person pick list. If

a Person record does not already exist for the individual, use the Quick Add function to create one.

Enter the contact person’s phone number under Contact Phone.

Choose the appropriate description for the requested action (e.g., Maintenance, Escort, Window
Repair) from the Request Type lookup list.
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15. Select the record of the person who has been administered the request from the Request Assigned
To Person pick list. If a Person record does not already exist for the individual, use the Quick Add
function to create one.

16. Enter the date and time the request was made in the Assigned Date/Time field.

17.  When the action is complete, input the Completed Date/Time.

18. If there is a tracking or other ID number assigned to the action request, enter it in the Tracking

Number field.

25 Add New Record
« OK &3 Cancel

Crganization

_l_j, Campus Security {:3 >

Ciraanization Nam
Crganization Name

Window Glass Repair Service

Organization Number
5-796-1

MNotified Type

Dispatch -

Ertrance. Merth Campus Security has been called in to repair the window |

(= lE =

nvolvement Type
Responding Service/fgency v
Organization Type
Corporation -

Reference Number
4238-F

R
& o J ) Contact Person Cortact Phone
& OSullivan, Elaine ‘{:3 ~ 780 555 7809
Reguest Type Request Assigned To Person
‘window Repair - J_i Thieszen, Ryan ‘{:3 et
Assigned Date/Time Tracking Number
20/05/2011 09:08 AM  : EH K 780 555 7805
Completed Date/Time
20/05/201110:00AM & EH X
Request Motes
During the fire alarm evacuation 19/05,2011, an unknown person broke the second left window at the Front -

19. Enter any additional Request Notes.

20. Click OK. The new action request entity will be saved as an entry in the Organization Responses grid.
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< (General < Hesponses < Reguests < |nvolvements Aftachments < Links < Controls Audit History

= Add New = Edit = Remowve

Total: 1
Organization Type Organization MName Involvement Type Request Type Azsigned DateTime Completed Date/Time Request Assigned To Person
Corporation Window Glass Repair.. Responding Servic..  Window Repair  20/05/2011 9:.08 AM 20/05/2011  10:00 AM Thiessen, Ryan :

During the fire alam evacuation 19/05/2011, an unknown person broke the second left window at the Front Entrance.

W) CB:remnyakova - 20/05/2011 11:39:58 AM - LM: remnyakova - 20/05/2011 11:39:58 AM

Identify All Persons Involved in an Activity

The Persons sub-tab in the Involvements tab provides space to record persons that have been involved in
the selected activity. The procedures of identifying persons involved in an activity are identical to the
processes described for Incident records with one exception: in an Activity record, there is no option to
add a loss or recovery associated with the involved person. For details, please refer to the Identify All

Involved Persons section.

Identify All Organizations Involved in an Activity

The Organizations sub-tab in the Involvements tab provides space to record organizations that have been
involved in the selected activity. The procedures of identifying organizations involved in an activity are
identical to the processes described for Incident records with one exception: in an Activity record, there is
no option to add a loss or recovery associated with the involved organization. For details, please refer to

the Identify All Involved Organizations section.

To note an action request sent to the organization, use the options under the Requests tab. For details,

refer to the Note an Action Request for an Activity section.

To log the organization’s response to the activity, use the options under the Responses tab. For details,

refer to the Record an Organization’s Response to an Activity section.

Document All Vehicles Involved in an Activity

The Vehicles sub-tab in the Involvements tab provides space to record vehicles that are involved in the
selected activity. The procedures of identifying these vehicles are identical to the processes described for
Incident records with one exception: in an Activity record, there is no option to add a loss or recovery
associated with the involved vehicle. For details, please refer to the Document All Involved Vehicles

section.
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Identify All Items Involved in an Activity

The Items sub-tab in the Involvements tab provides space to record items that are involved in the selected
activity. The procedures of identifying these items are identical to the processes described for Incident
records with one exception: in an Activity record, there is no option to add a loss or recovery associated
with the involved item. For details, please refer to the Identify All Involved Items section.

Attach a File to an Activity Record

Open the Attachments tab and complete the operation, as described in the Attach a File to a Record
section in Incidents chapter.

Link an Activity to Another Activity

1. Select the Links tab.

2. Select the Activity Links sub-tab.

3. Click Add New. A pop-up window will open.

4.  Specify how the two activities are related in the Link Type field (e.g., Identical, Common Location).
5. Select the activity that you want to link to the open activity from the Linked to Activity pick list.

6. Indicate the date that the two activities became associated with each other in the Link Effective
Date field.

7. Type any additional information about the link in the Notes field.

8.  Click OK.

25 Add New Record = ===

o OK | &3 Cancsl
Link Type Linked To Activity
Identical - & ACT-2011-000007 lﬂ:l
Link Efective Date
20/05/2011 D E X

Naotes
The same activity has been reported twice by different officers.

m © Resolver Inc. Confidential. Do not distribute. Page 128 of 350



Perspective User's Guide Data Forms

9.  After saving, the created link will be automatically cross-referenced in both Activity records under
the Links tab. To review a complete record of an activity linked to the currently open activity, select
the correct link from the list of Linked Activities and click Go To.

< Genersl < Responses < Feguests < Involvements Attachments < Links < Controls Audit History
Activity Links  Incident Links

= Add Mew = Edit = Remove = Goto

Number of Linked Activities: 2

Linked From Activity Linked To Activity Link Type Link Effective Date MNotes
ACT-2011-000015 ACT-2011-000022 |dentical 15/05/2011 Similar circumstances. Requires investigation.
EACT—ZD'I 1-000022 ACT-2011-000007 |dentical 201052011 The same activity has been reported twice by different officers.

W CB:remnyakova - 20/05/2011 4:05:32 PM - LM: remnyakova - 20/05/2011 4:05:32 PM

Link an Activity to an Incident

1.  Select the Links tab.
2. Select the Incident Links sub-tab.

3. To create the link between an existing Incident record and your Activity record, click Add New. A
pop-up window will open.

4.  Specify how the activity and the incident are related in the Link Type field (e.g., Escalated to

Investigation, Follow-up).
5. Select the appropriate incident from the Linked To Incident pick list.

6. Indicate the date that the activity became associated with the incident in the Link Effective Date
field.

7. Type any additional information about the link in the Notes field.
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7 Add Mew Record = o=

o OK | &3 Cancel
Link Type Linked To Incident
Escalated to Investigation g} ADMI-2010-000102 d}l
Link Effective Date
27/05/2011 CE X

Notes
The activity has been escalated to an Incident record for further investigation. -

8.  Click OK. After saving, the created link will be automatically cross-referenced in the linked Incident

record under the Links tab.

& General < Responses < Reguests < |nvolvements Aftachments < Links < Controls Audit History

Activity Links  Incident Links

= Add MNew = Edit = Remove = Goto
Number of Linked Incidents: 2
Linked To Incident Link Type Link Effective Date  Notes

EADMI-ZD‘I (-000102 Escalated to Investigation 271052011 The activity has been escalated to an Incident record for further investigation.

ADMI-2010-000016 Common Location 211052011 Both the activity and the linked incident occurred at the East Wing Front Entrance o...

lﬂ CB: remnyakova - 20/05/2011 4:38:55 PM - LM: remnyakova - 20/05/2011 4:38:55 FM

Control an Activity Record’s Processing Options
Set the Security Controls and Status of the Activity Record

1. Select the Controls tab; the Details sub-tab will open by default.

2. In the Controls section, fill out the Org Level fields to set the record visibility settings for the various
hierarchically organized groups within your organization. Only users with organizational rollups
corresponding to, or higher than, the organizational rollup you select for the record will have access
to it.

3. Inthe Access Level field, set the security level from 1 to 5. Each security level corresponds to a
specific security description, such as Classified. Only users with the same security Access Level as the

one you select (or higher) will be able to view the record.

4.  Set the Activity Status to one of the following descriptors:
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e Open - Report Required—The meaning of open is dependent on your organization’s definition
of this status. Generally, an open record means that it is actively being worked on or, possibly, is
inactive for a finite amount of time. This status would normally be assigned to an open activity
that requires additional information.

e Closed - Report Completed—The meaning of closed is dependent on your organization’s
definition of this status. Generally, a closed status means that the record is no longer being
worked on due to completion or inactivity for an indefinite amount of time. This status would
normally be assigned to a closed activity that is no longer being worked on and that contains a
report.

e Closed - No Report—This status would normally be assigned to a closed activity that is no
longer being worked on and that does not contain a report.

5. Select the most appropriate description of the activity's current standing in the Disposition field
(e.g., Inactive, Under Investigation, Waiting for Approval).

6.  From the Record Owner pick list, select the Person record that corresponds to the individual who is
responsible for the closing the record. If a Person record does not already exist for this individual,

use the Quick Add function to create one.

7. If you want to archive the Activity record making it unavailable for users to access, check the Archive
(Record is not visible) box.

8. If any policy, legislation, or business rule pertinent to your organization's procedures requires
information about the record, or the persons involved in the record, to be kept for a certain length

of time, enter the end date of that period in Expiry Date.

Note: No information will automatically be deleted on this date; it is for tracking purposes only.
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< General % Responses % Requests 2 Invalvements Attachments < Links < Controls Audit History

Details  Standard Operating Procedures  Assignments

% Controls
Org Level 1 Accesslevel
- Level 4 - O Archive (Record is not visible)
Org Level 2 Activity Status Record Owners
- Cpen - Report Required - D Remnyakova, Svetl CD:' Pt
Org Level 3 Disposition
hd Under Investigation -
Org Level 4 Expiry Date
- 20/052011 DHA X

¥ Workgroup Visibilities

Define Which Workgroups Can Access the Activity Record

In the Workgroup Visibilities section of the Details sub-tab, define access options for the record, as
described in the Define Which Workgroups Can Access the Record section in the Incidents chapter.

Review the Standard Operating Procedures for the Activity Record’s Specifications

Note: The function to review the Standard Operating Procedures (SOPs) for an Activity record is only
available if the Activity’s specifications correspond to a SOP that was previously recorded in the
Administration component of Perspective. For further details, see the Perspective Administrator’s Guide. If
the Standard Operating Procedures sub-tab is absent, then there are no specific procedures to follow for this
type of activity.

1. Select the Controls tab.

2. Select the Standard Operating Procedures sub-tab.

3.  Review the Procedure Description of the Standard Operating Procedures (SOP) available for the
activity's Call Category, Site, and/or Status.

4. Check off the SOP procedures that have been completed under SOP Checklist.
5. Click Save.
6.  View the relevant SOP Attachments by double-clicking on them.

7. Click on the individual SOP Links to open the related network locations, files, or Web links.
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8. To view mass notifications and/or individual email notifications that have been sent in relation to the
activity, click on the View Details and the View Email hyperlinks correspondingly. The record of the

selected notification will appear in a separate window.

© General Responses Requests Involvements Attachments Links < Controls Audit History

Details | Standard Operating Procedures | Assignments

Security Activity: Facility Check

Shte

4 University/Administration Build
feme LnversiySaminisirstion Sulding 1 No Mass notification has been sent
Category: o . .\ i
Security ActivityMerification|Checl/Facility Check = Notification sent on (081272011 8:17.32 PM) View Email...
Procedure Description:

The routine facility check is performed at the end of every working day, at 18:00, to confirm the integrity of the system settings of computers on site.

SOP Checklist(s): SOP Attachment(s): SOP Links(s):
v Examine possible modffications made to the sy (% STANDARD OPERATING PROCEDURE-3-22-0¢ ©) MIR3inEnterprise Login Page
v Examine possible modifications to data 2 S0P for Handling Security Incidents at Acme Univ

v Examine the facilty for possible extemal tools 2
Look for possbile extemal tool output
Review log files
Check for systems possibly involved in intrusior

4 n 3 < 1 3 < . 3

Give an Activity-Related Assignment to Another User

In the Assignments sub-tab, give an activity-related assignment to another user, as described in the Give
a Record-Related Assignment to Another User section in the Incidents chapter.

Track Changes Made to an Activity Record

Open the Audit History tab and complete the operation, as described in the Track Changes Made to a
Record section in the Incidents chapter.

Escalate an Activity Record to an Incident

If an Activity record has exceeded the scope of the provided Activity data form functions and requires a
more detailed analysis and investigation, you may escalate it to a full-fledged Incident record on the basis

of the information stored in the original Activity record.

To perform this operation, click on the Create Incident ..:l button on the Viewing pane and complete the
remaining Incident form data, as described in the Incidents chapter. All the data contained in the original
Activity record that matches a regular Incident form will be copied to the new Incident record, while the

Activity Notes will be saved as unsealed Original Activity Notes under the Narratives tab.
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Click Save to assign the new Incident record an Incident Number and save it in the system. The new
Incident record creation information will be documented under the Audit History tab as a new record
action.

Note: The original Activity record will remain intact.

Items

Create a New Item Record

Perspective provides two ways to create a new Item record: with the help of the standard Add function,
and by importing an Item record from the Gateway. To create an Item record using the standard Add
function, follow the steps described below.
1. Click the Add button &P on the Viewing pane toolbar.
2. Give the item a descriptive Item Name.
3 If known, type in the item’s Serial Number.
4.  Enter the item'’s exact or estimated value in the Original Value field.
5. Identify the general classification of the item by making selections from the Item Category and
Item Type lookup lists. These fields are hierarchical.
Specify the Item Make and Item Model. These fields are hierarchical.
If the item’s owner is known, check the Owner Identified box.
Then, select the name of the organization or person that owns the item from either the Owner
Name Organization or Owner Name Person pick lists. If an Organization or Person record does
not already exist, use the Quick Add function to create one.
9.  Add comments about the item in the Notes field.
10. To add an image of the item to the record, click the Add icon '¥ in the image box.

11.  Locate the image file in the browser window and click Open.
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.7 Llaptop
% Corporate Property /Laptop

o Save Edit efpAdd + 7 Delete

7 Lock i Print Merge [tems

&3 Cancel

ltem Category

Corporate Praperty -
ltem Type

Laptop -

[ Owrer Identified
Owner Name Organization

J_i Advanced Security | é} =

Notes
Located at the cubicle ADMIN-66.

< History < Aftschments < Controls Audit History

ltem Mame
Laptop

Serial Number
XTP-4005

Criginal Value
$ 2900.00 CDN

ltem Make
Dell hd

tem Modsl
Inspiron E1705 Ad

Owner Name Person

8 Howard, Katherine % X

To import a record from the Gateway, consult the Import Record’s Settings From the Gateway section.

Import Record’s Settings from the Gateway

The function to add a record by importing it from the Gateway is an additional method of creating a

record that complements the standard method of the Add button 5P, Both can be accessed from the

Viewing pane toolbar.

1. Open the appropriate data form.

2. Click the small arrow to the right of the Add icon, and select From Source. The Import pop-up

window will appear.

 Save || 7 Edit [P Add -

Delete | [5) Lock =h Print Merge Itemns

1
From Source o
< General & & Controls Audit History

3. Select the Gateway sub-tab, if it is not displayed by default.

4. To display the top 1000 imported records that have been added to Perspective or are available to be

added, click Search.

Note: Only items with the Available status in Gateway will be searched and displayed.

5. To search for a particular imported record, set specific search criteria:
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a.

In the Field Name lookup list, select the field that you want to set as the main criterion for

narrowing your results.

Choose an Operator for the field (e.g., =, <>, Starts With, Ends With, Like).

Enter the compared criterion Value. If the Selector button L] is available, click it to display a

tree of Value options in a separate window.

Note: You may choose any node of the tree as the defining criterion, making your comparison

value as narrow hierarchically as you want.

Rellup ITEMMAKEMODELROLLUPS =]
=I- tem Make Model Rollup

i Inspiron 710M
- Inspiron E1505
- Ingpiron E1705
- XPS M140

- Matorola
- Nokia

- Palm

- Somy

5
¥
¥
¥
.

[ select |[ cancel |

If you want to include a second field as an additional search criterion, select the And or Or radio
buttons and complete the Field Name, Operator, and Value fields below. You may add as many

search criteria as you want. To remove a field from your search criteria, click the Delete button

Ed)

By default, your search will display the top 1000 imported records matching the criteria that you
set. To display more or less than the top 1000 records, adjust the number in the Select Top field
(from 1 to 2000).

Click Search to generate a list of records matching your search criteria. A count of the number
of records in the list, as well as the total number of imported records matching your search

criteria, will be displayed at the bottom of the window.

To make changes to the ongoing search, click Stop Search first, and then make the necessary

changes to the search criteria.

If you change your search criteria at some point, click Refresh % to update the record list

according to the changes made.
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6. Choose the correct record from the list and click Import 5. The pop-up window will close and the
form fields of the new record will automatically populate with the selected record's information. To

cancel the selection at any time, click Close (%}

Impart | =]
M Import... 3] Refresh &3 Close
Gatewrmy

Fsid Names ) Operstor Ve
ltem Name - = =| Laplep 8 And O
Fonid Bama Oparator ) Value p—
| emm Makn.ioddel - = AR Bod Or |25
L] i »
Selad Top ; ]
1000 | Stest Search | | Step Search
Skale Subenit 1D Facord 1D Rem Mams Bem Make. Modal Hotes
Added Source System 1D | TETSS343 Laptop Computer D Trspiron E1705 ke Mobes:
Added Source System |0 TETEROM2 Lagdep Ded/inspiron 710M
Pl Sourcs Systam 1D [ 101000100 Laptop Dl rspiron E1505
Anradatie Source System 1D | 52517122448 Lapiop Compiuter Dl Trespirnn E1705
Arrailatie Source System 1D | 5251122443 Liaptop Computer Diedl/inspiron E1705
Aoralable Source System 1D | 5251122442 Lagtop Dol Inpiron E1505 ke Notes
(6 of & Records)

View Record’s Incident Involvements

1. Select the History tab. The Activity History sub-tab opens with a list of entities (i.e., Persons,

Organizations, Vehicles, and Items) that have been involved in the record you are viewing.

a. The Incident History sub-tab displays a list of any modifications that have been made to the

record since its creation.

2. Tolink all of an incident in the grid to a case, select any incident in the grid and click Add to Case. A

pop-up window will open.

3. Specify how the incidents are related to the case in the Link Type field (e.g., Similar M.O., Same

Class, Location).

4.  Select the appropriate case from the Linked to Case pick list.

5. Indicate the date that the incidents became associated with the case in the Link Effective Date field.

6. Type any additional information about the link in the Notes field.

7. Click OK.
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Add Mew Record =]
" OK | &3 Cancel

Link Type Linked To Case

Common Organization hd g CASE-2010-000027 ED:I
Link Effective Date

011212010 CE X

Motes

Advanced Security Ltd., Human Resources -

8. Click Save.

Note: These links will automatically be cross-referenced in the linked case’s record, as well as in each of
the linked incidents’ records, under the Links tab.

< General < History < Attachments < Controls Audit History

|'gh Addto Case = Goto

Total: 8
Incident Number Class Category Occurred From Date/Time Site IncidentStatus LossStatus Investigation Start Date
ADMI-2010-000124  Criminal Theft 221172010 4:20 PM Site A/Building 1/Location 1/Se. Open Stolen 2311172010

ADMI-2010-000125  Criminal Break a.. 24112010 10:12 AM Eritish Columbia/Salmon Arm Open

ADMI-2011-01-00006 Criminal Theft 20101/2011 12:00 PM Aeme University/Sdministration.. Open
INC-2008-000262  Mon-C .. 1310/2009 4:36 PM Open Damaged

Attach a File to an Item Record

Open the Attachments tab and complete the operation, as described in the Attach a File to a Record
section in the Incidents chapter.

Control Record’s Processing Options
Set the Security Controls and Status of the Record

1. Select the Controls tab; the Details sub-tab will open by default.

2. Inthe Controls section, fill out the Org Level fields to set the record visibility settings for the various
hierarchically organized groups within your organization. Only users with organizational rollups

corresponding to or higher than the organizational rollup you select for the record will have access
to it.
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3. Inthe Access Level field, set the security level from 1 to 5. Each security level corresponds to a
specific security description, such as Classified. Only users with the same security Access Level as the
one you select (or higher) will be able to view the record.

4.  If you want to archive the record making it unavailable for users to access, check the Archive
(Record is not visible) box.

< General < History < Aftachments < Controls Audit History

Details

% Controls

Crg Level 1 Access LevellD
Level 3 =| [ Archive (Record is not visible)

1

MNarth America

Crg Level 2
Canada A

Crg Level 3
Alberta -

Org Level 4
Edmonton hd

% ‘workgroup Visibilities

Define which workgroups can access the record

1. In the Workgroup Visibilities section, give one workgroup the ability to read and modify the record
by selecting them under Owner Workgroup (Full Rights). Initially, the field will contain the name of
your default workgroup. Once you attempt to change it, the system will display a confirmation
dialog asking you if the Full Access rights that belong to the original owner workgroup should be

transferred to the workgroup you have chosen. Click OK if the change was intentional.

2. Determine the access right for All Other Workgroups, selecting from the Read, Update, or None
access right options.

3. To set customized access for a workgroup that does not conform to the other control settings
specified, click Add Exception(s). A pop-up window will open.

a. Select the workgroup and then select the workgroup's visibility for this record (Read, Update, or

None). Continue to customize workgroup visibility for as many workgroups as you like.

Note: Workgroup visibility exceptions override the access settings assigned under All Other
Workgroups.
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wiorkgroup Update Mene -
\Workgroup A [}
\Warkgroup B [}
\workgroup C 0
»# Workgreup D [l
\waorkgroup E 0 Il -
[

(=]
-~

Cancel ]

b. Click OK. The selected workgroups and their corresponding modified access settings will be
transferred to the grid in the Viewing pane of the main window.

< General < History < Attachments < Controls Audit History
Details
¥ Controls
% ‘workgroup Visibilities
COwner Workcgroup {Full Rights) All Other Workgroups
Advanced Users - Read A
% Add Exceptionls) % Remove

workgroup Update Mone
» ‘workgroup A
‘Workgroup B
‘Workgroup C

EOEE
OoEOO

‘Workgroup D

Track Changes Made to an Item Record

Open the Audit History tab and complete the operation, as described in the Track Changes Made to a
Record section in the Incidents chapter.

Persons

Create a New Person Record

Note General Details of the Person

Perspective provides three ways to create a new Person record: using the standard Add function, by
importing a Person record through your Microsoft Active Directory®, or from the Gateway.
To create a Person record using the standard Add function, follow the steps described below:

1. Click the Add button& on the Viewing pane toolbar.

2.  Enter the person's Title (e.g., Mr. or Mrs.) and Designation (e.g., B.Sc. or Chartered Accountant).
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3. Type their First Name, Last Name, and middle Initial.

4.  Specify their Date of Birth, Gender, and Marital Status.

5. Identify the person’s physical characteristics, including Eye Color, Hair Color, Height, and Weight.
6. Add any other relevant personal information or notes in the Additional Information box.

7. To add a photo of the person to the record, click the Add icon &+ in the image box.

8.  Locate the image file in the browser window and click Open.

' Howard, Katherine M @
() DOB: 04/06/1983

ol Save e hdd = [ 5 Lock imbPrint 5 Nerge Pe 3 Cancel

< General @ Contact(s) < Links @ History Agachments @ Cortrols A Hestory

Ttk First Noarme Initial 4 Name

Misy = Hatherna M Heward

Date of Beth Gender bartal Status Designation
DU0EMSE3 D R K Female » | Single + PhD

Eye Color Hair Color Height Weight

Grey ~ | Bruretie =] 505" 135 1bs

Addtional Information
Cubsicin ADMIN-66.

To add a person imported through your Microsoft Active Directory:
1. Click the down arrow to the right of the Add icon >,
2. Click From Source.

Save JEdit EBEIAdd «| < Delete | (3 Lock s Print (; Merge Persons Cancel

| From Source ii ] o
— I < History  Attachments < Controls Audit History

< Genersal &

3. Inthe pop-up window, select the Active Directory tab.
4.  Find and select the correct person from the source list.

5. Click Import. The pop-up window will close and some of the Person form’s fields will automatically
populate with the selected person’s information.
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|2 Refresh €9 Close

Active Directory

Objects to Querny
Object

Users

Search Results
{8 PPM2000

(0 of 0 Records)

To import person’s settings from the Gateway, perform the steps described in the Import Record’s
Settings From the Gateway section in the Items chapter.

Identify the Person’s Unique Features

1. In the Unique Features section, click Add New. A pop-up window will open.

2. Select the appropriate descriptor of the person’s unique feature from the Feature Type lookup list
(e.g., Distinguishing Marks, Ethnic/Racial, Scars/Disfigurements, Tattoos).

3. Specify the Location of the unique feature on the person’s body, and provide its Description.

&5 Add New Record =R|en <]

o OK | €9 Cancel

Feature Type Location
Distinguishing Marks * | Left side of forehead

Description
Birth mark s

4. Click OK.
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< General < Contact(s) % Links < History Attachments

% Unigue Features

= Add New = Edit = Remove

Total: 2

Feature Type Location Description
Distinguishing Marks Left side of forehead  Birth mark
Tattoos Left shoulder Snake

9

¥ |dentifications
¥ Trespass Details

¥ Flags Details

Record the Person’s Pieces of ID

1. In the Identifications section, click Add New. A pop-up window will open.

Audit History

2. Specify the Identification Type (e.g., Driver's License or Birth Certificate) and the Identification

Number.

3. Identify the organization/governing body that issued the identification in the Issued By field.

4.  Add any other notes in the Comments text box.

57 Add New Record [ |[ -5 ]
o OK | &3 Cancel

Identification Type Identffication Mumber
Driver's License | |1234566-789

lssued By
Alberta Motor Association

Comments
(Class 5 operator's license -

5. Click OK.
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< (General < Contact(s) < Links < History Attachments < Controls Audit History

¥ Unigue Features

# |dentifications

= Add Mew = Edt = Remove

Total: 2

|dentification Type |dentification Number |ssued By Comments
Driver's License 1234566-789 Alberta Mator Association Class 5 operator’s license
Birth Certificate 59-01-012345 Regina, Saskatchewan, Department of Public Health  Birth date: March 27, 1580
L

¥ Trespass Details

¥ Flags Details

Document the Person’s Trespass Details

1. Inthe Trespass Details section, click Add New &A pop-up window will open.
2. Specify the Site, Building, Location, and Section where the trespass occurred.
3. If a trespassing notice was created, check the Notice Printed box.

4. If there is an expiry date for the trespassing notice, or for the offence, enter this in the Expiry Date
field.

5. Include any additional information about the trespass under Comments.

P Add New Recard ===

0K &JCancel

Site Expiry Date

Site A - 271272011 T H XK
Building

Building 2 - [wl Motice Printed

Location

Location 1 -

Section

Section C -

Comments
A copy of the Trespass Report for this property is enclosed in the -
Attachments

6. Click OK.
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< General < Contact(s) < Links % History Attachments <% Controls Audit History

Unigue Features

<«

¥ |dentifications

»

Trespass Details

= Add New = Fdit = Remove

Total: 2
Site Rollup Expiry Date MNotice Printed  Comments
Site A/Building 2/Location 1/Section C 2220 v A copy of the Trespass Report for this property is enclosed in the Attachments.
Alberta/Edmanton r
Q

% Flags Details

Flag the Person

1. In the Flag Details section, select each flag's Status (i.e., Yes, No, or Unknown), depending on
whether or not the flag applies to the person. Also, select the Severity of the flag. Examples of flags
include Violent, Trespasser, and Wanted.

2. Type any other comments under Flag Notes.

< General < Contact(s) < Links < History Attachments < Controls Audit History

¥ Unigue Features
¥ |dentifications
¥ Trespass Details

# Flags Details

Description Status Severity
¥ W Warted Yes v || Critical | =
™V Volent Mo - -||=
%\;— T Trespasser Yes ~ || High -
%’ I Infectious Unknown = L | 5
Flag Notes
Multiple trespass notices issued. -

Record Contact Information

1.  Select the Contact(s) tab.
2. Inthe Address section, click Add New. A pop-up window will open.

a. Specify the Address Type (e.g., Business, Head Office).
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b. Enter the person’s full address in the fields provided.

c. If the address entered is the person’s main address, check the Primary Address box.

d. Click OK.

Add Mew Record
" OK | &9 Cancel

Address Type
Home

Address 1
£71 Nicholas Street

[l Primary Address?

Courtry
Canada

State'\Province

Address 2
Alberta
City
ZIP / Postal Code Edmonton
AlB 2C3
3. Inthe Phone Numbers section, click Add New. A pop-up window will open.

a. Select the Phone Type (e.g., Main, Work).

b. Enter the person’s Phone Number. To avoid duplicate entries and to facilitate accurate

searches, it is best to use a consistent format when entering phone numbers (e.g., hyphens in

place of spaces, no parentheses).

c. If the phone number entered is the person’s main number, check the Primary Phone box.

d. Click OK.

Add New Record
" OK | &9 Cancel

Phone Type
Cell

Phone Number
| 17804344402

¥ Primary Phone?

4.  In the Email Address section, click Add New. A pop-up window will open.

a. Specify the Email Type (e.g., Home, Work, etc.).

b. Enter the person’s Email Address.
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c. If the email address is the person’s main email address, check the Primary Email box.

d. Click OK.
Add MNew Record =]
« OK | &3 Cancel
Email Type Email Address
work * | kathy howard @mywork.ca
¥ Primary Email?

5. Add as many contact entries as you want.

< General < Links < History Attachments < Controls Audit History

% Address
= Add New = Edit = Remove

Total: 1

Primary Address?  Address Type Address 1 Address 2 Geographic Rollup ZIP/ Postal Code
v Home 671 Nicholas Street Canada/Alberta/Edmonton AB2C3

# Phene Numbers
= Add New = Edit = Remove
Total: 2

Primary Phone?  Phone Type  Phone Mumber
"3 Home 17805550987

r Cell 17804344402

% Email Address

= Add New = Edit = Remove

Total: 1
Primary Email? Email Type Email Address
I Wiork kathy howard@mywork.ca

Link a Record to a Person

1. Select the Links tab.
2. Inthe Person Links section, click Add New. A pop-up window will open.

3. Indicate how the record is related to the person in the Link Type field (e.g., Partner, Employer,
Driver).

4.  Select the person you want to link to the record from the (Linked To) Person pick list. If a Person

record does not already exist for the individual, use the Quick Add function to create one.
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5. Enter the date that the person became associated with the record in the Link Effective From Date
field. If this association no longer exists, indicate the date that it terminated in the Link Effective To
Date field.

6. Type any additional information about the link in the Notes text box.

7. Click OK.

Add New Record x|
o OK | &3 Cancel

Link Type Linked To Person
Partner v Ed} Brown, JeffL d}i >

Link Effective From Date Link Effective To Date

12/07/2007 cEX !l B

MNotes
Mr Brown works at the same department as does Ms Howard. -

8.  Once you click Save to save the changes made to the record, this link will automatically be cross-
referenced in both the current record and linked Person record under the Links tab.

< (General < Contact(s) < Links < History  Attachments < Controls Audit History
% Person Links

= Add Mew = Edit = Remove = Goto

Total: 2

Linked From Person  Linked To Person  Link Type Link Effective From Date  Link Effective To Date  Motes

Howard, Katherine M Brown, Jeff L Partner 12/07/2007 Mr Brown works at the same department as does Ms_
Howard, Katherine M Freemark, Craig G Associate 051072010 251172010
L

¥ Organization Links

¥ \ehicle Links

Link a Record to an Organization

1.  Select the Links tab.

2. In the Organization Links section, click Add New. A pop-up window will open.
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3. Specify how the record and the organization are related in the Link Type field (e.g., Employer, Parent
Company, Owns/Owned By).

4.  Select the organization you want to link to the record from the Organization pick list. If an
Organization record does not already exist, use the Quick Add function to create one.

5. Enter the date that the record and the organization became associated with each other in the Link
Effective From Date field. If this association no longer exists, indicate the date that it terminated in
the Link Effective To Date field.

6. Type any additional information about the link in the Notes text box.

7. Click OK.

Add New Record =]
o OK | &3 Cancel

Link Type Crrganization

Employer - g} Advanced Security Inc. {:3 =
Link Effective From Date Link Effective To Date

12/07/2007 CE X CEX
Notes

Ms Howard has been employed as an Administrative Assistant at the Advanced Security -
Inz. since Juby 2007.

8.  Once you click Save to save the changes made to the record, this link will automatically be cross-

referenced in both the current record and the linked Organization record under the Links tab.

< (General < Contact(s) < Links < History Attachments < Controls Audit History
¥ Person Links
# Organization Links

= Add New = Edit = Remove = Goto

Tatal: 2
Organization Link Type Link Effective From Date  Link Effective To Date  Motes
Advanced Security Inc. Employer 12/07/2007 Ms Howard has been employed as an Administrative Assistant at the Adwv..
PPM 2000 Inc. Affiliste 24/08/2005
Q

¥ Vehicle Links
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Link a Record to a Vehicle

1.  Select the Links tab.

2. In the Vehicle Links section, click Add New. A pop-up window will open.

3. Specify how the record and the vehicle are related in the Link Type field (e.g., Registered Owner,
Owns/Owned By, Same Fleet).

4.  Select the vehicle you want to link to the record from the Vehicle pick list. If a Vehicle record does
not already exist, use the Quick Add function to create one.

5.  Enter the date that the record and the vehicle became associated with each other in the Link
Effective From Date field. If this association no longer exists, indicate the date that it terminated in
the Link Effective To Date field.

6.  Type any additional information about the link in the Notes text box.

7. Click OK.

Add New Record =]
« OK | &3 Cancel

Link Type Wehicle

Drriver v |E URV-245 g X
Link Effective From Date Link Effective To Date

08/05/2009 CEOX CE X

Nates
VIN: 4LUKPI122222M333333

8.  Once you click Save to save the changes made to the record, this link will automatically be cross-

referenced in both the current record and linked Vehicle record under the Links tab.
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< (General < Contact(s) < Links < History Attachments < Controls Audit History
¥ Person Links
% Organization Links

# Vehicle Links

= Add Mew = Edit = Remove = Goto

Total: 2
ehicle Link Type Link Effective From Date Link Effective To Date  Motes
PPP-616 - Honda/Odyssey Passenger 06/02/2008 10/02/200%
URV-345 - BMWwiM3 Driver 09/06/2009 WIN: 4LUKPI22222M333333

View Person’s Incident Involvements

Access the History tab and complete the operation, as described in the Items section, the View Record’s
Incident Involvements chapter.

The Persons Data Form has an additional sub-tab; Detailed Person History. This sub-tab shows a detailed
history view of every time the person in the record you are looking at was linked or referenced in
Perspective.

Attach a File to a Person Record

Open the Attachments tab and complete the operation, as described in the Incidents section, the Attach
a File to a Record chapter.

Control a Person Record’s Processing Options

Set the Security Controls and Status of the Person Record

1. Select the Controls tab; the Details sub-tab will open by default.

2. In the Controls section, fill out the Org Level fields to set the record visibility settings for the various
hierarchically organized groups within your organization. Only users with organizational rollups
corresponding to or higher than the organizational rollup you select for the record will have access
to it.

3. Inthe Access Level field, set the security level from 1 to 5. Each security level corresponds to a
specific security description, such as Classified. Only users with the same security Access Level as the

one you select (or higher) will be able to view the record.

4.  If you want to archive the record making it unavailable for users to access, check the Archive
(Record is not visible) box.
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5. Check the Employee box, if the person is employed by your organization, and then enter the
person’s Employee Number.

< General < Contact(s) < Links < History  Attachments < Controls Audit History
Details
# Controls
Org Level 1 Access Level
MNorth America - Level 1 (Lowest) [ Archive (Record is not visible)
Org Level 2 Employee Number
Canada - ADMIN-5687 i Employee
Org Level 3
Alberta -
Org Level 4
Edmanton i

¥ Workgroup Visibilities
Define Which Workgroups Can Access the Person Record

In the Workgroup Visibilities section, define access options for the record, as described in the Incidents
section, the Define which workgroups can access the record chapter.

Track Changes Made to a Person Record

Open the Audit History tab and complete the operation, as described in the Incidents section, the Track

changes made to a record chapter.

Organizations

Create a New Organization Record

Perspective provides two ways to create a new Organization record: with the help of the standard Add

function, and by importing an Organization record from the Gateway.
To create an Organization record using the standard Add function:

1. Click the Add button o on the Viewing pane toolbar.

2. Enter the Organization Name.

3. If known, input the organization’s file, ID, or other tracking number in the Organization Number
field.
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4.  Choose the appropriate description from the Organization Type lookup list.

5. If the organization has a Web site, specify the Web address under Organization Webpage URL.
Clicking the adjacent Microsoft Internet Explorer® icon @ will open the Web page in a separate

browser window.
6.  Enter any additional information about the organization in the Notes box.

7. To add an image to the Organization record, click the Add icon %+ in the image box. Locate the
image file in the browser window and click Open.

. Metropolitan Police Service @
C-9870-D

‘A Save T Edit E"}Add - Delete | (5) Lock e Print Merge Organizations | &3 Cancel

< (General < Contact(s) < Links < History < Attachments < Controls Audit History

Cirnzrizaticon Nam
Organization Name

Metropaltan Police Service

Crganization Number

Metropolitan | [cas7D
"\rﬂ uﬂp()lllce _a/' Organization Type

o e i

Municipal Agency -

Crganization Webpage URL B
wiww.metropolitanps .com @ X

Motes
Est. 1955. -

To import organization’s settings from the Gateway, perform the steps described in the Items section, the

Import Record’s Settings from the Gateway chapter.

Record an Organization's Contact Information

Open the Contact(s) tab and complete the operation, as described in the Persons section, the Record
Contact Information chapter.

Link an Organization to a Person

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to

a Person chapter.
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Link an Organization to Another Organization

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to
an Organization chapter.

Link an Organization to a Vehicle

Select the Link tab and complete the operation, as described in the Persons section, the Link a record to
a vehicle chapter.

View Organization’s Incident Involvements

Access the History tab and complete the operation, as described in the Items section, the View Record’s

Incident Involvements chapter.

Attach a File to an Organization Record

Open the Attachments tab and complete the operation, as described in the Incidents section, the Attach
a File to a Record chapter.

Control an Organization Record’s Processing Options

For control options available for Organization records, refer to the Items section, the Control Record’s

Processing Options chapter.

Track Changes Made to an Organization Record

Open the Audit History tab and complete the operation, as described in the Incidents section, the Track
Changes Made to a Record chapter.

Vehicles

Create a New Vehicle Record

Perspective provides two ways to create a new Vehicle record: with the help of the standard Add function,

and by importing a Vehicle record from the Gateway.

To create a Vehicle record using the standard Add function, do the following steps:
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1. Click the Add button 5F on the Viewing pane toolbar.
2. Enter the License Plate number. To avoid duplicate entries and to facilitate accurate searches, it is
best to use a consistent format for entering license plate numbers (e.g., no spaces or special

characters).

3. If known, indicate where the vehicle's license plate was registered in the Country and
State/Province fields.

4. If known, enter the vehicle's VIN, Vehicle Value, and Year.

5. Specify the vehicle's Make, Model, Style, and Color.

6.  If the vehicle is a company vehicle, specify the Division and Branch it belongs to.
7. Add any additional information in the Comments text box.

8. To add a photo of the vehicle to the record, click the Add icon %+ in the image box. Locate the
image file in the browser window and click Open.

&= URV-345 @
= BMw/M3

=l Save || Edit efpAdd ~ < Delete | (5 Lock e Print & Merge Vehicles | €) Cancel

< General < Links < History Attachments < Controls Aydit History

License Plate Registered In

| f f 4 License Plate Courntry
URV-345 Canada -
VIN State’\Province
AL UKPIZZZF2M 333333 Alberta -
Vehicle Valus Year
g 103.250.00 LUSD 2007 ©
Make Style Division
BMin/ | | 2 Door * | Security -
Madel Calar Branch
M3 w| | Green | Operations
Comments
Bought in 2010, -

To add a vehicle imported through the Gateway, perform the steps described in the Items section, the

Import Record’s Settings From the Gateway chapter.
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Link a Vehicle to a Person

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to
a Person chapter.

Link a Vehicle to an Organization

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to
an Organization chapter.

Link a Vehicle to Another Vehicle

Select the Link tab and complete the operation, as described in the Persons section, the Link a Record to
a Vehicle chapter.

View Vehicle’s Incident Involvements

Access the History tab and complete the operation, as described in the Items section, the View Record’s

Incident Involvements chapter.

Attach a File to a Vehicle Record

Open the Attachments tab and complete the operation, as described in the Incidents section, the Attach

a File to a Record chapter.

Control a Vehicle Record’s Processing Options

Set the Security Controls and Status of the Vehicle Record

1. Select the Controls tab; the Details sub-tab will open by default.

2. Inthe Controls section, fill out the Org Level fields to set the record visibility settings for the various
hierarchically organized groups within your organization. Only users with organizational rollups
corresponding to or higher than the organizational rollup you select for the record will have access
toit.

3. Inthe Access Level field, set the security level from 1 to 5. Each security level corresponds to a

specific security description, such as Classified. Only users with the same security Access Level as the

one you select (or higher) will be able to view the record.
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4.  If you want to archive the record making it unavailable for users to access, check the Archive
(Record is not visible) box.

5. Check the Company Vehicle box if the vehicle belongs to your organization.

< General Links History Aftachments < Controls Audit History

Details

# Controls

Org Level 1 Access Leve
Europe - Level 4 = [ Archive (Recond is not visible)

Org Level 2 [l Company Vehicle
LK -

Org Level 3
England -

Org Level 4
% ‘wlorkgroup Visibilities

Define Which Workgroups Can Access the Vehicle Record

In the Workgroup Visibilities section, define access options for the record, as described in the Incidents
section, the Define Which Workgroups Can Access the Record chapter.

Track Changes Made to a Vehicle Record

Open the Audit History tab and complete the operation, as described in the Incidents section, the Track
Changes Made to a Record chapter.

Merge Records

The Merge function is only available on four Perspective's data forms, i.e., Items, Persons, Organizations,
and Vehicles. It is a method of merging partially duplicate records that correspond to a single physical
referent (e.g., an item, a person, an organization, or a vehicle). The function is represented by the Merge
button on the Viewing pane toolbar.

Note: The Merge function is irreversible and cannot be undone. Be absolutely certain you want to merge
records before proceeding!

1. Open arecord that will function as the primary record of your merging process, typically, the one

with the most accurate information and the most details.
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2. Click the Merge button on the Viewing pane. A Quick Merge form will open with the general details
of the selected record on the left, and an equivalent blank record form on the right.

3. Select the appropriate Secondary Record with which you would like to merge the primary record
from the pick list at the top of the blank form.

The blank form will populate with the data contained in the General tab of the selected record. The
checkmarks will mark the pieces of information that can be merged between the records. For the
fields, where the secondary record contains no information, the checkmarks will be inactive. This
means that the corresponding values in the primary record will remain unchanged.

4.  Select (or deselect) the fields in the second form you want to save (or leave out) using the
appropriate checkmarks.

Click Select/Deselect All to toggle the selection of all the available data fields for merging.

Note: Deselecting all fields in the secondary record form does not mean that the merging of the records
will not occur. The Merge function performs both merging of the general data that is displayed in the
Quick Merge form, as well as the rest of the data that is contained in the merging records and hidden

from the Quick Merge forms (e.g., contacts, attachments, links, history).

5. Click Merge.
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Quick Merge Items (== |[E]
Secondary Record
= '{,‘3 > ||, Laptop 533 =
ltem Photo
tem Name Laptop Computer tem Name Laptop
Serial Number XTP-4005 Serial Number XTP-4005
Criginal Value 2135.00 Criginal Value
tem Class Rolup Comorate Property./Laptop tem Class Rolup
ltem Make Model Rollup Del ltem Make Model Rollup Dell/Inspiron E170%
Owner Identfied Yes Owner Idertfied Yes
Owner Mame Organization Owner Name Organization Sydney Police Service
Cwner Name Person Zeyen, Jeff Cwner Name Person Woods, Victoria
Motes Motes
Located &t the cubicle ADMIN-77. - Bought in 2010. o] @
User Defined Fields User Defined Fields
Field Name Field Value Field Name Field Value Keep Value?
» Expected Retum § Expected Retum § | 300.00
Company Id Tag K Company Id Tag 487WF “
Select/Deselect Al

6. Once the merging of the selected records is complete, a confirmation dialog will be displayed. Click
OK. The secondary record will disappear from the Listing pane, while the resulting merged record

will display in the Viewing pane in editing mode.

Laptop Computer
(0} Corporate Property/Laptop Dell Laptop
—_—
Laptop (0) Corporate Property/Laptop DellfInspiron E1705

(0} Dellf/Inspiron E1705

The result of the merge will be a single record that contains the following components:

a. The values from the primary record data (including the image of the record'’s reference item,
person, organization, or vehicle, and the user defined fields) that were not selected for merging
on the secondary record form;

b. The values of the secondary record data (including the image of the record’s reference item,
person, organization, or vehicle, and the user defined fields) that were selected for merging on

the secondary record form;

c. The hidden data entries pulled from both the primary and the secondary record that correspond

to all or some of the following data types:

The records’ Contacts: Addresses, Phone Numbers, Email Addresses;
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The records’ Links: Person, Organization, and Vehicle Links;

The records’ Histories of all incident involvements;

The records’ Attachments;

If you were merging two Person records, the data will also be pulled from the Unique Features,
Identifications, and Trespass Details sections from both records.

The data that never gets merged (i.e., that is left unchanged, with the primary record’s values)
includes the settings of the Controls tab. If you were merging two Person records, the Flags
Details contained in the primary record will be saved as the default settings for the resulting

merged record too.

Under the Audit History tab, the occurred merge is documented with the help of two Record
Action entries: the Merge entry stands for the occurred merging of the records’ general and
hidden data, whereas the Update entry documents the merging of the specific fields in the

primary and the secondary record forms.

e Laptop e
w' Corporate Property/Laptop
= Save Edit CDJAdd - Delete | () Lock s Print Merge ltems | €3 Cancel

< General History Attachments < Controls Audit History

€3 Get Audit History

=I- Details {Updated)
emName

Drag a column header here to group by thatcolumn

DateTime (GMT) UserlD Record Action Control Changes ~ Machine Infa H Before: Laptop Come
+- After: Laptop
2011/08/26 10:51:53 remnyakova Update 192.168.1.34 x_amMakaMndeanHuplD
Before: d0609624-342d:
2011/08/26 10:51:53 remnyakova Merge 192.168.1.34 i Mter: 618d47d2-517.20a
emMakeModel Rollup
2011/08/26 10:44:23 remnyakova Mew 1592.168.1.34 .. Before: Dell

i After: Dell/Inspiron E
erNameCrganization
Before: (NULL)
After: dc20d681-bfdobed
erCrganization Descr
Before: (NULL)
After: Sydney Police
wnerMamePersonlD
-~ Before: 0672267 b 3403
After: 3c0dc13c-dE5 466
wnerPersonDescription
i Befors: Zeyen, Jeff
After: Woods, Victori;
= udfExpectedRetum

i Before: (NULL)

- After: 300.00

Summary - Laptop

Record Court: 3

User: remnyakova

Record Action: Update
Date/Time

Yours: 26/08/2011 4:51:53 PM
Users: 26/08/2011 4:51:53PM
GMT: 26/08/2011 10:51:53 PM

7. Scan the final record for possible repetitions of data that were merged and resulted in unintentional

duplication of the same information.

8.  Click Save to save the changes made.

m © Resolver Inc. Confidential. Do not distribute. Page 160 of 350



Perspective User's Guide Data Forms

Construct a Visual Link Chart for a Record

Visual Analysis allows you to create a visual link chart representing the data relationships between the
selected types of records.

To activate this function, select the main record of focus (e.g., a Person record) in the Viewing pane and

, . - @ . S L :
click the Visual Analysis icon @® on the Ribbon. A separate Perspective Visual Analysis window will open
with the selected record displayed as an icon in the centre.

See the Perspective Visual Analysis section for further information on building a link chart.

]
B
H

@ Perspective Visual Analysis

HHD X al-]lo RIES & g 4 |[-——+

=
[ ]
j—
»

| »

Blerld ¢ [RXTW

m

Invert Selection

Show Relationships
Show Record k

1]

o

4 [ | ¥
Do mare with this chart
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Analyze and Report

The Analyze and Report module includes three components: Analysis Expert, Reports, and Custom
Reports.

Analysis Expert: Analysis Expert is an internal search engine that scans the data in all Activity, Incident,
Case, Item, Person, Organization, and Vehicle records, and returns results that meet the defined search

requirements.

Reports: Perspective contains a number of preset reports that you may use to generate statistics and
analyze trends in your data.

Custom Reports: You have the ability to take queries that you've built in Analysis Expert and customize
them into custom reports.
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Analysis Expert

Analysis Expert is an internal search engine that scans the data in all Activity, Incident, Case, Item, Person,
Organization, and Vehicle records, and returns results that meet the defined search requirements. Search
results reflect assigned user access rights and privileges. Use Analysis Expert to create a query, and then
turn your query's results into a spreadsheet, a chart, a printed grid, or a report.

User Interface

The interface of the Analysis Expert component transforms according to the stages of query building, by
which it evolves into two separate screens — the initial query designer window and the subsequent query
results window.

The query designer window of Analysis Expert enables you to set specific query criteria, grouping and
search options, and is aimed at producing optimal query results. It is divided into the following six
sections:

1. Ribbon: Contains an additional set of buttons that perform saving, adding, cloning, deletion,
sharing, and execution of queries.

Note: Some functions of the Ribbon buttons are accessible directly from the right-click menu of a
record entry or a query. Specifically, you may add, clone, share, remove, rename, execute it, and edit a
query by right-clicking the corresponding query entry and selecting the relevant option in the menu.

2.  Listing pane: Arranges queries that you create according to their access options (i.e., Shared Queries
or Private Queries) and query category. By default, all new queries are Private Queries available only
to the user who created them. In order to make a saved query available to users across your
organization, you must share it. Refer to the Share a Query chapter for more information on how to
do this.

3. Form(s) pane: Depending on the query selected in the Viewing pane, displays a list of forms
available for querying. Once you select a form in the Form(s) pane, the corresponding fields will be

checked in the Field(s) pane and recorded in the Selection(s) pane.

4.  Field(s) pane: Depending on the form selected in the Form(s) pane, displays specific fields that can
be selected for display in the query results. The selected fields will automatically populate the
Selection(s) pane under Display. The Field(s) pane also enables sorting and grouping of the query
results by specific fields that are imported as query criteria into the Selection(s) pane and Criteria

Designer.

m © Resolver Inc. Confidential. Do not distribute. Page 163 of 350


file://///ppm2000.com/Corp/Departments/Product%20Management/Private/beth.blackstock/My%20Documents/Beth/NEW%20Reports.docx%23shareaq

Perspective User’s Guide Analysis Expert

5.  Selection(s) pane: Displays the selected query criteria, as well as grouping and display options for
the query results.

6. Criteria Designer: Contains three tabs (Criteria, Properties, and Audit) that control the process of
query building.

e The Criteria tab displays the fields that were selected as search criteria from the Field(s) pane and
enables settings of their search values.

e The Properties tab displays the text expression of the criteria selected under the Criteria tab.

e The Audit tab tracks the history of the runs of the query.

Py Perspective EIM -

Main o Privacy Legal
] Q 2 §
'Q%K“\&@aﬂga_ia
: |
Gz ez Lol Seings QF”‘[: Maps Help | Add Edit Share Delete Clone Execute 1
< = = )
Settings Queries
= [ERvAT T
o) Analysis Bxpert o Create New Query = B
) 4
o
3
il Reports =
Save Execute
In Custom Reparts f | Formes) Field(s) Selection(s)
- {0 Incidert Detail Reported to Division " Group By
[Civision Reported To Summary.
[IReported to Supenvisor = Display.
[ISupervisor Reported To e-ncident Number
CFollow-up Required Repotted to Polics
2 3 & Followup Date 4 Reported to Division 5
v Year J
[ uater
[IMerth
[week
Cpay
IWeekday
[IDay of Year v
Criteria | Froperties  Aucit
Criteria Designer
Symbol Fom Field Operator Value
£} Dashboard
b Dispatchlog
5 patarorms
i Analyze and Report
) Gateway
Administration

bb SmokeORole AE Queryvias cancelled Ready @ Comnected
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Navigating Data Forms Overview

To complete a full cycle of creating a query in Analysis Expert and then using the resulting data for further
analysis, follow the general navigation principles described below:

1. Inthe initial query designer window, create a customized query that exactly corresponds to your
specific criteria. From this window, you may also edit, clone, share, delete, save, and/or execute your

query.

2. Once the query is executed, a new window will pop up with the results of the query displayed in the
form of a grid. At this point, you may start working with your query results, which includes searching,
grouping, exporting, charting, and printing them, as well as performing an internal analysis (i.e.,
building a visual link chart or performing calculations) of the individual records that compose the
query results.

3. If you chose to chart your results, a new charting window will appear with a set of standard charting
tools and an option to elaborate the design of the chart even further with the Chart Wizard tool.

When your chart is complete, you may choose to print it or copy it to clipboard.

The following chapters will address the options available for each of these steps in greater detail.
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About Operators

Analysis Expert uses operators to determine what data to display. The following table explains what each

operator means.

Symbol Read as

equals

Explanation of Result

Will display records where the field's value is
equal to the value specified. Note that only
exact matches will be displayed.

is greater than

Will display records where the field's value is
greater than or equal to the value specified. This
operator is only available for criteria with

or equal to . "
numerical values, such as dates, quantities,
amounts of money, etc.
Will display records where the field's value is
is less than or | less than or equal to the value specified. This
<=
equal to operator is only available for criteria with
numerical values.
Will display records where the field's value is
> is greater than | greater than the value specified. This operator is
only available for criteria with numerical values.
Will display records where the field's value is
< is less than less than the value specified. This operator is
only available for criteria with numerical values.
. Will display records where the field's value is not
<> is not equal to .
equal to the value specified.
. . Will display records where the value specified is
Like like . . .
contained somewhere in the selected field.
. . Will display records where the field's value starts
Starts with starts with

with the value specified.
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Ends with

ends with

Will display records where the field's value ends
with the value specified.

Between

between

Will display records where the field's value is
between the dates specified.

Not Between

not between

Will display records where the field's value is not
between the dates specified.

Will display records where the field's value is

Toda toda
v Y today's date.
Will display records where the field's value is
Yesterday yesterday )
yesterday's date.
. . Will display records where the field's value
This Week this week ) .
contains records from this week.
. . Will display records where the field's value
This Month this month ] )
contains records from this month.
. . Will display records where the field's value
This Year this year . .
contains records from this year.
Will display records where the field's value
contains records from the last specified number
Last # Days last # days . .
of days. Will not display the day you are
currently in.
Will display records where the field's value
contains records from the last specified number
Last # Weeks | last # weeks

of weeks. Will not display the week you are
currently in (reads as Sunday-Saturday).

Last # Months

last # months

Will display records where the field's value
contains records from the last specified number
of months. Will not display the month you are

currently in.

Last # Years

last # years

Will display records where the field's value

contains records from the last specified number
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of years. Will not display the year you are
currently in.

Will display records where the field's value is
Is Empty is empty N/A. Using the operator is empty will lock (make
uneditable) the Value field.

Create a Query Category

You can create query categories so that similar queries appear in a table together. For example, you may
have a Quarterly category for all queries you run every quarter, or a Thefts category for any Activity,
Incident, or Case query pertaining to thefts. Any queries that you do not put into a category will
automatically be placed under the Miscellaneous Queries category. You can create query categories when

you create or edit a query.

L Perspective EIM - B n
& Privacy Legal

Main

H e X A O 3y

File  Toggle Logoff Setings Quick Mapping Help | a0 poociie

- Find
Settings Queries
o) . PRIVATE QUERIES
4; J Analysis Expert = Incidents with Knives
Name Type Created Date Last Run Time Description
ol Reperts - = r—
) Query 1 Incident 2014-08-1% 14 These queries show Incidents that have Knives involved
= Miscellaneous Quernies
I i Custom Reports
— Name Type Created Date Last Run Time Description
Queny Incident 2014-08-19 10-
Query Vehicle 2014-08-19 10-..
SHARED QUERIES
--------- = - rt-Miscellaneous Queries
@ Dashboard Name Type Created Date Last Run Time Description
IncidentQueryBy . rt-Incident 2014-08-1% 2:0..
W_} Dispatchlog HewGQueryforio  rtincident 20140819 207 20140819 215
E Data Forms
lm Analyze and Report
ri
Iﬁ’ Gateway

Administration

L3

bb SmokeiRole Ready @ Connected
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Query Design Process

Create a Query

1. Make sure the query category you want your created query to appear under is highlighted (i.e.,
Private Queries, Shared Queries).

PRIVATE QUERIES

Incidents with Knives
Miscellaneous Queries

SHARED QUERIES

rt-Miscellaneous Queries
2. To start a new query, choose one of the following options:

e Click Add  on the Ribbon.
e Right-click in the listing pane, and select Add from the drop-down menu that appears.
3. A Create New Query dialog box will open.
4.  Enter a title for the query in the Name field.
e By default, the system will name the new query, according to the template <New Query>.
5. Make sure the Query Category is correct. If you want to create a new Category, type it in this field.

6. From the Type lookup list, choose the record entity you would like Analysis Expert to search (e.g.,
Incident, Person, Case).

7. In the Description text box, identify the type of query and/or its purpose.

Note: The Description field can be left blank. The Name and Query Category fields must be filled in.
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c Create New Query
Name
Incident = Knife
Query Category Type
Inciderts with Knives Incidert v
Description
Care
8. Click Add.

9.  The new query entry will be added to the relevant record entry node. The Form(s) pane will
automatically populate with the names of the selected record entity’s respective forms (e.g., Incident
Details, Incident Flags, Incident Losses).

Specify Query Criteria

Before specifying criteria for your query, take some time to think about the design of your query by
considering the following questions:

o Do you want to search the whole database or just a portion of data (e.g., incident data recorded
within a particular time period, person data for employees only)?

) If you want to search a portion of data, what parameters do you want in your search?
) What type of data do you want to see in your query results (e.g., incident time, place, losses)?

) How do you want to present your data? Do you want to summarize your results or see lists of actual
data values?

In the example below, we will be looking at a query design with the following specifications:
. Type of query: Incident query.

e Scope of data: Incidents that happened since 2007 and involved net losses (e.g., Net Loss of each
incident is above 0.50 cents).

) Data of interest: Number of incidents, Year, Category, Site, Total Loss, and Net Loss.

) Data grouped by: Year, Category, and Site.
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OPTION 1a: If you want to search the whole database, proceed to select the specific types of data
that you want to see in your query results.

1. Expand the relevant form nodes in the Form(s) pane to see all constituent subforms.

2. Toview fields available in a form in the Field(s) pane, click once on the name of the relevant form. To
select all the fields in a particular form, check the form box.

3. Inthe Field(s) pane, check the boxes of the fields you want to see as headers in your query results
and reports. The field names will automatically populate the Selection(s) pane under Display in the
order they were selected.

e To reorder the fields appearing in your query results, select the field in the Selection(s) pane and
then use the up and down arrows in the top right corner of the pane to rearrange the field's
position in the Display list.

e To delete a field from display in your query results, select the field name in the Selection(s) pane
and click the Remove icon 7% in the top right corner of the pane, or uncheck the field's
checkbox in the Field(s) pane.

Form(s) Field(s) Selection(s)

=¥ ] Incident Detail || L Total Bposure
..l Organizational Rollups
] * Class Rollups
L ]* Business Unit Rollups
+ Site Rollups
+|:|,; Investigation Initiated By Person
- 15 Supervisor Reported To
- 15 Record Owner
+|:| B Incident Flags
+|:| 4 Incident to Incident Links
+|:| B Incident from Incident Links
+|:| B Incident tems
2. ] F Incident Organizations
+|:| B Incident Persons
-] B Incidert Vehicles
+|:| B Incident Naratives v
< >

OPTION 1b: If you want to search a portion of data, set the parameters of your data sample.
1. Inthe Field(s) pane, right-click a field that corresponds to the parameter of interest, and select the

Search By option from the menu. If you do not want a parameter field to be displayed in the query

results, unselect the checkbox beside the field’s name in the Field(s) pane.
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Feld(s)

=[] Reported Date,/Time

T

~[]Quar| #  Search By

- Mon

FlWed Group By

[ | Day Cancel

Wi ¥
[ Dayof Year

[ Hour
-] Minute o

m

The selected field will now appear in the Criteria Designer pane below.

Criteria Properties  Audit
Cntena Designer
Symbaol Form Field Operator Value

(A)

2. To specify a comparison value for the selected parameter, select the relevant Operator from the
lookup list (e.g., =, <>, >, Like, Starts With, Ends With). Depending on the type of parameter, you will
have an option of either entering the comparison value in the Value field, or selecting it from the

lookup list.

3. Add as many parameters for your data sample as needed.

Criteria Properties  Audit

Cniteria Designer

Symbol Form Field Operator Value
A Incident Detail Year »= 2007
3 B Incident Loss Summarny MNet Loss 3= v | 0.05

|

(AAND B)

oA,

W

4. Asyou continue to specify the parameters, the system will edit the corresponding Boolean logic
statement at the bottom of the Criteria Designer pane. By default, Perspective searches for data that
meets both criterion A AND criterion B, and so on. If you want to only generate results that meet
either criterion A OR criterion B, or some variation thereof, you must modify the statement to reflect

this. It is best to modify the statement after you have entered all your data parameters first.
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Note: Deleting a parameter symbol (e.g., A, B, C) from the statement will not remove the corresponding

parameter from the list. However, if a parameter is deleted from the statement, it will not appear in the
executed query results. Ultimately, the Boolean logic statement contains the defining formula for your

data sample, while the list of parameters provides the parameters you may search by, and serves as a

reference point for the statement.

Criteria ~ Properties  Audit

Criteria Designer

Symbaol Form
A Incident Detail
B Incident Loss Summary
» D Incident Detail
os Incident Detail

((% AND By AND {COR D))

Field
Year
MNet Loss
Reported to Supervisor

Reported to Division

Operator Value
2007
0.05

e To reorder the parameters in the Criteria Designer list, select the corresponding row and use the up

and down arrows in the top right corner of the pane to rearrange the parameter’s position in the list.

o To delete a parameter from the list, select the corresponding row and click the Remove icon Zin
the top right corner of the pane, or uncheck the field's checkbox in the Field(s) pane.

) To view the text expression of the Boolean logic statement for your data, select the Properties tab

of the Criteria Designer pane.

Criteria | Properties  Audit

Criteria Text Expression

(({A>=2007 ANDB >=0.05) AND(C=YES ORD=YES)))

OPTION 2a: If you want to see lists of raw data values in your query results, proceed to execute your

query.

OPTION 2b: If you want to see your query results summarized, select the fields by which you would

like to group your results.

1. To group your query results by a particular field, ensure the field's box in the Field(s) pane is

checked. Then, right-click the field and select Group By from the menu.
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Note: Not all fields are available for group by. In order to group by a particular field, it must have only
one reference value, ie., its value cannot be cumulatively derived from several fields. For example, an
incident’s Total Loss field cannot be grouped by, since it potentially draws data from multiple involved
items and vehicles with recorded losses. In contrast, the Site field in an Incident record can refer to only
one site value, which makes it a legitimate candidate for a Group By criterion. Moreover, it is not
possible to group by a child data field (e.g., Assigned Date of Incident Investigators).

Feld(s)

[ File: Mumber

= -[|Reported Date/Time

m

W] e
~[C|Qual # Search By
(| Mon
- Wesg
-] Day] Cancel
""D"l"lllet.ltua]'

|| Dayof Year

[ Hour

D Minute -

Group By

The Summary function is activated when at least one Group By field is selected. This will reflect in the
view of the Selection(s) pane: the selected field name will automatically populate the pane under
both Group By and Summary, while the field names that were listed under Display, will all be
transferred to the Summary list.

If you delete a field name from the Group By list, all the fields contained under Summary will be

transferred back to Display.

Note: If your Display list contains fields from child data (e.g., Incident Investigators’ Assigned Date,
Completed Date, or Last Name), selecting a Group By field (e.g., Year) will transfer all the parent data
fields to the Summary list and delete all the child data fields.

2. Inthe query results, the system will perform data calculations on all the fields that appear under
Summary. The fields’ actual data values will not appear in the query results (unlike when they were
selected for Display); only the products of the specified data calculation for the fields will appear. In
order to see the actual data values together with the calculations, you will need to duplicate all the

relevant field names under Group By using the Field(s) pane, as described above.

To quickly locate the field names in the Field(s) pane, one by one click on the field names in the
Section(s) pane. The system will automatically display the relevant field list in the Field(s) pane.
Right-click the field you want to import to the Group By list of the Selection(s) pane and select
Group By from the menu.
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Selection(s) > Selection(s) > Selection{s) >
Group By =1 Groug By Group By
Summary Year Tear
Incadient Bombar Incident Mumber Ske
Yo Sy
Cbagany % Cabegany - Incadert Nursber
= - - e
Pasgned Clate Lkspiay Catagory
Complated Date Ste
Last Marne Despday

Some of these calculations are meaningful; for instance, the COUNT for Incident Number will
produce counts of Incident records for specific categories by which you chose to group your query
results (e.g., Category, Site). Others may refer to unique categorical entries (e.g., DISTINCT COUNT
for Site or Year), and will not produce meaningful results, unless you choose to display the actual
values of the field (i.e., transfer the field to the Group By list). Therefore, you will need to think very
carefully about selecting the right fields for summaries (e.g., sums and averages for losses, counts for
items), and leaving the rest as actual values (e.g., names of categories, sites, years).

Note: Once a field appears in both Summary and Group By lists, its calculation node disappears, which
means that the system will display the actual value of the field (not a calculation) in the query results.

3. Proceed to save or execute the query.

Save a Query

1. Complete the design of your query.
. . Cu .
2. Store the query for access at a later date by clicking Save I=! on the Ribbon.

Edit a Query
1. Make sure the query you want to edit is highlighted.

PRIVATE QUERIES
= dsagdg

lame Type Created Date Last Run Time Description
adsg Vehicle 2014-08-20 5:1.. adsg
=  Incidenis with Knives
Name Type Created Date Last Run Time Description
 Incident :2014-08-21 10....
Query 1 Incident 2014-08-19 1:4.. These queries show Incidents that have Knives involved.

2. To open and begin editing the query, choose one of the following options:
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e Click Edit ® on the Ribbon.

e Right-click in the listing pane, and select Edit from the drop-down menu that appears.

3. The Query dialog box will open.

L Edit/View Current Query Description

Name

Incidert > Knife
Query Category
Incidents with Knives

Description

Cancel

e You can change the query Name, Category, and/or Description.

4.  Click the Edit button to open the query or the Cancel button if you have selected the wrong query.

5. Toview a query’s specifications, select the query from the tree on the Navigation pane. Review the

Form(s), Field(s), Selection(s), and Criteria information and make changes to the selected checkboxes,

if necessary.

. . LT .
6.  Store the query for access at a later date by clicking I=| Save on the Ribbon.

Clone a Query

1. Make sure the query you want to clone is highlighted.

PRIVATE QUERIES
= dsagdg

Name

adsg
= Incidents with Knives

2014-08-21 10-...;
2014-08-19 1:4.. These queries show Incidents that have Knives involved.

Created Date Last Run Time Description
2014-08-20 5:1.. adsg

Created Date Last Run Time Description

2. To clone the query, choose one of the following options:

e C(Click Clone % on the Ribbon.
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e Right-click in the listing pane, and select Clone from the drop-down menu that appears.

3. A prompt will appear, asking if you are sure you want to clone the query. Click the Yes button to
clone the query, or No to cancel the cloning process.

Perspective

Are you sure you want to clone the following query?

Name: Query
Type: Incident
Query Category: Miscellaneous Queries

Description:

Note: If you do not have Manage rights, you will be unable to clone a query. Additionally, you are only able
to clone a query that has already been shared to you.

Share a Query
1. Make sure the query you want to share is highlighted.

PRIVATE QUERIES
=] dsagdg

Mame Type Created Date Last Run Time Description
adsg Vehicle 2014-08-20 5:1.. adsg

=  Incidents with Knives

Name Type Created Date Last Run Time Description
*Incident 20140821 10
Query 1 Incident 2014-08-19 1:4.. These gueries show Incidents that have Knives invelved.

2. To share the query, choose one of the following options:

e Click Share Lg on the Ribbon.

e Right-click in the listing pane, and select Share from the drop-down menu that appears.
3. The Share Query dialog box will open.
4.  Click the Add User button and/or Add Role button.

5. Select the user(s) and/or role(s) you want to share the query to by typing his/her name and/or role in
the text field, or scrolling through all users and/or roles.
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6. Double-click the user's name and/or role to confirm your selection.

e Click the Allow Manage checkbox if you want the user or users in a particular role to have the
ability to edit, share, delete, or clone the shared query.

e If you share to a user and a role, and that user is in the role as well, the query will be shared to
him/her twice.

Note: If you give a user Manage rights when sharing a query, the user is able to modify the original query.
To keep a copy of the original query that cannot be edited, clone it for yourself.

Share Query: Incident > Knife

Add User Add Roles Remave
Share To Share To Allow Manage
User “Offl - Officer, 1 ! |
Save Cancel

7. Click the Add Roles button.

8.  Select the role you want to share the query with by typing its name in the text field, or scrolling
through all roles.

9.  Double-click the role’s name to confirm your selection.

e Click the Allow Manage checkbox if you want those with that role to have the ability to edit,
share, delete, or clone the shared query.

10. Click Save.

e Shared queries will have the 3 Share icon displayed beside the title.

=  Incidents with Knives

MName Type Created Date
& | Incident > Knife | Incident -

Query 1 Incident 2014-08-19 14
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Delete a Query
1. Make sure the query you want to delete is highlighted.

PRIVATE QUERIES
= dsagdg

Mame Type Created Date Last Run Time Description
adsg Vehicle 2014-08-20 5:1.. adsg

=  Incidents with Knives

Name Type Created Date Last Run Time Description
Incident > Knife £2014-08-21 10 ;
GQuery 1 Incident 2014-08-19 14.. These queries show Incidents that have Knives involved.

2. To delete the query, choose one of the following options:

e C(lick Delete 3 on the Ribbon.
e Right-click in the listing pane, and select Delete from the drop-down menu that appears.

3. A prompt will appear, asking if you are sure you want to delete the query. Click the Yes button to
delete the query, or No to cancel the deletion process.

Execute a Query

1. Once your query is created, you may either run it immediately, or save it for further use, and then
run it. To run a saved query, select the name of the query you want to run from the query list in the
listing pane.

2. To execute the query, choose one of the following options:
o Click Execute ® on the Ribbon.

e Right-click in the listing pane, and select Execute from the drop-down menu that appears.

3. A new window will open displaying the Criteria for the query. You do have the ability to modify the

Criteria values if needed. Click the Execute button inside this window.

Note: Queries can be run in the background. As a result, you can set up the next query, design a report,

or review a record while waiting for the results notification to appear.
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o Incident > Knife = B

3

Execute

Symbol Form Field Operator Value
4 A Incident Detail Year 3= 2007
B Incident Loss Summary Net Loss 3= 0.05
D Incident Detail Reported to Supervisor = YES W
C Incident Detail Reported to Division _ YES W

({AANDB)AND(CORD))

Track Query Runs

To track the history of query runs, open the Audit tab of the Criteria Designer pane. The tab will display
the following information:

e Last Run By User: The user who last ran the query.

e Last Run Time: The time when the query was last run.

e Last Run Returned Rows: The number of data entries in the query results.

e Last Run Duration (second): The time Analysis Expert needed to generate the query.

e  Where Clause and SQL Statement: Technical data on the query data, criteria, and location.

Criteria  Properties | Audit

Last Run By User Last Run Time Last Run Retumed Rows Last Run Duration (second)
Clirt 23/02/2011 7:55:35 AM 2 0
Where Clause

SELECT ID_PK FROM dbofcrdblPersonsSecured%'lUserlDaDe4cB1 b 70-4261-56-0ab2ced 7578c") AEPersons WHERE ( (ID_PKIN (SELECT Person|D_FK .
FROMthPer&onTrespasses erson [respass v (Convert{varchar(Tl) BxpiyUate_DT. 117} = AT 23 ) |

SQL Statement

SELECT AEPersonDetail ID_PK AS ID,AEPerson Detail ID_PK AS Person|D, AEPersonDetail FirstMame_NV AS [Fiame] AEPersonDetail LastMName _NY AS [Wv -
Last Namé]'mmmb?’wmons Setirs ser(Ualedc - ’bmmm H2 AEPersonDetail ™V Eraon HWIN {

{ -0684-45c 48475 ¢ 15t Erson Irespass. |

ID AEPerson TEspass PErsnIl Personil FR By G lemmm%ﬁmeass m@?ﬁl FROM thiPerson Trespasses
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Working with Query Results

View Query Results

Once the query is executed, a new window will open with the results of the query displayed in the form of
a grid. The number of returned records will be displayed at the bottom of the screen.

E7f Incident Executed at 2014-09-18 3:59:10 PM = =
[3] Export (2 Print Grid i8] View Detail 5] View in Visual Analysis  Incident Detail - [ Chart | (=} Print Detail Report
View Style
[ Show Child Record Records Found {26025) ﬁ Analyze Results
() Horizortal |
O Vetical Drag a column here to group by that column _
() Outlook Group By Incident Detail o
Incident Number  File Number' Name  Reported Date/Time  Occurred From DateTime  Occurred To Date/Time  Record Owner Incident [
Expand Al INC-DO0DO16757 2013-08-15 320 PM  2013-08-15 3:08 PM 2013-08-15 4:21 PM Harris, Gilbert 73
INC-D00D015657 2013-07-15 6:44 PM  2013-07-15 6:32 PM 2013-07-15 8:07 PM Stinson, Helen 95
Card View INC-D000014466 2012-05-24 10:23 4 2013-05-24 10:11 AM 2012-05-24 1212PM  Carver, Renald 121
hd INC-D00D000SS2 2011-03-12 11:29P  2011-09-12 1117 FM 2011-09-13 1:04 AM Young, David 107
Text Search INC-D00D020321 2013-12-17 257 AM  2013-12-17 2:45 AM 2013-12-17 413 AM Douglas, Allen 88
INC-D00DO14188 2013-05-13 2:40 AM  2013-05-13 2:28 AM 2013-05-13 4:54 AM Riley, Brizn 146
-] Bactecolor of Search Resuits INC-D00DO10225 2012-11-30 11:41A  2012-11-30 1129 AM 2012-11-30 1259PM  Spears, Calvin 90
[ Include Chid Record INC-0000014592 2013-05-30 8:47 AM  2013-05-30 8:35 AM 2013-05-30 10:43 AM Carver, Ronald 134
[ Exact Match of Text INC-D000011716 20130209 1:35PM  2013-02-09 1:13PM 20130209 257 PM Douglas, Allen 104
L] Case Senstive INC-DODDO23120 20140425 453AM 20140425 4:41 AM 20140425 611 AM Newell, Ethan 90
Search Giid INC-0000013366 2013-04-13 822 AM  2013-04-13 210 AM 2013-04-13 10:05AM  Young, David 115
INC-0000008121 2012-09-17 223PM  2012-08-17 211 PM 2012-09-17 3:20 PM Newell, Ethan 69
INC-D000003178 2012-01-30 5:04 AM  2012-01-30 4:52 AM 2012-01-30 7:23 AM Spears, Calvin 151
INC-D00D001686 2011-10-27 528 M 2011-10-27 5:16 PM 2011-10-27 6:26 PM McDenald, Rory 70
INC-D000009286 2012-10-25 4:41PM 2012-10-25 4:23 PM 2012-10-25 5:58 PM Dawson, Maddie 89
INC-D000018809 2013-10-14 9:35AM  2013-10-14 9:23 AM 2013-10-14 10:24AM  Riley, Brian 61
INC-D00DO16412 2013-08-06 8:42PM  2013-08-06 8:30 PM 2013-08-06 9:50 PM Riley, Brian 80
INC-D00DO13045 2013-04-02 6:15PM  2013-04-02 6:03 PM 2013-04-02 7:22 PM Riley, Brizn 79
INC-D00DO12765 2013-03-24 425PM  2013-03-24 413 PM 2013-03-24 5:08 PM McDonald, Rory 55

M~ nAAnAN1ECER AN19 AT A0 0.EE AML T AT AL 0.47 AR N1 AT A0 1NAA AR Unrin Milkmes 171

[ Number of Records Retumed 26025 I L]

Search for Specific Data in Query Results

To search for specific data in your query results, use the Text Search function. Type a keyword in the Text
Search field, and click Search Grid.

) The color of the highlighted search text can be modified using the Backcolor of Search Results
lookup list.

. Check Include Child Record to search all records in the query results.
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e  Check Exact Match of Text to search only for text that corresponds exactly to the text entered in
the Text Search field.

o Check Case Sensitive to only search for text containing the correct uppercase or lowercase
characters specified in the search text.

CA <My Experimental Query>  executed at 20,/12/2010 10:57:02 AM (=R
@ Export L‘:E:] Print Grid View Detail View in Visual Analysis  Incident Detail ~ [En Chart Print Detail Report
View Style Records Found {56)
7 .
Show Child Record Incident Detail -
(2 Horizortal Incident Number Year % Class Rollups Category  Site Rollups.Sit  Incident Loss. Total L ¥, Incident Loss Netlo X
@ Vertical INC-2003-000252 2008 211 2911
(0 Outlook Group By ADMI-2010-00011 2010 3000 3000 | _
_ INCDODDOD00182 2008 ACCIDENTS Manitoba 4532 44437
Collapse Al
“ = INCDOODDODO1BE 2008 Emergency Situation Site B 437724 63 5437554 63
Card View Incident Investigators
<None> - Assigned Date Completed Date Investigator.Last Name
06/04/2006 Adams
Text Search 17/03/2009 17/03/2009 Johanssen
2009
Incident Detail
Backeolor of Search Results Incident Number Year X Class Rollups.Category  Site Rollups.Sit Incident Loss. Total L X Incident Loss MetLlo X
Include Child Record = INCDO0D00DO186 2008 Security & Safety Syste  Site A 950 160
[T Bxact Match of Text Incident Investigators
[] Case Sensttive Assigned Date Completed Date Investigator. Last Name
Search Grid 24/02/2009 25/02/2003 Adams i
”Nm‘rﬂ)erufreturredrennrds:SS ” | J

Group Query Results by a Field

e  To group the results by a field, drag the column heading to the gray box above the grid and drop
it. All query results will automatically collapse, grouped by the column heading you just selected.
Grouped By query results may contain child records. To view child records, click Expand All to view

all records contained under nodes. Once clicked, the name of this button will change to Collapse All.
Click this to hide all child records again.

ﬁecords Found (32) Records Found (32)
|‘r’ezr_ I} EI"' n header here to group by that column Year
Tincident Detzil Year : 2007 (11 items)
Year £| COUNT_ E Class Rollups.Category  Site Rall { “fear : 2008 (17 items)
2007 1 ACCIDENTS Site B “ear : 2008 (& items)
2007 2 Assault Site A Year: 2010 Z items)
2007 1 Emergency Situation Site B

e  To add another tier to the grouping, first expand one of the nodes to view its data in grid format.
Then, click and drag a different column heading to the gray box. The query results will once again
collapse, grouped first by your initial selection, and then by your second selection. You may continue
to add tiers to your grouping using the same method.
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e  To reorder the tiers in your grouping, click and drag the column headings in the gray bar.

Records Found (32)
'

f
- o Year
il EC"'LPS-D"SH Site Rollups.Site

= Year : 2007 (4 items)

2
3
1
1

[= site Rollups Site : Site A (4 items)
Incident Detail
COUNT_Incid E Class Rollups Category

Assault

Fire

Security & Safety Obser
Theft

Site Rollups Site : Site B (4 items)
Site Rollups Site : Site C (1 item)
Site Rollups Site : Site D (2 items)

Year : 2008 (6 items)

Year : 2009 (6 items)

Year : 2010 (2 items)

SUM_Incident Loss Total Loss

1823625
28440
450
13000

¥ SUM_Incident Loss.Net Loss

1818171
19500
450
5000

¥ GROUPED_BY

2007/Assault/Site A
2007/Fire/Site A
2007/Security & Safe
2007/Theft/Site A

e To remove a field from your grouping, drag the column heading in the top gray bar and place it

anywhere in the query results screen.

Perform Calculations on Query Results

1. To perform calculations on data in query results that were created using the Group By option, select
the Outlook Group By radio box in the View Style section. The Sigma (Z) symbol will appear on all
column headings. (If the Group By function was used to build the query, Sigma will automatically
appear on column headings.)

2. To perform data calculation on a column of data, click the X button at the top of the respective

column. The Select Summaries dialog box will open.

3. Select the type of calculation that is required for the column (Average, Count, Maximum, Minimum,

and/or Sum). You can select more than one calculation option.

4.  Click OK.

™ Select Summaries
[][#* Average
[ & Count
[T B Maximum
[ & Minimum
=| Sum

[ ok

] [ Cancel
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The calculation results will be displayed below the appropriate columns at the bottom of the query results.
If your results were grouped by a field within the query results window, then the calculations will apply
and be displayed for each group.

Records Found (32)
o
Site Rollups Site *

= Year : 2007 (4 items) COUNT_Incident Wumber Sum = 18, SUM_Incident Loss Total Loss Average = 175396.36272727272727272727273, SUM_Inciden
= Site Rollups.Site : Site A (4 items) COUNT _Incident Number Sum = 7, SUM_Incident Loss Total Loss Average = 466378.75, SUM_Incident Loss Net

Incident Detail

COUNT_Incident Mumber % Class Rollups.Category ~ SUM_Incident Loss Total Loss % SUM_Incident Loss Net Less % GROUPED_BY
2 Assault 1823625 1818171  2007/Assault/Site
3 Fire 28440 19500 2007/Fire/Site A
1 Security & Safety Obsens 450 450 2007/Security &
1 Theft 13000 5000 2007/ Theft'Site A

Summaries for Site A

Sum=7 Average = 466378.75 Average = 460780.25

Sum = 1865515.00 Sum = 1843121.00
1= Site Rollups. Site : Site B (4 items) COUNT_Incident Mumber Sum = 5, SUM_Incident Loss. Total Loss Average = 1228750, SUM_Incident Loss Net L

Incident Detail

COUNT_Incident Mumber % Class Rollups.Category ~ SUM_Incident Loss Total Loss % SUM_Incident Loss Net Loss % GROUPED_BY
1 ACCIDENTS 15000 15000 2007/ACCIDENT
1 Emergency Situation B0 B0 2007/Emergency
2 Fire 30000 25000 2007/Fire/Site B
1 Theft 100 100 2007/ Theft/Site B

Summaries for Site B

Sum=5 Average = 1228750 Average = 11037.50

Sum = 49150.00 Sum = 44150.00

Site Rollups Site : Site C (1 item) COUNT_Incident Number Sum = 2, SUM_Incident Loss Total Loss Average = 13095.00, SUM_Incident Loss Net Lo

Site Rollups Site : Site D (2 items) COUNT_Incident Mumber Sum =2, SUM_Incident Loss Total Loss Average = 797955, SUM_Incident Loss Met Lo
Year : 2008 (6 items) COUNT_Incident Wumber Sum = 13, SUM_Incident Loss Total Loss Average = 498542 05T727272727272727272727, SUM_Inciden
Year : 2008 (6 items) COUNT_Incident Mumber Sum = 18, SUM_Incident Loss Total Loss Average = 162944 625, SUM_Incident Loss Net Loss Average
Year : 2010 (2 items) COUNT_Incident Number Sum = 9, SUM_Incident Loss Total Loss Average = 515642 45, SUM_Incident Loss Net Loss Average =

Export Query Results
1. To export query results, click =51 Export on the top toolbar. A Windows Explorer window will open.

2. Choose the location for the new file and name the file and indicate the file type (e.g., Excel-Data
(*xls). Click Save.

3. You will receive a confirmation message stating the export was successful. Click OK.

Print Query Results

1. To print the query results, first estimate the layout of your grid in relation to the portrait layout. If
deemed necessary, scale the query results window to fit one portrait page.
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2. Click k= Print Grid on the top toolbar. A Print Preview window will open.

3. Review the layout of the grid using the toolbar at the top of the screen.

4. Click the Print icon & to print the grid.

a-' Print preview [ (B[]
ébp'|ﬂm.mm|(:|ose Page| 1/%

e o T e i
e e e e e tn e e e a8 Btk e i e

ey 1
— e |

Access Records in Query Results and Print Reports

Note: These functions are not available if the Group By function was used to build the query.

To view a record from the list of records contained in your query results, select the record and click g,
View Detail. The record will open in a separate window in the read-only mode.

To print, email, or save one of the records listed in the query results, follow the steps below:

1. Select the record and click (=l Print Detail Report.

2. A Report Visibility window will appear. This window contains checkboxes for all report sections
containing data. By default, all boxes will be checked. Uncheck the boxes for any sections you do not

want to appear in your report. Check the Download All Attachments? box if you want to download
the attachments included in the record for printing. Then, click OK.
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Subreport Visible
Cover Page

Incident Detail
Incident Flags
Incident Persons
Incident Organizations
Incident ltems

Incident Narratives
Incident Attachments
Incident Reviews
Incident Assignments

HEEEEEEEEE

Select Al Deselect Al Download Al Attachments? @] | OK | [ Canesl |

3. The Report Options window will open.
a. Click the Open icon to instantly view a printable PDF copy of the report.

b. Click the Send icon to send an email message with a PDF copy of the report attached.
c. Click the Save icon to save a PDF copy of the report to the location of your choice.

d. Click the Close icon to cancel the report.

)

The Report is available for viewing.
What would you like to do with this report?

Open
Open this report with PDF viewer.

Send
*—@ Send Report as Attachment

Save
m Save Report as PDF

Close
% Take Mo Action With This Report

Created :Mar-19-2013 5:01 FM
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Construct a Visual Link Chart From Query Results

With Perspective Visual Analysis, you can create a visual link chart representing the data relationships

between records listed in the query results.

Note: If the Group By function was used to build the query, this feature will be disabled.

Click anywhere in the query results and then select ¥ View in Visual Analysis. A separate Perspective

Visual Analysis window will open with all the records listed in the query results contained within.

See the Perspective Visual Analysis section for further information on building a link chart, or click the

Help icon in the Visual Analysis window.

5 Perspective Visual Analysis =] = ]
== LY (- . . el - = i
SHA X 92I]loRIES 86 g &1 ——+ nﬂi

N
ﬁ. L 5 L ﬁ L i L -
i/ i/ i/ i/ wi
INC-2008-000212 INC-2008-000028 ADMI-2010-000067 INCDOO0DO000ZS -
o
o
&
»
p—
&
i/ i/ i/ i/
COW-2011-02-00026 INCDOO00000103 LUI%-0000000086 INC-2008-000022
=
et
£ et i et
i/ 74 i/ 4 &
INC-2008-000005 CCW-2011-02-00086 ADMIL2011.01-00012 INC-2008-000251 =

il

L

©

b
Do more with this chart J

Chart Query Results

1. To begin charting your query results, click > chart. If your query results contain child data, you may

choose to chart either parent records (e.g., Person Detail) or child records (e.g., Person Incidents

Involvement) by selecting the appropriate data label under the attached lookup.

2. A charting window will open with a blank Viewing pane, a list of variables available for charting listed

in the Data pane on the left, and a grid with raw chart data listed at the bottom Data tab. (In this

section, we will be looking at the case of an organization that wants to know the proportions of

marital statuses of their employees by gender.)
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In the Data pane, select an X-Field (e.g., Gender) and a Y-Field or multiple Y-Fields (e.g., Last Name)
for your chart from the available options. The X-Field data will appear on the horizontal x-axis of
your chart. The Y-Field data will appear on the vertical y-axis of your chart. If you select more than
one Y-Field, ensure that they have the same unit of value (e.g., dollars, items). Note that Y-Fields are
always charted as numerical values. Generally, text fields are counted (e.g., quantity of Incident
Numbers or Last Names), while numerical fields are summed (e.g., amounts of Incident Losses).

Your chart will appear in the Viewing pane. By default, your initial chart will be formatted as a
column chart. The bottom pane will display your selected Chart Data.

You may copy and paste data from the Data or Chart Data tabs into Excel by highlighting the data
and then using the Ctrl+C and Ctrl+V keyboard commands.

[l Marital Status by Gender executed at 21/12/2010 3:24:29 PM, Chart Created at 21/12/2010 3:24:32 PM o= ]
Eﬁ Copy to Clipboard [E] Print | B ChartTypes ~ [B Wizard |t Clear Themes v/ Border  MNone - _
Lizs ? Enter Title
------ 1l Column chart
I Last Mame
Data 1
= X- Fields
(0 LastName
Add Series I Female Male
Chart Data 1
o [] Marital Status Gerder Lozt Name
ema 33
Male 47
Data | Chart Data

If you want to select an additional variable for your chart (e.g., Marital Status) to see the distribution
of one of your variables by another (e.g., Marital Status by Gender), right-click the variable under X-
Fields, and select Add Series. The chart type will switch to a pivot chart. The new variable will be
added to the x-axis and will be explained in the chart’s legend.

Note: Once a Series variable is incorporated into your chart, only one Y-Field will be charted.
Additional Y-Fields will automatically be dropped from your chart.
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[LIl Marital Status by Gender  executed at 21/12/2010 3:24:29 PM, Chart Created at 21/12/2010 3:24:32 PM |- ]
Ei, Copy to Clipboard @ Print & Chart Types - Iﬁ;b Wizard |[f- Clear [E] Themes ~| Border | Mone - ;
LiziE i Enter Title
------ [l Pivote Chart
35 I Common-law
Divorcad
30 I Married
Single
75 Widowad
Data q 20
El- X - Fields
() Last Name 15
@ Gender
() Marital Status 10
Bl Y - Fields 5
Last Name
[[] Gender 0
[C] Marital Status Female Male
Chart Data 5
Gender Marital Status Last Name 5
Female Divorced 1
Female Marmied 8
Female Single | -
Data | Chart Data

7. If the chart does not have a series field, you may use the available toolbar options to adjust its
appearance. These options are also available with a greater range of functionality in the Chart

Wizard. For description of the various chart customization options in Chart Wizard, see Appendix D:
Chart Wizard.

a. To change the default column chart to a different chart type, choose an option from the ::H
Chart Types lookup list (e.g., pie, bar, area). The Charts pane will automatically populate with the
name of the selected chart.

b. To change the default 2D (two-dimensional) chart to a 3D (three-dimensional) chart, choose 3D
in the drop-down menu on the toolbar. Click and drag the chart to rotate it and adjust its
perspective.

¢. Enter a name for the chart in the Title text box.

d. From the Border lookup list, select a border or frame style for the chart.

e. Inthe 2] Themes lookup list, select a color theme for your chart.
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If the chart does include a series field, any customizing of the chart, including changing the chart

type, must be done in the Chart Wizard.
8.  To copy your chart to clipboard & or print it Eﬂ click the appropriate icon on the toolbar.

9. If you want to erase this chart and construct a new chart of the query results, click " Clear on the

toolbar, or right-click in the chart area and select Clear.
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Analyze Results

Analyze Results allows you to choose how you view your query results. You can filter by variables and
continually modify the results displayed. You can change the appearance of your results, as well as narrow
or expand your results by hierarchy levels, building locations, criminal activity type, etc. The Pivot Grid in
the Analyze Results module allows you to determine the data you want displayed, while the Data Chart
section and Pie Chart section gives you the ability to dig deeper into your results and display them in a
visually appealing way.

Table

The table section of Analyze Results is where you decide what to analyze and how you want it to be
displayed.

1. In the Navigation pane, open the Analyze and Report module.

2. From Analysis Expert, choose the query record that you want to view. To execute the query, do one
of the following:

o Click Execute  on the Ribbon.
e Right-click in the listing pane, and select Execute from the drop-down menu that appears.

3. If you have user rights, you may make modifications to the Value field in the window that appears.

Then click the Execute 3 button.

‘ ﬁ Anatyze Results

4.  Click the Analyze Results button.

5. The Analyze Results window will open. By default, you will be in the Show as Table tab. From here,

you can begin organizing and filtering your data into a table.

6. Choose the variables you want to see displayed in your table by dragging them from the Fields

section into the Filters, Columns, Rows, or Measures windows.

e Filters: Allows you to limit the data you see by filtering out the fields you don’t want displayed.

Select the variables you want to filter by.

Note: You can change the variables on the Tables, Data Charts, and Pie Charts tab.
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e Columns: Organizes the selected fields into columns.
e Rows: Organizes the selected fields into rows.

e Measures: Shows a count of the data you want displayed.

Fields il Measures

; Count of records

v . Incadent Detail

— Ill Measures

| Ill Count of records

Fields

. Incident Detail o)
— Ill Measures

IIl Count of records

i
» ¥ Count of records

II Incident Duraticn

L

» ¥ e-Incident Mumber
» ¥ File Number\ Name
» T Incident Duration
» T Incident Initisted By
» T Incident Number
» T Occurred From Date/Time
» T Occurred To Date/Time
» T Police File Number
» T Record Owner
L s # PRenodedDatelms

L AN 2AN SAR 2AN R 2R 2

' !

Drag fields between areas below:

T Filters Ml Columns

T Record Owner

v File Number\Name

= 1l Measures

" Fepored DeTme

Defer Update Update Layout |

Note: Selecting the Defer Update checkbox will prevent your data from automatically being shown on your
screen. If this checkbox is selected, you will have to click the Update Layout button whenever you want to see

a current display of your data.
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7. Once you have selected the data you want to appear in the table, you can dig deeper by using the
Data Slicer to narrow or expand your results by hierarchy and level.

e Once you have decided how you want to slice your data, click on the specific hierarchy and level
you want to view.

Note: To hide the hierarchy and level drop-down menus, click the =! button. To bring it back into view,
click the [#l button. Additionally, if you want to reset the hierarchy and level, click the % button.

Diata Slicer

Hierarchy Level
Record Owner + | | Record Owner +

[Car\ter, Ronald
IDawson. Maddie
[Douglas. Allen
IHanis. Gilbert

| Martin, Carl
[McDonaId. Rory
[Newell, Ethan
[Riley. Brian

I Spears, Calvin

[Stinsan, Helen

L
|
|
|
|
J
|
|
|
|
|
|

[Young. David

Note: You can hide the Data Slicer section of Analyze Results by clicking the © button, found in the
top left corner of the Analyze Results window. Click the ®button to bring the Data Slicer back into
view.

8.  To show different counts of your data (Average, Count, Minimum, Maximum, or Sum), use the
Aggregator drop-down menu.

Aggregator | Count ¥

Average

Count
Minimum
Masamum
Sum

9.  Now that you have organized your data by the information you want displayed, you can do any of
the following:

e Click the Export to Excel button.

e Click the Show as Data Chart tab to view your results in a chart.
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e C(lick the Show as Pie Chart tab to view your results in a pie chart.

Note: You can save how your results are displayed by clicking the Add button in the upper left corner of the
Analyze Results window. Type a name for your saved view and press the Save button (which appears after
you click Add). To cancel, click the Cancel button. Saved views are visible to people you share the queries
with. Each shared query has a common set of saved views. This means that if anyone adds a view to a
shared query, everyone that query is shared to will be able to see it.

Data Chart

The data chart tab allows you to modify how you view your data results. The following section will give
you an in-depth understanding of the options you can use in the Data Chart section of Analyze Results.

1.  Click the Show as Data Chart tab.

2. From the Chart Type drop-down menu, select the type of chart you want your results to be
displayed in.

Chart Type

Column ¥

Lrea
Column
Linz

Point
Step Area
Step Line
Waterfall

3. Enter a title for your chart in the Title field.
4.  Enter a subtitle for your chart in the Subtitle field.
5. Select the Show Marker Values checkbox to see exact counts.

6.  Select the Enable DataPoint Tracking checkbox to allow you to track exact numbers for different
variables. Hover over the chart to have these numbers displayed.

7. Select the Show Shadows checkbox to better define particular variables on your chart.

8.  Select the Show Zoom Options checkbox if you want to be able to zoom into specific areas of your

chart. To do this, hover over the small replica of your chart to decide if you want to:

m © Resolver Inc. Confidential. Do not distribute. Page 194 of 350



Perspective User's Guide Analysis Expert

10.

11.

e Zoom out &
e Zoomin &
e Reset your zoom to default &%, or

e Select the default mouse drag interaction by right-clicking the & button (zoom into selection
area ¥, or pan W)

Note: If you Copy Chart as Image, you need to deselect the Show Zoom Options checkbox or else it will
appear in your copied image.

By default, the Show Legend checkbox is selected. To hide the legend, deselect the Show Legend
checkbox.

From the Legend Position drop-down menu, select where you want your legend to appear in
relation to the chart.

You can copy the chart and paste it into a document (e.g., Microsoft Word or Excel). To do this, click
the Copy Chart as Image button, open the program that you want to copy the chart to, and paste it.
Or, you can save your chart to your desktop by clicking the Save Chart as Image button.

Incidents with Knives 2013
2013-2014 2011

900 870 879 887

800
700
600
500
400
300
200

100

0 Harms, GilberStinson, HeleCarver, RonzYoung, DavicDouglas, Alle Riley, Brian Spears, CalvNewell, EthaiMcDeonald, RDawson, Mac
NiA

Note: Hide the charting options by clicking the Chart Options ® button. Bring the options back into view by
clicking the @ button.
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Pie Chart

The Pie Chart tab, while a different type of chart from the Data Charts tab (with different options to view
your results by), allows you to modify how you view your data results. The following section will give you
an in-depth understanding of the options you can use in the Pie Chart section of Analyze Results.

1. Click the Show as Data Chart tab.

2. Enter a title for your chart in the Title field.

3. If you want to see exact numbers, hover your mouse over the pie chart.

Stinson, Helen/N/A
2366 (9%)

4. You can copy the chart and paste it into a document (e.g., Microsoft Word or Excel). To do this, click
the Copy Chart as Image button, open the program that you want to copy the chart to, and paste it.
Or, you can save your chart to your desktop by clicking the Save Chart as Image button.

Note: Hide the charting options by clicking the Chart Options ® button. Bring the options back into view by
clicking the @ button.
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Reports

Perspective contains a number of preset reports that you may use to generate statistics and analyze
trends in your data.

User Interface

The interface of the Reports component of Perspective is built around the specific type of report that is
selected from the Navigation pane, and can be roughly divided into three parts:

1. Navigation pane: Allows you to select various preset reports from five general categories. Once
selected, the name of the report will appear at the top of the Report System pane.

e Administrator Only: Reports that list groups of administrative hierarchies available in
Perspective (e.g., Roles, Users, etc.).

e Detail Reports: Condensed summaries of individual records stored in Perspective.
e List: Reports that contain lists of records, assignments and losses.
o Lookups: Reports that list values available in various Perspective’s lookups.

e Summary Reports: Reports with a summary of data analysis; results are summarized in assorted
bar and pie charts.

2.  Report System pane: Assists in filtering data for future reports and executes their creation.
3.  Report Settings toolbar: The invariable part of the Report System pane that provides options for
refreshing the report settings view, generating reports in PDF, and opening previously run reports

locally.

4.  Report Settings pane: The variable part of the Report System pane that displays tabs, panes, and

tools for specifying parameters for the data used in your report.
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1] Al Workigroups for Lockasa and Rolkaps.

Types of Reports

Administrator Only

Role List: Lists all system roles, along with their respective descriptions and organizational rollups.

Test Report: For testing purposes only; successfully running this report demonstrates that SQL
Reporting Services is operating properly.

User List: Lists all system users, along with their assigned security controls (roles, workgroups,
organizational rollups, and access levels), and groups them by a security control of your choice.

Workgroup List: Lists all workgroups, along with their respective descriptions, organizations, and
Perspective e-Reporting access status.

Detail Reports

Incident Executive Summary: Displays the selected Incident record in brief detail, providing a short

summary of the incident, its investigation and outcome, which is intended for managerial review.

Activity Landscape: Displays the selected Activity record in great detail in a landscape-format
report.

Activity Portrait. Displays the selected Activity record in great detail in a portrait-format report.

Case: Displays the selected Case record.
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e Incident Condensed Landscape: Displays the selected Incident record in great detail in a landscape-
format report.

o Incident Condensed Portrait. Displays the selected Incident record in great detail in a portrait-
format report.

e  Incident: Displays the selected Incident record, including some of its investigation data.

e  Item: Displays the selected Item record.

. Organization: Displays the selected Organization record.

e Person: Displays the selected Person record.

. Vehicle: Displays the selected Vehicle record.

e Investigation: Displays investigation data from the selected Incident record.

List

o Case Assignment By Person: Lists all case-related assignments along with key assignment details,
such as the particular case in which the assignment was created, the user who created the

assignment, and the user who was given the assignment.

. Case Losses: Groups and totals case loss values by category, manager, supervisor, status, or

workgroup; results are displayed in list form and are summarized in a bar chart.

e Case Summary: Groups and totals cases by category, manager, supervisor, status, or workgroup;

results are displayed as brief case summaries.

. Case Totals: Groups and totals cases by category, manager, supervisor, status, or workgroup; results

are displayed in list form and are summarized in a bar chart.
) Incident Assignment By Person: Lists all incident-related assignments, along with key assignment
details, such as the particular incident in which the assignment was created, the user who created the

assignment, and the user who was given the assignment.

e Incident Losses: Groups and totals incident loss values by business unit, class, organizational rollup,
site, or workgroup; results are displayed in list form and are summarized in a bar chart.
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e Incident Summary: Groups and totals incidents by business unit, class, site, status, or workgroup;
results are displayed as brief incident summaries.

o Incident Totals: Groups and totals incidents by business unit, class, disposition, organizational
rollup, owner workgroup, or site; results are displayed in list form and are summarized in a bar chart.

Lookups

o Business Unit Hierarchy: Lists all combinations of lookup list values for the four-tier business unit
rollup.

. Class Hierarchy: Lists all combinations of lookup list values for the four-tier class rollup.

e Lookup List: Lists all System English values for the selected lookup list, as well as their alternative
labels in other languages.

o Organization Hierarchy: Lists all combinations of lookup list values for the four-tier organizational
rollup.

e  Site Hierarchy: Lists all combinations of lookup list values for the four-tier site rollup.

Summary Reports

) Officer Category By Time: Calculates the time officers spent on activities providing the number of

activities, the total and the average time, and the percentage of the total time per activity category.

. Officer Log Report: Lists the officer log status changes by officer, including such details as Call Sign,
Location, Status, Date/Time of the change, and Notes.

e Response Time By Site: Provides short activity processing summaries by activity category, including
activities’ Start Time, Arrive Time, End Time, and calculating the Response Time and the Total Time

per activity and per category.

) Frequency Distribution: Compares the total number of incidents that took place in two separate

time periods by year, quarter, month, weekday, and hour; results are summarized in bar charts.

. Case Classification: Groups and totals case loss values by category; results are summarized in
assorted bar and pie charts.
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e Incident Classification: Groups and totals incident loss values by class and category; results are

summarized in assorted bar and pie charts.

o Yearly/Quarterly/Monthly Summary: Provides descriptive statistics for the number of incidents

that took place during the time periods of years, quarters, and months; results are summarized in bar

charts.

Creating a Report

1. Select a report from the list in the Navigation pane.

2. The Parameters tab will open by default. Each report has a unique set of one or more parameters

that can be specified before running your report. As in all other Perspective forms, red parameter

fields are required and all others are optional.

Select a Language: Choose a label set or a language of your report (e.g., System English).

Select Group By: Choose the entity your report’s results will be grouped or organized by (e.g.,
Access Level, Role, Workgroups, Status, Class Rollup).

Select a Date Range: Set a date range(s) your report’s data will be drawn from. Some reports
may provide an option of selecting more than one date range for comparison.

Year/Quarter/Month (for the Frequency Distribution Report): Select the time period for which
you would like your report to display statistics.

Workgroups checkboxes: Select the workgroups you would like the report to generate statistics

from. Check All Workgroups to select all workgroups in the list.

Select a Business Type, Class Type, Lookup Type, Org Type, or Site Type: Specify the

particular lookup list or rollup for which you would like to view available options or values.

Select an Officer (only for Officer reports): Choose the officer for which you would like to see the
report data.

Select an Activity, Incident, Case, Item, Organization, Person, or Vehicle: Indicate the
particular entity your report will be based on (e.g., Incident record INC-2010-000124, Jane Doe's
Person record).
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e Select Series (only for Totals reports): Specify the entity that your report’s charts will be grouped
or organized by, next to the selected Group By field (i.e., Status, Disposition, Access Level, or

Workgroups).

e Select Net Loss Over/Under (only for the Yearly / Quarterly / Monthly Report): Specify the Net

Loss threshold value by which you would like to organize your report.

e Completed? (only for Assignment reports): Indicate whether you would like completed,

incomplete, or both completed and incomplete assignments to be included in your report.

e Include Locked? (only for the Role List report): Indicate whether or not you would like locked

roles to be included in your report.

=

<Administrator Orly>

_ ™ Report

Role List < inch S
Test Roport 1]/ Incident & Entity List = =
Ussr List :
Report Settings
Workgroup List 3 ~|0o X34 =
2 [7 <Detail Reports> Refresh | Preview PDF =
Incidsnt Bxscutive Summary QAINCO0086470
Activity Landscape Parameters Accidental/External Source/Nature/Floot Closed
Activiy Portrai
Cagew Select an Incidert QAINCD008646 (TCB824a) A
Incident Condensed Landscape Accidental/External Source Open
:nm:e: Condensed Portrat QATNCOD08646E
s
tom Accidents|/External Source/Nature/Flost Closed
Organization QAINCO0086463 (TC2318-123) [1N]
Person Accidental/External Source/Nature/Float Open
Vshice
Investigation QAINCO0086462
= [T <List> Accidental/External Source Closed
Case Assignment By Persan _
Case Losses QAINCD0086460
Case Summary Accidental/External Source/Nature/Floac Closed
Case Totals QAINCO0086459 A}
Incident Assignment By Person
Incident Losses Accidental/External Source/Nature Open
Incidsnt Summany QAINCOD0BE4SE
o an::m Totals Accidental Closed
Business Unit Hierarchy QAINCO0D0B6457 [1N]
Class Herarchy Accidental Open
Lookup List
Orgarizstion Hisrarchy QATNCOD086456
Site Hierarchy Criminal Closed
[T <Summary Reports> _
Officer Category By Time QAINCO0086454
Officer Log Report Accidental/External Source/Nature/Floac Closed
Responss Tims By Sits QAINCOD0BG453
Frsqusncy Distribution ¥ ‘ i
Case Classiication e -
Incident Classfication K4 17518 b M
ety Quartsry Mortrly Summany
5, View Deta... o Select €) Close
3. In addition to the Parameters tab, some Summary Reports have an option of filtering data that you

would like to include in your report. To further qualify your report results, select the Criteria tab.

a. Check the All Workgroups for Lookups and Rollups box to search across lookup lists and

rollup values for all workgroups.

b. In the Searchable Fields pane, select a form entity to display its available fields in the yellow

pane to the right.
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c. Highlight and right-click a field you would like to specify settings for, and select Search By to
add the field to your search criteria. The chosen field will automatically populate the Field Name
box in the search pane on the right half of the screen.

d. Select a field operator from the Opt lookup list (e.g., =, >).

e. Enter the comparative value in the Value field or select an option from the list by clicking on the
plus icon .

f.  Click Enter to add the field specification to your report search criteria.
Every time you add a new field specification to the search criteria, the pane on the left will
populate with a new symbol associated with the added criterion (e.g., A, B, C). The arrangement
of the symbols in the pane defines the relationships between the criteria, which are also
reflected in the Boolean logic statement outlined below. By default, every criterion added is in
the OR relationship with the previous and next.

g. To modify these relationships (and the logic statement), creating an internal hierarchy within the
criteria, select a symbol from the pane on the left and click the adjacent up or down arrows.
Criteria that appear in separate nodes are in the OR relationship to each other, while criteria that
appear in sub-nodes are in the AND relationship to the main criterion at the top of the node.

h. To modify your search criteria, select the criteria you want to modify, make changes in the Opt
and Value fields, and click Update. The changes will be applied to the criterion on both the level

of the criteria list and the Boolean logic statement.
i. Toremove a field from your search criteria list, select the field and click Remove.
4.  Click Preview in the Report Settings toolbar to generate the report.

5. For some reports, you will have to select parts of the report that you want to include in the report
from the Report Visibility window. This window contains checkboxes for all report sections
containing data. By default, all boxes will be checked. Uncheck the boxes for any sections you do not
want to appear in your report. Check the Download All Attachments? box if you want to download
the attachments included in the record for printing (this checkbox only appears if the report includes
attachments). Click OK.
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|*| Report Visibility

Sub-Report Visible
i Cover Page
Incident Detail
Investigation Details
Incident Controls
Incident Visibility
Incident Assignments

Select Al Deselect Al Download All Attachments? (V] oK Cancel

6. A Report Options window will open.
a. Click the Open icon to instantly view a printable PDF copy of the report.
b. Click the Send icon to send an email message with a PDF copy of the report attached.

c. Click the Save icon to save a PDF copy of the report to the location of your choice.

d. Click the Close icon to cancel the report.

(2]

Report Options
The Report is available for viewing.

What would you like to do with this report?

Open

]
\___/  Open this report with defautt viewer.

. Send
E; Send Report as Attachment

Save
H Save Report

Close
gg Take No Action With This Report

Created :Aug-20-2014 10:47 AM

7. To access the most recently generated report, click the Open Local button in the Report Settings
toolbar.

m © Resolver Inc. Confidential. Do not distribute. Page 204 of 350



Perspective User’s Guide Reports

Note: The Preview button should always be used to generate new reports with the most up-to-date
data available in Perspective. The Open Local button should only be used to quickly reference recently
run reports.
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Custom Reports

You have the ability to take queries that you've built in Analysis Expert and customize them into custom
reports. You define what information goes into the report and how it looks.
Note: You need user permissions to access Custom Reports.

User Interface

The interface of the Custom Reports component evolves into separate screens depending on how far
along you are in building your custom report — the initial custom reports window and the subsequent
reports designer window. The reports designer window of the Custom Reports component is where you
modify the appearance of your report, including changing the background, font colors and sizes, adding
logos, etc. The initial custom reports window is divided into the following sections:

1. Ribbon: Contains the buttons that perform adding and execution of custom reports.
Note: Right-click the listing pane to open a menu with the following options: Add, Edit, Share, Delete,
Clone, and Execute your custom report.

2.  Listing pane: Arranges custom reports that you create according to their access options (i.e., Shared
Custom Reports or Private Custom Reports) and Custom Report category. By default, all new Custom
Reports are Private Queries available only to the user who created them. In order to make a saved

Custom Report available to users across your organization, you must share it. Refer to the Share a

Custom Report chapter for more information on how to do this.

Custom Report Design Process

The following chapter involves working with Perspective’s Report Designer. To understand how to use the

Report Designer, please refer to the Report Designer section for details.

Create a Custom Report

1. Make sure the custom report category you want your created custom report to appear under is
highlighted (i.e., Private Queries, Shared Queries).

2. To start a new custom report, choose one of the following options:

e C(lick Add 3 on the Ribbon.
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e Right-click in the listing pane, and select Add from the drop-down menu that appears.
3. A Create New Custom Report dialog box will open.
4.  Enter a title for the custom report in the Report Name field.

Note: Use specific names for your custom reports, because if same-named reports are shared, the user
will only see the first query with that name.

5. Make sure the Report Category is correct. If you want to create a new Category, type it in this field.
6. Inthe Report Description text box, identify the type of custom report and/or its purpose.

Note: The Report Description field can be left blank. The Report Name and Report Category fields must
be filled in.

P Create new custom report.

Report Name
Incident Report

Report Category
Incidents|

Report Description

Please selecta query or queries for your report.
PRIVATE QUERIES

@ Miscellaneous Queries

Mame Type Description

g eesy ool oL .|
Mew Query Incident
New Query Vehicle

Design Cancel

7. Click Design.
8.  The new custom report entry will be added to the relevant record entry node. The Perspective

Report Designer window will open (refer to the Report Designer section for details on how to use
the Report Designer).
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Save a Custom Report

1. Complete the design of your custom report.
2. Store the custom report for access at a later date by doing one of the following actions:
e Click Save kil on the Ribbon.
e Click File, and from the drop-down menu that appears, click Save.
Edit a Custom Report
1. Make sure the custom report you want to edit is highlighted.
2. To open and begin editing the custom report, choose one of the following options:
e Click Edit & on the Ribbon.
e Right-click in the listing pane, and select Edit from the drop-down menu that appears.
3. The Custom Report dialog box will open.
e You can change the custom report Name, Category, and/or Description.

4.  Click the Edit button to open the custom report or the Cancel button if you have selected the wrong

report.
5. Make the appropriate changes in the Custom Report Designer.

6.  Store the custom report for access at a later date by clicking Save & on the Ribbon, or click File and

then Save from the drop-down menu that appears.

Clone a Custom Report

1. Make sure the custom report you want to clone is highlighted.

2. To clone the custom report, choose one of the following options:

e C(lick Clone % on the Ribbon.
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e Right-click in the listing pane, and select Clone from the drop-down menu that appears.

3. A prompt will appear, asking if you are sure you want to clone the custom report. Click the Yes
button to clone the report, or No to cancel the cloning process.

Note: If you do not have Manage rights, you will be unable to clone or edit a custom report.
Share a Custom Report
1. Make sure the custom report you want to share is highlighted.

2. To share the custom report, choose one of the following options:

e Click Share 3 on the Ribbon.

e Right-click in the listing pane, and select Share from the drop-down menu that appears.
3. The Share Custom Report dialog box will open.
4.  Click the Add User or the Add Role button.

5. Select the user you want to share the custom report with by typing his/her name and/or role in the
text field, or scrolling through all users and/or roles.

6.  Double-click the user's name and/or role to confirm your selection.

e Click the Allow Manage checkbox if you want the user or a particular role to have the ability to

edit, share, delete, or clone the shared custom report.
7. Click Save.

e Shared custom reports will have the kg Share icon displayed beside the title.

Delete a Custom Report

1. Make sure the custom report you want to delete is highlighted.

2. To delete the custom report, choose one of the following options:

e C(Click Delete 3 on the Ribbon.

m © Resolver Inc. Confidential. Do not distribute. Page 209 of 350



Perspective User’s Guide Custom Reports

e Right-click in the listing pane, and select Delete from the drop-down menu that appears.

3. A prompt will appear, asking if you are sure you want to delete the custom report. Click the Yes
button to delete the report, or No to cancel the deletion process.

Note: A custom report that has been shared to you by another user cannot be deleted.

Execute a Custom Report

1. Once your custom report is created, you may either run it immediately, or save it for further use, and
then run it. To run a saved custom report, select the name of the report you want to run from the
custom reports list in the listing pane.

2. To execute the query, choose one of the following options:

e Click Execute 3 on the Ribbon.

e While in the Report Designer, click File, Export and from the menu that appears, select the file
type you want the report to be run in.

Report Designer

In the Report Designer, you have all your query data at your disposal and can prepare it for printing in

different ways.

Getting Started

Insert a Company Logo into the Report

For the company logo, please use the sunshine.gif file, which you will find in the directory for the Sample

Application. We also need a Picture object. Proceed as follows:

1. Click Insert > Picture (Objects > Insert > Picture).

Start Insert Project 0
T \N O O |[bd|m [ d © e &
ALT

Text Line Rectangle Ellipse Picture Barcode  Formatte Form Co Form Te.. Data Gra.. Gauge HTA
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Note: Objects are your project's building blocks. They are generated in the workspace where they are
also given a border with which their size and position can be changed. This border defines the space
that the object takes up and thus also the maximum size to which the contents of the respective object
can be expanded. Objects may overlap fully or partly.

2. Inthe workspace, point the mouse to the position where the upper left corner of the object is to
begin. The mouse cursor changes to a crosshair. Hold down the left mouse button and drag the
crosshair to the lower right corner of the planned object. Release the mouse button when the object
(the dashed border) is the right size.

Note: Objects can be added to the workspace in different ways: via the menu Objects > Insert, via the
toolbar or via keyboard shortcuts, or with Drag and Drop from the list of variables.

3. Select if the picture is loaded from a file or if the content is defined by a formula/variable.

Note: This dialog is not available in Windows XP, the file selection dialog will appear directly.

Picture source selection n

How should the picture content be determined?

A picture can be created from various contents. Choose from the following selection.

< File
Load a picture from a file. Optionally, the file can also be embedded into the project.

< Formula
Choose a formula for the picture contents. The formula result can be e.g. the picture file
name,

Cancel

4.  If you select File, a file selection dialog will appear. Select the image file.

Note: The following formats are available: LL, BMP, DOCX, HTML, JPG, PDF, PNG, RTF, SVG, TXT, TIFF,
XLS, XLSX, XML, and XPX. As a general rule, you should use the RGB color space (not CYMK).
Transparency in PNG files is supported by using the corresponding Windows functions. In our
experience the majority of printer drivers do not support transparency so that reports with e.g., partly
transparent PNG files should thoroughly be tested on the actual hard-software combination. If that is
not possible we recommend doing without the alpha channel.

Insert the picture into the project by enabling the Embed image in project file checkbox option.
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fEirlle:secl image in preject Cancel

5. After you select the file, select the Embed image in project file checkbox, and click Open, the logo
will be inserted into your report.

M HeZ- Designer - - o

“ Start | Inset  Project ~ 9
T \ O O E m # B o od © @ @ &

Text Line Rectangle Ellipse Picture Barcode Formatte.. Form Co
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) Project =
% [Picture] E [-oe
EE |
3 fe
Q=
~T
Q=
Q-
Report Structure Objects Layers =
Properties x =
& 4 8 "
4 (o 3
Locked False [No] 2 =
Name <
4 Dat e
(Contents) ==
4 Data Source File Name g
File Name C:\Progra...\combit-logo.gif =
Formula =
4 Variable =
Q=
Properties o=
Save as JPEG False [No] =
Include in Project False [No] 'e__:
4 Original Size False [No] =
Keep Proportions True [Yes] 3
v Q-
F T——— . n 7S 4 =
Design 3
7 Layout [# Layout Preview | &3 Previev
4,981, 11.796 Select Picture - 6.159in, 0.331in - 7.916in, 1.260in = 1.757in, 0.929in (Base) 100% S +

Add a Title to the Report

Use a text object to add a title to the report. Text objects let you place text in the workspace. As well as
fixed text, you can also insert the contents of fields (variables) from the database (e.g., company name), or
you can use functions (page number, date, etc.).

1. Click Insert > Text (Objects > Insert > Text).
Start Insert Project ~ e

T \ 0O OC E m &I B dl ® @ @A &

Text Line Rectangle Ellipse Picture Barcode  Formatte. Form Co.. FormTe.. R C Data Gra... Gauge HTML Text PDF OLE Cont...

© Resolver Inc. Confidential. Do not distribute. Page 212 of 350



Perspective User’s Guide Custom Reports

2. Inthe workspace, hold down the left mouse button and pull the object to the required size. Text
objects should always be created in the maximum size you want, the object shrinks at print time to
the required size.

3. The formula wizard will now appear which you can use to define the contents of the text object.
This dialog consists of a series of tabs each containing different elements to be edited. The following
chapters explain the meanings of these elements in more detail.
¢ Data and Functions: the available variables, fields, and functions.

e Condition: for defining IF-THEN-ELSE conditions.
e Text: for entering fixed text and tabs.

e Date Format: different date formats.

¢ Number Format: different number formats.

e Operators: available conjunction operators.

You can also enter the expression that you want directly in the edit box or modify the text that is
there (e.g., put something in brackets).

Therefore, enter our title Products directly. Fixed text must be enclosed in quotation marks. Enter

names of data and functions without brackets.
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5] Edit Text n

Data and Functions | Condition | Text | Date Format = Number Format | Operators

Products]
Linefeed Tab ';"r:lﬂ;r.
Edit free text
Insert
"Products” -
2
=
< N ¥
o Products
( |
A oK Cancel

Note: Please note that there are two ways of writing expressions, depending on their use. You will find
more information about this in the chapter Variables, Fields and Expressions.

4.  The title will be displayed when you close the dialog with OK.
5. Use the tab Texttools > Text (mini-toolbar) to enlarge the font size.

6. You have now added the title:
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T ™ Text Toals Designer - -
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Insert the Table for the Product List

Use the Report Container object to add a table to the report. As the name says, a report container can
hold several objects: tables, charts and crosstabs can be added in any order.

Note: The report container is not available in all applications. In applications that don't have the report
container, use the Table object.

1. Click Insert > Report Container (Objects > Insert > Report Container).

File Start | Inset  Project ~ 0
= = | [ [=: \ o
T \ O O W m & = D @ M B
Text Line Rectangle Ellipse Picture Barcode Formatte... Fon Form Te... | Report C... | Data Gra... Gauge HTML Text PDF OLE Cont... =

2. Inthe workspace, hold down the left mouse button and pull the object to the required size.

3. Aselection dialog will appear for the chosen element type. Choose the Table element type.
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Choose Element Type n

Which element would you like to insert into the report container?

The report container can hold any number of elements. The following element types are available.

% Table
Atable displays data in a list (e.g. address list). The selection of ‘free content’ as a data source
enables descriptive texts and captions.

< Crosstab

A crosstab collects data in two dimensions (e.g. turnover per region and quarter).

< Chart
A chart displays data graphically (e.g. pie chart, bar chart, map...).

< Gantt Chart
A Gantt chart shows the chronological progress of task data graphically.

Cancel

4. Now supply the data source in the following dialog. All available tables are shown hierarchically; in
other words, under the tables, you will find the relational tables in each case.

S5 Choose Source Table Path “

Please choose the source table here:

.. Free content A
» - Categories
- Category Sales for 1995
ClimateData
- Current Product List
> - Customers
> Employees
- Invoices
.. Order Details
- Order Details Extended
- Order Subtotals
5> - Orders
- Pollen
- Product Sales for 1995
> | Products
- Products Above Average Price
> . Project h

©

1

Select the Products table because it contains the fields that we want for our product list.
5. A selection wizard will appear with all the fields in the Products table. In addition, underneath the

Products table, you will also find the fields in the tables Categories and Suppliers which have a
1:1.relationship with Products.
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sy Data Selection Wizard

Line name:

others.

As multiple lines of the same type can be used, you should choose an appropnate description to be able to distinguish the line better from

Variables or fields that can be inserted: Columns:

v

> 4d) Categories (Products.CategorylD+—Categories.C
T Suppliers (Products.SupplierD—Suppliers.5upp
.[# CategorylD
i |v] Discontinued
! #) ProductlD
[A] ProductName
(Al QuantityPerUnit
# ReorderlLevel
[# SupplierlD
[# UnitPrice
i[# UnitsinStock

] [ UnitsOnOrder

-{f¥) Uservariables v
< >

Products.PreductName

Products.CategorylD@Categories,CategorylD:CategoryName
4] Products ~ Products.UnitPrice

Please choose the fields to be printed in this line. Properties can be set afterwards.

@

oK Cancel

In this dialog, now choose the columns for the table. Double-click a field, e.g., ProductName. The

field will be added to the Columns area.

6. Repeat this step for all fields that are to be shown in the table; i.e., also the CategoryName field

from the linked table Categories and the UnitPrice field for the unit price. Confirm your selection by

clicking OK.

7. The table will now be displayed in the workspace.

The selected fields are displayed in the data line, in other words, the data line contains the data.

e In addition, a header line is automatically produced. Header lines are used mostly as column

titles, i.e., the selected field names are now shown here as text.

e If you pull the report container widthwise to make it wider or narrower while holding down the

CTRL key, the columns will be adjusted proportionally to fit.

e The width of the columns adjusts automatically. You can adjust the width of a column manually

by moving the separating line to the right or the left with the mouse.

Note: This changes all table columns, whose separators are within +/-2 mm from the mouse position. If

you hold down the CTRL key, the action will only be carried out for the line on which the mouse is
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positioned. If the Column width modification affects next column option is enabled (File > Options >

Workspace), you can alter the column width while making the next column smaller.

W HeZ- Table Tools Designer - - B9
Start nsert Project Table ~ @
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bjec) T b s el Tue e b fbeod i o ue s s b g
[ Project °=
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= m c:
Q=
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> Left =
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v a3 B ia
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Design =
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£ Layout [ Layout Preview | 3 Previe
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.
Format Table Fields

Only a few basic formatting options are explained here.

1. In the product category column title, the field name CategoryName is shown. Click the respective

field in order to change this text to Category. The formula wizard will now appear, which you can use

to change the contents of the field. Text must be enclosed in quotation marks.
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™ Edit Table [ x |

Data and Functions | Condition | Text | Date Format | Number Format | Operators

¥ | Functions: &=
I3) Vanables "
{ED Fields L
[# Abs {Number}) "
[ AddDays ({Date},{Number})
) AddHours ({Date],{Number})
) AddMinutes ({Date},{Number))
I:E AddMonths ({Date},{Number})
E‘ AddSeconds ({Date},{Number})
) AddWeeks ({Date},{Number}) v
Insert
"Category” -
P33 m
=
s )

6 Category
| ]

—
2 =

oK Cancel

In addition, we want to format the unit price as currency and align the entire column to the right.
You will find both formatting options in the tab Table Tools > Table (mini-toolbar). Click in the
upper left corner to select the field containing the unit price.

Cakgory UnitPrice
Bewerages b H)

3. Click the button % Format for the formatting dialog

A selection dialog will now appear in which you can select the formatting that you want for the
numeric field. To do this, choose the type on the left hand side i.e., Currency. In the right pane, you
can specify the currency formatting in detail. The settings for the relevant application will be used in

each case as standard. Alternatively, you can choose the system setting or a user defined setting.
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= Format
No Format Decimal places: Applicati etti W
Number & p d pplication setting
Currency Decimal point: Application setting v
Date
Time Thousands separator: Application setting v
Date and Time
Date-/Time Difference | Currency symbol $ s
Percentage ¢ f o | Aoplicats .
: v
Angle ormat for positive values: pplication setting
Format for pegative values: Application setting v
Exponential format: No v
[] No output if value is 0
[w] Always 0 before decimal point
[ ] Optimized decimal places
Preview

-§12,345.67

@ oK Cancel

5. Finally, select both fields (the header and the data line) to align them to the right. To do this, hold
down the CTRL key and select both fields by clicking in the upper left corner in each case. Then click

the button for right alignment.

=3

Caiegory
Bewerages

Display a Preview of the Report

Until now, you have only seen the report in layout view as a structure with a record. To get an impression
of the result, you can display a preview of the report. Use the tabs in the bottom margin of the workspace

to change to the preview.

Note: Real data preview mode is not supported by all applications.

[ Layout & Layout Preview Preview

The report will now be displayed with the data from the Products table. You can also change the number

of products or data records in the Sample Application.

1. To do this, save the report with File > Save.

2. End the Designer with File > Close.
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3. Inthe Sample Application, choose Options > Settings, and increase the maximum number of root
records to 50.
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4.

T

Open the print template that you created again via Design > Extended Samples, and switch to
preview mode. Your report will look roughly like this:

HeZ - Designer - C\Program Files (x86)\combit\Sample Application\Report.srt CE]

0f

) projet]

L& [Picture]

bjects

A [Te

i = [Report Container]

Properties
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4
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Project Description List & Label Project File
Active Design Layout

: § i x N
‘ Page: 1 q ) i‘,(z:mm\n ; 3 Export <] g Finc )
Pre File | % £ Zoom Out &F — —
Select Page Quick [ Maten Case Limit  Close Print
Area width &' Presentation = print~ =] E-mail Pages~  Preview

] Products comot X

Condiments

Objects

alx

Number of Issues 1

Embed Drilldown Reports False [No]
Minimum Page Count 1

Design Scheme . Summer Day
Transition Effect for Slideshow M... i

General Settings

11367, 1

1754 Select -nothing selected- 100% S +

Add a Page Number

It's a good idea to add a page number in the lower area of the page. To do this, add a new text object.
You will be using functions (such as the page number function) as well as fixed text with this object.

Choose Insert > Text (Objects > Insert > Text).

= | - o)
T \ 0O O HE W L B i © e M ®
Text Line Rectangle Ellipse Picture Barcode Formatte. Form Co. Form Te. Data Gra.. Gauge HTML Text PDF OLE Cont...

In the workspace, hold down the left mouse button and pull the object to the required size.

The formula wizard will now appear which you can use to define the contents of the text object. The
available functions are shown in the right pane. You can use an auto filter with this list. Type page in
the filter field. This will cause all functions containing the expression page to be displayed.

e The Page$ () function returns the page number.

e The TotalPage$ () function returns the total number of pages.
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Add the Page$ () function to the result area by double-clicking.

4.  If you now want to output a footer in the form of Page 1 of 2, you can enter the text of directly in
the usual way. Please consider that individual parts must be joined with a + and that text must be

enclosed in quotation marks.

5. Now add the TotalPages$ () function by double-clicking to get the total number pages. The formula

will look like this:

= Edit Text

Data and Functions | Condition | Text | Date Format | Number Format | Operators

» 452) Vanables
> Al Project variables

Current page as string.

"Page " + Page$() + " of " + TotalPages$()

<

o Page 1 of =0=
[ |

¥ Functions: Be:
page v
¥ Lastpage ()
#] Page ([{Number}])
Al Pages$ ([{Number}])
Al TotalPagesS$ ([{Number}])
Insert
= ()
3] m
=
5 9
0K Cancel

@] L=~

6.  You can center this line in the report in the usual way:

Start Insert Project Text
ﬁ £ Assignto Layer ~ [ ) “l[izet | & & 7? ﬁ

Border v |
Content y A~ Append Insert |
X Delete BIUS A-A

Iy
]
]
[T}

7. Switch to preview mode to view the result:
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General Procedures

Choose a Page Layout

The first task in a new project is to set up the page layout that you want. Click Project > Layout Regions
(Project > Page Layout) to specify properties such the choice of printer, paper size, and orientation.

If multiple layout areas are defined, the active workspace can be selected via the Active Design Layout
project property.

Zoom

It is possible to zoom in on the workspace. Use Zoom In, Zoom Out, and 100% to adjust the view in the
workspace. Use the Zoom slider in the status bar to slide to the zoom percentage you requires (50% -
500%).

Use Select Area to select the view area with the left mouse button. Click Start> Select Area (objects
toolbar > Select).
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Status Line

The status line is divided in three sections.

e The current mouse position from upper left.

e The active operation (e.g., selection).

e Name, position upper left, position lower right, width, height, and layer of the selected object.
e Zoom slider for Workspace and Preview.

5.635, 14339 Select Text - 0.725in, L62%in - 3.520in, 2.70%9in = 2.795in, L0&0in (Base)

Ribbon

The Ribbon contains command buttons on different tabs. The commands are arranged according to how
often they are used. Frequently used commands are available prominently; less frequently used
commands are located on less prominently.

Note: Alternatively, you can work with a classic menu and toolbars. Select the type of display in the project
options (Project> Options> Workspace).

m Start  Inset  Project (2]
T \ O O W m H B i © e A &

Text Line Rectangle Ellipse Picture Barcode  Formatte Form Co. Form Te Data Gra.

Some other commands are displayed only when you might need them, in response to an action.

Text Tools

If you insert a text object, the Text Tools and the tab Text are displayed. The tab contains the commands
you need for working with text objects. When you have finished the work on the text object, the Text

Tools are hidden.

“ Start  Insert Project Text (2]
y &% Assign to Layer v a > 1
/"ﬁ] on to Lay Arial v12pt v/ A" A :? E?I ] j s
== [I5 Border ~ = =4 ==
Content Y. A~ =|=|= = Append Insert t Forward Back ___
X Delete BIUS A-A F[ES X Delete v ~  EEPosition

With the Text Tools you can append/insert a paragraph, move paragraphs upwards/downwards, apply

fonts, font sizes, text colors and formatting as well as arrange objects.
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e To select a complete paragraph, click onto the bar on the left. Hold CTRL or SHIFT to select multiple

paragraphs or a complete range.
Table Tools

If you insert a table, the Table Tools and the tab Table are displayed. The tab contains the commands you
need for working with table objects. When you have finished the work on the text object, the Table Tools

are hidden.
Start Insert Project Table - 0
Y & Assign to Layer v : a v X - 4 >4 % Format L I g
o Calibri v([12pt ~ SEN e =
ﬂ Tl PLTIA A o BB & Move Left o 0
Content y A~ =|=|= == Delete Insert Insert Insert Insert Border Forward Back _‘
Y Filter BIluUSs A-A EE=EE=S Below~ Above~ Leftv Rightv ~ & Move Right - - £E Position

With the Table Tools you can define a new line, insert a new row, move selected rows/cells to the
left/right, borders, apply fonts, font sizes, text colors, and formatting, as well as arrange objects.

e To select a field, click in the top left corner of the field. Hold CTRL or SHIFT to select multiple fields or

a complete range.

e To select a complete ling, click onto the bar on the left. Hold CTRL or SHIFT to select multiple

paragraphs or a complete range.

[ 3 orser Order dete Shipdate Wieight Ordertic

ivieon wayaIms ISy i3z

. e - b =

e To select a complete column, hold ALT. Hold CTRL or SHIFT to select multiple columns or a complete

range.
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Compsny

AlfrcSs fulcrkais 12205 Bcdw

Drawing Tools

If you insert a drawing object, the Drawing Tools and the tab Design are displayed. The tab contains the
commands you need for working with drawing objects (e.g., Outline color, Lineweight).

“ Start Insert Project Design

J _ 15, Aligr
l J— v ﬁil *_hl TIII . rouD
Qutline Lineweight F Fill Forward Back

Color~ . Color = Effect »  ZE Position

Minimize the Ribbon
The ribbon can be minimized in order to save screen space.
e Right-click the ribbon, and then click Minimize the Ribbon.

e To quickly minimize the ribbon, double-click the name of the active tab. Double-click a tab again to
restore the ribbon.

e To minimize or restore the ribbon via Keyboard shortcut press CTRL+F1.

To use the ribbon while it is minimized, click the tab you want to use, and then click the option or
command you want to use.

File Menu

The File menu contains commands for saving, printing, exporting the project, and the project options.

MU HeZ - | Designer

“ Start Insert Project
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Quick Access Toolbar

The Quick Access Toolbar is a customizable toolbar that contains a set of commands that are independent
of the tab on the ribbon that is currently displayed. You can move the Quick Access Toolbar from one of
the two possible locations, and you can add buttons that represent commands to the Quick Access
Toolbar.

On the ribbon, click the appropriate tab or group to display the command that you want to add to the
Quick Access Toolbar. Right-click the command, and then click Add to Quick Access Toolbar on the
shortcut menu. In order to delete a command, right-click the command you want to remove from the
Quick Access Toolbar, and then click Remove from Quick Access Toolbar on the shortcut menu.

Mini-toolbar

When you select a text object or a table object, a convenient toolbar in miniature format is displayed, the
mini-toolbar.

Note: The Mini toolbar is especially useful if you use the classic menu and toolbars instead of the ribbon. You
can select the type of display in the project options (Project> Options> Workspace). When using the ribbon,
the functions of the mini-toolbar will be displayed in the tabs Text Tools and Table Tools.

e With the mini-toolbar you can add a text paragraph, define a new table line, insert a new table row,
apply fonts, font sizes, orientations, text colors and formatting as well as open the object dialog.

e You can close the mini-toolbar by pressing ESC. With the project option Show mini-toolbar (File >

Options > Workspace) it can be suppressed permanently.

72201
4711081

Default Settings for Font and Frame

Click File > Options > Objects.

m © Resolver Inc. Confidential. Do not distribute. Page 228 of 350



Perspective User’s Guide Custom Reports

The Select button under Object font lets you choose the default font to be used for objects. Under Color
preferences, you can specify the border and the filling for objects.

New objects will be created according to these settings. However, you can change the settings later
individually for each object.

When you start a new project, it's a good idea to configure these settings using suitable values to keep
the effort required for making manual changes to a minimum. The settings only apply for the current
project.

The Default parameter in the respective object properties (Font/Frame/Background) is active as standard
for all objects. Therefore, if the default values are changed later, this will also affect all objects whose font
has not been changed manually.

Create a Professional Table

In this chapter, we will extend the previous examples to include more functions, output grouped data, use
appearance conditions and layers to allow multiple pages to be output and add more elements to the

report container.
Use Advanced Features with the Report Structure

You use the Report Container object to add a table. As the name says, a report container can hold several
objects.

Tables, charts, crosstabs and Gantt charts can be added in any order, even as sub-elements of tables. This

lets you define sub-reports with almost any relationships between tables.

However, only one report container is permitted and you cannot define any separate tables, charts,
crosstabs or Gantt charts.

You define new elements in the Report Structure tool window along with the hierarchical structure that
you want. All elements and respective sub-elements of a report structure are shown here, with object type

and data source [relation name, sort name], in the order in which they will later be printed (sequence

plan).

The currently selected item will be highlighted in the workspace. By using the checkboxes in the tool

window Report Structure, you can toggle the visibility of elements, sub elements and branches.
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Report Structure x
ER R R
4|l Report Container

a [V]E| Table: Customers [CustomerlD [+]]

| Table: Orders [Customers2QOrders]
i..[¥|Z Table: Order Details [Orders2Order Details)

Report Structure Objects Layers

All actions are available in a context menu. There are additional buttons in the top toolbar for the
frequently used actions.

To add a new element to the report container, select the Append an element or the Append a sub-
element button. Sub-elements are only possible with tables.

Only one element is displayed at any time in the workspace. This means that with the Report Structure
toolbar, you select the element that you want to be displayed in the workspace.

Practice: Define the Report Structure Correctly

Let's assume that you want to produce a list of all customers, showing the orders of the respective
customers and all order items.

You want the result to look roughly like this:
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Order Overview

Customer orders

Compamy Address Cuest omierNo
Atrads Atteriste Obars 3r. 57, 1209 Barbn HLUFEL
Order Order date Ship date Weight OrderNo
25092012 E.10.301Z DAL g 10s2z
Pos ltem No O wantity Product name Pricein€
1 5 15 Che Saueriraut 45,80
z 25 r 4| Chartmuss veri 1200
Totad a3a0
E Order Order date Ship date Weight OrderNo
02113012 21123012 iy - 10esz
Pos ltemNo O santity Product name Price in €
1 a3 20 Vagasonaad 43
Totad 4330
Totad of orders
Compa vy Address Cust omerNo
Arg Trulo Emparadadosy halados  Avds. dels Corstbusdn 2227 05021 Maaon DUF. AMETR
Order Order date Ship date Weight OrderNo
19103011 25103011 15 kg 10308
Pox ltem No 0 santity Product name Price in €
1 53 1 Gudb mndsdatsost 25,50
Z 0 s Outhack Loger 1200
Totad 40,20
E Order Order date Ship date Weight OrderNo
Q20920132 K001z 4330 wg 10525
Po= ltem No 0 s=ntity Product name Price in €
1 < 3 Tatu 235
z iz ) Sngporsan Howoen Frsd Mas: 14.00
Totad TS

Total of orders

Totad of 2l cusio mers
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To achieve this, proceed as follows:

4.

Click Insert > Report Container (Objects > Insert > Report Container).

“ Start | Insert  Project ~ 9
T \ O O E m [ = d © e @ &

Text Line Rectangle  Ellipse Picture Barcode Formatte.. Form Co.. FormTe.. |ReportC... | DataGra.. Gauge  HTMLText PDF  OLE Cont..

In the workspace, hold down the left mouse button and pull the object to the required size.

A selection dialog will appear for the chosen element type. Choose the Table element type.

Choose Element Type “
Which element would you like to insert into the report container?

The report container can held any number of elements. The following element types are available.

2 Table

Atable displays data in a list (e.q. address list). The selection of 'free content’ as a data source
enables descriptive texts and captions,

2 Crosstab

A crosstab collects data in two dimensions (e.g. turnover per region and quarter).

2 Chart
A chart displays data graphically (e.g. pie chart, bar chart, map...).

2 Gantt Chart
A Gantt chart shows the chronological progress of task data graphically.

Cancel

You specify the data source in the following dialog. All available tables are shown hierarchically, in
other words, under the tables, you will find the relational tables in each case.

(=) Choose Source Table Path

Please choose the source table here:

Free content
4 - Customers (Base table)
a - Orders [Customers20rders]
| Order Details [Orders2Ordler Details] |

Z oK Cancel
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For the list of invoices, you need the following structure: Customers > Orders > Order_Details.
You have two alternative procedures at this point:

a. You select the Customers table to first create the top table. This corresponds to a top-down
procedure; meaning that you then add the Orders sub-table followed by the Order details sub-
table by means of the Report Structure tool window.

b. Oryou choose the structure that you want right from the start by selecting the lowest table. This
corresponds to a bottom-up procedure, meaning that you create all three tables starting by
designing the lowest table.

5. You will be using the second method in this example. Accordingly, you select the table Customers >
Orders > Order_Details.

6. A selection wizard will appear with all the fields in the Order_Details table.
= Data Selection Wizard ﬂ

Line name:

As multiple lines of the same type can be used, you should choose an appropriate description to be able to distinguish the line better from
others,

Variables or fields that can be inserted: Columns:

Order_Details.ProductID
- Order_Details.Quantity
4 (& Fields " Order_Details.ProductiD@Preducts.ProductD:ProductName
) Customers Order_Details,UnitPrice
4 4 Order_Details
@D Orders (Order_Details.OrderlD+~Orders.OrderlD
» 45 Products (Order_Details.ProductiD—~Products.P
[#) Discount
[#) OrderlD
[# ProductiD
[# Quantity
i [# UnitPrice
b {2) Orders
|£%) User variables
IZ) Sum variables

< >

Please choose the fields to be printed in this line. Properties can be set afterwards.

@ I OK Cancel

In this dialog, now choose the columns for this sub-table. For example, double-click the ProductID,
Quantity, UnitPrice and ProductName fields from the Products table which has a 1:1 relationship.

This will add the fields to the Columns area. You can change the order with the arrow button.
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7. All tables will now be displayed in the workspace, the currently selected item Order_Details will be
highlighted in the workspace.

e The selected fields are displayed in the data line, in other words, the data line contains the data.

e In addition, a header line is automatically produced. Header lines are used mostly as column
titles, i.e., the selected field names are now shown here as text.

e The width of the columns adjusts automatically. You can adjust the width of a column manually
by moving the separating line to the right or the left with the mouse.

Note: This changes all table columns whose separators are within +/-2 mm from the mouse position. If
you hold down the CTRL key, the action will only be carried out for the line on which the mouse is
positioned. The Column width modification affects next column option lets you alter the column width

while making the next column smaller.

8.  To define the columns of the Orders table, double-click the table in the Report Structure tool
window.

Modify Fields and Columns

There are two possibilities for adding additional columns to tables or for editing and formatting them in
detail.

Table Tools and Mini-toolbar
If you insert a table, the Table Tools and the tab Table are displayed. The tab contains the commands you
need for working with table objects. When you have finished the work on the text object, the Table Tools

are hidden.

Optionally, you can activate a mini-toolbar for the tabel-objects (File > Options > Workspace).

“ Start Insert Project Table 0
il = Assign to Layer ~ . A x & ¥ ¥ % Format
‘“‘fﬂ = Calibr v ||12pt ~ o e
| it B Aa It 1T J—‘ UH n t‘ - ,] i
Content _ s A~ = = = Delete Insert Insert Insert Insert Border Forward Back _
T Filter BIUS 4-AEE=E Below~ Above~ Left~ Rightv =~ @ Move Right v  EEPosition

With the Table Tools you can define a new ling, insert a new row, move selected rows/cells to the

left/right, borders, apply fonts, font sizes, text colors and formatting as well as arrange objects.
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e To select a field, click in the top left corner of the field. Hold CTRL or SHIFT to select multiple fields or
a complete range.

e To select a complete ling, click onto the bar on the left. Hold CTRL or SHIFT to select multiple
paragraphs or a complete range.

e To select a complete column, hold ALT. Hold CTRL or SHIFT to select multiple columns or a complete
range.

Object Dialog

Use the object dialog for more advanced functionalities. You open this dialog via the corresponding

button in the mini-toolbar or by double-clicking the element in the report structure.
Marker when at least one

Linetypes line definition exists Line or column properties
iy able Contents - [tem ﬂ
5 ¥ Header Line v Data Line v FooterLine Group Header Group Fopter
Edit columns
and line definitions ———— & » & X & 1 * Br 4] e @
. (Contents) Sum(ltem.UnitPrice * ... A
40 Total Options
Line definitions %\ Tetal” : MEackground Pattern/Block Color
[l_ Sum(item.UnitPrice * ltem.Quantity, False) Pattern ] -
- ‘:;AT Color LL.Scheme.Back... I
(A “included 19% VAT Mid ‘.TEIU ILJ:[:‘
Column content —__[#) Sum{item.UnitPrice * Item.Quantity * (1- 1/ 1. o Sl
4 ) Subtotal e
@l - Picture File Name
Al “Sub total® Export as Picture Ne
[# Sumiitem.UnitPrice * Item.Quantity, True) Font
Format Nene
Rotation 0*
Ted Format Normal Text
4 Action
Link URI ¥
< > Background
1 | |Background.
CIN I My oK Cancel
Fade out dialog Edit dialog layout by mouse

There is a tab for each type of line where you can specify the different definitions and columns for the
respective line. The following types of line are available: header line, data line, footer line, group header,

group footer. A checkmark on the tab indicates that a line type has one or more line definitions.

e Header lines are mostly used as titles for the columns of the table.
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e Data lines contain the formatting for the actual table rows and the data that is to be shown in the
table.

e Footer lines are displayed at the very end of the table and can hold final information about the data
lines that are output above.

e Group header and footer lines are used to structure the data lines by means of Intermediate
headings and Intermediate footers.

All line types can be defined independently of one another.

e This means that the columns of a header line can have a different appearance as the data lines or
footers that follow.

e You can also create different line layouts or line definitions for the individual line types. It is then
possible to activate the different line definitions with special appearance conditions as required.

Variables-/Field-List, and Drag and Drop

The Variables-/Field-List (Project > Variables/Fields) shows all available variables and fields of the current
project. To add more columns to existing rows you can simply drag the desired fields from the list onto
the corresponding position with the mouse (drag and drop). The field can be inserted to the left or right
of the corresponding column, a symbol shows the insert position. The column (standard width 30mm) will

be inserted in the corresponding row. Please note that columns could be created in the non-visible area.
Define Multiple Line Layouts

You can define different layouts for each type of line. Depending on the appearance conditions, the
appropriate layout is used in each case according to the situation. For example, you can output two table
lines for each data record in this way:
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ItemNo Description Pricein €

EXPSAOL Southern Africa Explorer: 20-day tour from Cape Town to Victoria 1500.00
Falls excluding flight

Safart: Travel through the Okavango Delta in dug-out

- e
‘ '-?“ canoes, climb sand dunes in Namibla, visit Etosha

1 { National Park, Victoria Falls.

EXPCHO1 MNorthern & Southern Chile: 23-day tour from Santiago to Punta 3500.00
Arenas includ ing flight

Travel from the Atacama desert in Northem Chile, the
metropolis of Santlago, across the lakes and volcanoes
region to the Strait of Magelan and the huge Torres del
Paine Natlonal Park. Patagonla: Carretera Austral
[Southem Highway) with spectacular natural scenery,
visit the second largest |ake In South America, marble

caves.

Proceed as follows to create table lines in the object dialog.
1. First select the line type that you want to edit by clicking the relevant tab, e.g., Data Line.

2. Now choose Insert Table Line in the context menu. Alternatively, you can select an existing Line
definition and then click the New (Append line definition) button.

3. Inthe Choose a Table Line Definition dialog that follows, you have the option of:

e using an already existing layout as a template for the new line definition (very useful if the layout

is similar).

e starting the data selection wizard (very useful if you want to create several columns in one
operation)

e or creating an empty line definition so that you can then add the columns by means of the
object dialog.
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(] Choose a Table Line Definition “

The row you are trying to edit is empty. Please choose whether you want to use the
definition of another row or start the data selection wizard.

| ) Single field or free content
¥ Start data selection wizard
% Choose existing line definition
) Header Line
= Customer_Fields
< Customer_Data
) Footer Line
= Customer_Footer_Total
) Group Footer
= Customer_Footer_Total

@ | 0K ‘ Cancel

4. You have now created the new line. Edit the columns as described in Defining Column Contents.
Change the order of the line with the arrow button or with Drag & Drop.

5. You can then specify the appearance of the new line as a whole. Various properties are available for
this including:

e Appearance Condition with which you can specify when the line is to be printed. This is useful if

you define multiple line layouts that are to be printed depending on certain values. The familiar

dialog for defining logical expressions opens up here.

Example line 1. Subtotal not on last page

Appearance condition: not Lastpage()

Example line 2: Grand total only on last page

Appearance condition: Grand total only on last page
¢ Name of the line e.g., data first line. This makes it easier to find the line in complex layouts.

e Display in Designer: with this property, you can hide the lines in the workspace - this is very
useful if you have a lot of line definitions.
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e Spacing (margins): here you define the top, bottom, right and left spacing of the line. The top or
bottom values cause a corresponding space between the individual table rows. With the left and
right spacing values, you can specify the margin in relation to the table object, i.e., you can
indent lines or columns.

e The Default Font property sets the font for the entire table row. Newly inserted columns appear
initially in this font.

e Outline Level (index level) of the bookmark in preview mode or for PDF export.

[ Table Contents - ltem ﬂ
¥ Header Line v Data Line ¥  FooterLine Group Header Group Footer
2 B~ % X & B 3 B Al (@)
4

41 Item data first line Name Item data first line

1Al ltem.No Show in Designer Show

i-|A] ttem.Descriptionl -

[#) Item.UnitPrice Default Font [Calibri, 10.0 pt)

41 ltem data second line

4
: il tem.Picture Appearance Condition Always Show
e . :

|
~{A] Item.Description2 Index Level

1|l Data graphic 4 Spacing [0.000, 0.000, 0.000, 0.118in]
Left 0.000 in
Top 0.000 in
Right 0.000 in
Bottom 0.118in
Table of Contents Level 0
Appearance Condition

Appearance condition. The item will not be printed if this
condition evaluates to False.,

)

Define Column Contents

You can define as many columns as you want for each line. You must only make sure that these columns
can be displayed within the width defined for the table.

The individual columns are shown in the object dialog as a tree structure. The buttons let you edit, delete,
cut, copy, insert and move the selected columns. You can also move columns outside of the line
definitions by using Drag and Drop.

Proceed as follows to create new columns in the object dialog:

1. First select the line in which you want to insert a new column.
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2. Now choose Append column in the context menu. (ALT+INS). Alternatively, you can select an
existing Column definition and then click the New (Append column) button or the small downwards

arrow next to this button to specify the type.

3. Each column has a certain type. Various properties are available for the column type including: text,
drawing, barcode, RTF text, chart, gauge, HTML text and OLE container. When selecting a field, this
data type will be set automatically.

4.  To define the contents, the familiar formula wizard will appear in which you can define the column
contents in the form of expressions. You will find more information about this under Variables, Fields

and Expressions.

5. Now define the column's properties. Each column in a line can be edited and formatted separately.
Select the column that you want in the tree structure in the object dialog.

Ly Table Contents - ltem n
¥  Header Line v Data Line ¥  Footer Line Group Header Group Footer
A4 B3 X 4 B ¢ E Ao ®
4 ~
4 ltem data first line Name
|é ltem.No .
f {Al Item‘Da?:nptlcn] (Contents) Item.No
L [# tem.UnitPrice Options
4 J) ltem data second line . -
; Ié X Background Transparent
|l Item.Picture Exvort ¢ Pict N
i-[A] Item.Description2 port as e D_ i
H . Font [Calibri, 12.0 pt]
Jlll Data graphic
Rotation 0°
Text Format Normal Text
4
Link URL
El
Alignment Left
Annearance Conditinn Ahwvavs Show A
Format
Output format.

Sample variable 'ltem.No'".
This text can be defined by your application.

@ — 0K Cancel

To select multiple columns, hold down the ALT or the SHIFT key. Various properties are available

including:
e Formatting e.g., as number or currency.

e Name of the column: this will help you to maintain an overview with complex expressions. If you
change the name directly in the tree structure, your change will also be applied as content where

appropriate.
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e You can specify when this column is to be printed with an appearance condition. This is useful if
you define multiple columns that are to be printed depending on certain values. The familiar
dialog for defining logical expressions opens up here.

e Rotation of the content in increments of 90°.
e Background, frame, font, vertical and horizontal alignment.
e A fixed height for the field irrespective of the content.

e The column width.
Define Group Lines

Group lines are a special type of line. They are used to group together the data lines that are to be
printed.

You can use the Group by line property to specify how the data is to be grouped. This means that the line
is printed whenever the result of the expression changes from one data line to the next. If you don't enter
an expression, the line will not be printed and the property is highlighted in red in the property window.

A group header is printed accordingly before the data line is output, e.g., Item group XYZ group heading.
A group footer appears after the condition of the Group By property has changed, in other words, after
outputting the data line. Group footers are suitable e.g., for totals of data within a group.

In the report container you can also output a group sum in the group header with the Precalc() function,
e.g., Precalc(Sum(ltem.UnitPrice, <GroupBy-String>)).

m © Resolver Inc. Confidential. Do not distribute. Page 241 of 350



Perspective User's Guide

Custom Reports

() Table Contents - ltem
¥ Header Line v Data Line v  Footer Line v  Group Header v Group Footer
L H- 5 X & B ¢ g
4 Desigr
4] Main group header Name Main group header
| ~{A] "Main group " + """ + LeftS(tem.No, 1) + " Show in Designer Show
47 Sub group header 4 Appearance
~{AJ "Sub group * + ™" + LeftS(item.No, 3) + b Default Font [Calibri, 10.0 pr]
4 Layout
Appearance Condition Always Show
Break Before No
Group By LeftS(ltem.No,1)
Group Sums
[» Index Level 0
Repeat As Header Ne
4 Spacing [0.000, 0.000, 0.000, 0.197 in]
Left 0.000in
Top 0.000in
Right 0.000 in
Rottom 0.197 in
Group By
Whenever the string defined by this expression changes, a group
change is triggered. If nothing is specified the group line is only
printed once.
2] - 0K Cancel
Example: Grouping by the first letter of the "ltem.No" field.
Item no Barcode Description Price in €
Main group 'E'
Sub group ‘EXP*
EXPSADL Southem Africa Bxplorer: 20-day tour from Cape 150000
Town to Victona Falls excluding flight
EXPCHO1 Northem & Southern Chile: 23-day tour from 350000
Santiago to Punta Arenas including flight
EXPMALDL Maldives dving trip: 14 daye, southem Male Atoll, 10000
Faradizse Beach **** excluding flight
EXPHKDL Hong Kong and Ball: 2 weeks, including flights, 175000
accommodation, excursions
EXPYUCOL Yucatan, On the Trall of the Maya, 2-week round trip, 120000
excluding flight
EXPLONOL London, sightseaing tour with boat trip onthe 6000
Thames
6 Items In 'EXP' = 9820 .00
Sub group ‘EXC'
EXCPAROL Faris, visit to the Louvreinduding guided tour and 4000
admizlon
1 ltems In "EXC' = 40.00
7 ltems in 'E'= 9860 .00

1. Create a new line definition on the Group header tab. Enter the following expression for the content

of the column:

Main group: ' + Left$ (Item.No,1)
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The result of the expression Left$ (Item.No,1) is the first character of the Item.No variable. Whenever
the first letter of Iltem.No changes, the text Main group: and the first letter in each case will be
printed.

2. Enter Left$ (Item.No,1) as the condition for the Group By property.
With each new first letter, a corresponding intermediate header will be printed in the list.

3. Multiple line layouts are possible with group headers as well. In this way, you can produce
hierarchically structured intermediate headers. For example, you can define a line layout that is
produced, as in the above example, based on the first letter of the Item.No variable. In addition, you
define a second line layout that produces intermediate headers based on the first three characters of
Item.No.

4.  Create a new line grouping for the sub-group header in the same way. Enter Left$ (Item.No,3) as the
condition for the Group By property.

Enter the sub-group for the content of the column: ' + Left$ (Artikel.Nr,3): When the first 3 letters
change, a corresponding intermediate header will be printed in the list.

Along with the properties of the normal lines, you also have the following at your disposal:

e Group sums: You can set sum variables to 0 here once they have been output in order to produce
group sums.

e Page break before outputting a group header or break after outputting a group footer.

e The option of always displaying the group header additionally at the start of the table if the group
has been separated by a page break.

Table Layouts

There are various properties and functions which you can use to influence the layout of a table.
Align Columns
There are various ways of simplifying the use of table objects.

e If you hold down the CTRL key when reducing the size of a table, all columns will be automatically

reduced in size by the same factor.

e The width of the columns adjusts automatically. You can adjust the width of a column manually by

moving the separating line to the right or the left with the mouse. This changes all table columns,
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whose separators are within +/-2 mm from the mouse position. If you hold down the CTRL key, the
action will only be carried out for the line on which the mouse is positioned. If the Column width
modification affects next column option is enabled (File > Options > Workspace), you can alter the
column width while making the next column smaller.

e If you move the first column separator to the right with the mouse, an empty column will be created
in all line definitions.

e Use the function TableWidth() to define the column widths relatively. It returns the width of the table
object. Example: With TableWidth()*30/100 the Column takes 30% of the width.

e You can hide Line Types (header, data, footer, group lines) in the workspace. To do this, select the
table object and use Visible Line Types in the context menu or the corresponding menu item View>
Visible Line Types.

e To align (sub) tables easier with one another, additional tick marks can be shown on the ruler by
means of an element property.

0 1.0 2.0 3.0 4.0 5 6.0 7.0 8.0 9.0 10
b T No b e b S cccnc boco Toc becc ST boooo Vo boccconn bevee e b
E This column tick position is defined in:
3 - Order Details [ der Details], Header Line 1, Positions_Header
= - - Order Details [Orders20rder Details], Data Line 1, Positions_Data
— - Order Details [Orders20rder Details], Footer Line 1, Positions_Footer
- T
Fixed Size

The Fixed Size property lets you specify that the size of the table is not to be adjusted automatically when
fewer data lines are printed than the available space in the table object.

This property is useful to ensure that footers are always printed at the bottom of the page, e.g,, if the
page number is output in the footer. If the property is disabled, the end of the table automatically moves

upwards (and the footer therefore also).
Print Header Lines and Footer Lines Again

If the print of a table is continued on the following page, the header lines of this table and the outer table
will be printed again. To suppress repeated printing of the header lines on the following page, use the
FirstHeaderThisTable() function as an appearance condition.

This functionality is also available for footer lines, here you use the LastFooterThisTable() function as the
appearance condition. This ensures that footer lines are only output on the last page of the table in the

event that the print is continued on the following page due to lack of space.
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Define the Size of the Table Variably

You can define the height and width of the report containers variably to avoid data being truncated when

the page format is changed (e.g., from portrait to landscape).

To do this, select the report container in the Report Structure tool window and use the LL.Device.Page
variables and the UnitFromSCM() function to specify the height and width.

MPosition | [0.591, 2.086, 7.790, 10,762 in] |47

Left UnitFromSCM(15000) [0.591 in]

Top UnitFromSCM(52980) [2.086 in]

Width LL.Device.Page.5ize.cx - UnitFromSCM(27130) [7.199 in]

Height LL.Device.Page.5Size.cy - UnitFromSCM(76600) [8.676in] w
Position

Position of the object.

Force a New Page

With complex projects containing hierarchical tables, it is sometimes wise to create a page break before

outputting a line of the top table.

Alternatively, you may want to have a new page if, after outputting a data line of the top table, there is
not enough room for the following data lines of the sub-table.

You can handle both cases with the Pagebreak Condition property.
For example, in the case of a hierarchical table, in order to output each data line of the main table on a

new page, select the main table in the Report Structure tool window and set the Pagebreak Condition

property to True.
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Create a Conditional Page Break

Let's assume that you want to create a continuous table. However, you want to avoid printing data lines
from the main table at the bottom of the table unless there is enough room for at least 3 data lines from

the sub-table.

You do not want it to look like this:
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Product categories

You can avoid this by means of the RemainingTableSpace() function. This function returns a value showing
the available space. If you set the parameter to True, the value will be returned as 1/1000 mm.

If you want to specify that a new page should be started before outputting the data line of the main table
if the space remaining is less than 3 cm, enter the following formula for the Pagebreak Condition

property:

RemainingTableSpace(True)<30000
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Keep Lines Together

If the print of a table is continued on the following page due to lack of space, you can decide whether the
lines are to be separated or kept together if possible.

This option is useful for multi-line data lines or for invoice footer lines containing totals. You can use this
option with data lines, footer lines, group footers and group headers.

Output Free Content Before and After a Table

You can output free text before and after a table. To do this, use the RTF object and link the object to the
project as free text via the report container.

1. To add a new element to the report container, select the Append an element or the Append a sub-
element button in the Report Structure tool window.

2. Aselection dialog will appear for the chosen object type. Choose the Table object type.
3. Inthe following dialog, select Free content as the data source.

Ly Choose Source Table Path ﬂ

Please choose the source table here:

.| Free content|
- |tem

Z oK Cancel

4. Then add a column via the properties dialog for the table object. In our case, we want to create the
covering letter as formatted text. Therefore, click the small arrow on the right of the button and

choose the Formatted Text option.
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s Table Contents - Free content “
Data Line
£ Be® X % 6 B 4w @
Al Text Crl+T
L . Name
A Picture SRy Show in Designer Show
[ Barcode Ctrl+B 4
[5 FormatteqTed Ctri+F Default Font [Calibri, 10.0 pt]
\,—E:l Gauge .
@ HTMLTet Appearance Condition Always Show
> Index Level 0
= PDF - B
- 4 Spacing [0.000, 0.000, 0.000, 0.000in]
#% OLE Container Left 0.000 in
Top 0.000 in
Right 0.000 in
Bottom 0.000 in
Table of Contents Level 0
Appearance Condition

Appearance condition. The item will not be printed if this
condition evaluates to False.

L oK Cancel

5. Adialog appears where you can type in the covering letter in the form of continuous text. You will
find detailed instructions for working with formatted text in Chapter Practice: Create a Mail Merge
Project.

6. Please don't forget to remove the (column) frame for free content. The best way is to remove the
frame via the Default Frame property in the element properties.

7. You may also have to change the layer condition as the covering letter will now be output on the
first page.

8. If the General Terms and Conditions are also to be output at the end of the invoice, you must add

another free content object to the container after the item table. Then you have several options:
a. Use the Formatted Text object here as well.
b. Use the PDF object and include the General Terms and Conditions in PDF format.

c.  Use the LoadFile$() function to load a linked file and enter the path of the file as the parameter
as follows LoadFile$ (ProjectPath$()+\gtc.txt).

d. Fortheissue on a reverse side, see Reverse Side in Chapter Report Sections.

Anchored Lines (Overlapping Cells)
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Let us assume that you want to output the contents of a column across two lines. You can achieve this by

anchoring two lines to each other by the line property Anchor to row (Index (1-based) of the row; 0=no

anchoring). So the beginning of the next line definition will be forced to the beginning or the end of

another line definition. Hence the cells can overlap.

Note: This function is not supported by all export formats.

Ly

v

=]

Table Contents - Item

Header Line v Data Line Footer Line Group Header
A B X & B t 8 B 5

4
4|3 ltem data first line Name

-{A] ItemNo
A
{A] Item.Description1
4. Item Picture
Al a
& ItemPicture
4 2 Item data second line
Al -
Al Item.Description2

Show in Designer
a

Default Font

Anchor
Appearance Condition
Index Level
Spacing

Table of Contents Level

Anchor to Row

Pl Anchor to Row 1 l

Group Footer

Item Picture
Show

[Calibri, 10.0 pt]

Top

Always Show

0

[0.000, 0.000, 0.000, 0.200 in]
0

The starting position of the row will be anchored with the
starting or end position of the selected row.

Ny OK Cancel

Let's assume that you want to create two lines next to an image column:

1.

2.

3.

4.

a1

Define in the first line with 3 columns: Item.No (column width 1), empty content, a space (column

width 1), Item.Description (column width 3).

Define in the second line with 2 columns: empty content, Item.Picture (both column width 1). in the

line properties set Anchor to Row to 1 to anchor this line with the first line definition.

Define the third line also with 2 columns: empty content (column width 2), Item.Description2

(column width 3).

Thus, the second line is printed in the same starting position as the first line and the cells may

overlap:
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ItemNo Description
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to Punta Arenas including flight

o~ Travel from the Atacama desert in Northern Chile, the metropols of
Santiago, acrossthe lakes and volcanoes region to the Strait of
Magelan and the huge Torres del Paine National Park. Patagonia:

Expandable Region

When you activate the property Expandable Region, the sub-elements of an element are not printed into
the preview at first during printing, and a drop-down symbol will be displayed on the line itself. Clicking
on the symbol expands the region for the corresponding line, providing a drill-down option without
having to leave the current preview, and without having to design a separate project.
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p— ~ @
| a Page: 1 - ), $R Zoomin é (% Export 7] o E
Wy = W Previous File ) £ Zoom Out g Fa O ;

Move Previous Next Page Quick incel  Limit  Close Print
Page Page (@ MextFile Width & Presentation ~  print+ =3 E-mail ] (e

Pages~ Preview

Navigati
Report Structure x
W P X XD
4. Report Container
4 V| Table: Customers [CustomerD [+]] R Order Overview
4 [¥)E) Table: Orders [Customers20rders] LY TR
V) Table: Order Details [Orders2Order Details]

Report Structure] ~ Objects Layers
Properties X
B0 8 ]
= Top A
Right
Bottom
Design Scheme Project Design Scheme
4 Layout
Appearance Condition Always Show
Distance Before 0.000in
ExpandatieRegion 108 v
> Index Level 0
Pagebreak Before No
Pagebreak Condition RemainingTableS... [False]
> Table of Contents Level 0
4 Line Options
i Data Lines

1> Footer Lines.
> Group Footer Lines

1> Group Header Lines

Expandable Region
The sub elements of the element are initially not visible in the H -
preview, however they can be expanded interactively, -
4 Layout Layout Previe |8l Preview
4.693, 11.843 Select Report Container "Report Container” - 0.591in, 2.086in - 7.791in, 10.764in = 7.200in, 8.678 in (Base) 100% S +
.
Creating Charts

This object is used to evaluate and display data graphically in diagrams. This gives you an overview of
your data and lets you recognize anomalies immediately.
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For example, you can analyze sales trends, illustrate percentage shares and show data in multiple
dimensions. You have a wide range of different types of diagrams at your disposal:

e Circle/Donut chart
e Bar/Ribbon chart (also displayed as cylinders, pyramids, cones, octahedrons)
= Simple (e.g., sales per customer)
»  Multi-row (e.g., sales to various customers over the years, scaled by customer)
»  (Clustered (e.g., sales to various customers over the years, grouped by year)
= Stacked (e.g., percentage of sales to various customers stacked over the years)
= 100% stacked (e.g., respective sales percentages for various customers over the years)
e Line/Symbol: Simple, Multi-row, Stacked, 100% stacked
e Area: Simple, Stacked, 100% Stacked

e Bubbles/Dots: Distributed, Sorted (Displayed as circle, drop or picture file)

e Funnel/Pipeline

e Map/Shapefile

Insert a Chart Object

There are various ways of outputting chart objects:

1. Achart as an element in the report container. Add the object via the Report Structure tool window. If
you have not yet added a report container to the workspace, select Insert > Report Container
(Objects > Insert > Report Container) and pull the object to the right size in the workspace while
holding down the left mouse button. A selection dialog will appear for the chosen element type.
Choose the Chart element type.

2. You can output charts and gauges in a table cell. To do this, select the relevant entry by means of

the context menu in the object dialog for the table. If you want to output the aggregated data, a

good way of doing this is to use a footer line.
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3. In the following dialog, now select the data source. All available tables are shown hierarchically, in

other words, under the tables you will find the relational tables in each case.

To evaluate sales per country, for example, choose the Customers > Orders > Order Details table in
the Sample Application so that you have all three tables at your disposal. The Customers table
contains the country, the Orders table the order date and the Order_Details table the sales.

4. The chart object dialog is displayed. In the drop down lists in the top left you can select the base
type and the corresponding sub type.

5. The axes are defined in the tabs (Category Axis, Series Axis, Value Axis, Data Source, Segment, Funnel

Segment, Shapefile Selection). You can click directly into the live preview (e.g., onto the title or axis
label) to quickly jump to the corresponding property.
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] Chart Properties “

N oTEE
ﬁ Bar/Ribbon ‘ Circle
F_‘—_ Line/Symbol a Donut (3D)

t  Areas o Donut

"+ "% Bubbles/Dots

Y Funnel
=

‘_‘: Map/Shapefile

Data Source | Pie Segment ‘Dingram| Diagram Area | Colors

4Data ~
Customers.CompanyName
Minimum Share 5%
Sort Coordinates Yes
Number of Records for Design 5
Filter No Filter (All Data)
4 Labels
I Axis Label “Customer”
» Coordinate Label Cond(Len(LL.ChartObject.AxisCoordinate) > 25, Le... v
Coordinate Value

This formula determines the coordinate value of the data.

@ F_' oK Cancel

6.  On the Diagram tab, select the general diagram options (e.g., perspective, color mode).

7. On the Object tab, select the general layout options for the entire chart object (e.g., Title,
Background).

8.  On the Colors tab, you can specify the colors for the display:
e Design Scheme: Specifies the colors and color sequences for the data rows that are not specified
by the Fixed Colors. You can select a predefined color set from the drop down list. These colors

can still be adjusted in the properties.

e Fixed Colors: You can assign fixed colors to particular axis values. If you click the New button,
you can create a new assignment e.g., Customers.Country = Germany.

Pie, Donut, or Circle Chart

Let's assume that you want to evaluate the sales per country. The pie chart is the right choice for this. It
lets you read off the percentages immediately. Proceed as follows in the Sample Application:
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1.  As the data source, select the Customers > Orders > Order_Details table.

2. For the diagram type, click Circle/Donut > Pie.

3. You should first specify the coordinate values for the data source, i.e., the values that define the
individual segments, e.g,. Customers.Country.

Data Source | Pie Segment | Diagram | Diagram Area | Colors

4

1
>|@

4 Data
T  tomers County
Minimum Share 5%
Sort Coordinates Yes
Number of Records for Design 5
Filter Mo Filter (All Data)
4 Labels
> Axis Label “Country”
> Coordinate Label

Cond(Len(LL.ChartObject.AxisCoordinate) > 25, Le... ¥
Coordinate Value

This formula determines the coordinate value of the data.

4.  Switch to the Segment tab to specify the coordinate values for size of the segment, i.e., the sales.
Double-click the Coordinate Value property.

Now select the aggregate function that you want for the contents in the Coordinate Value dialog
that follows. You want to create a sales evaluation so choose the Sum function.

y Coordinate Value “
Content:

Order_Details.Quantity * Order_Details.UnitPrice

Aggregate function for the contents:

<no simile aiireiate function>

Arithmetic Average
Geometric Average
Median

Mode

Highest Value (Maximum)
Lowest Value (Minimum)
Variance

Standard Deviation

Count

Number of Distinct Values

Result:

6| Sum(Order_Details.Quantity * Order_Details.UnitPrice)
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10.

In the upper part of the dialog, you can specify the contents by clicking the formula button to start
the formula wizard. In the Sample Application, the sales per order value is not supplied directly as a
field so you must calculate it using the Order_Details.Quantity * Order_Details.UnitPrice formula.

The Label on Object property is already set to Yes so that a label with the percentage value is shown
on the segments. Define the value as percent without decimal places by means of the Format

property.

Data Source | Pie Segment | Diagram | Diagram Area | Colors

BE| 4 2 @
4
Coordinate Value Sum(Order_Details.Quantity * Order_Details.UnitPrice)
4
Cond(LL.ChartObject.Arcindex=1,20,10) Ja
4 Label on Object Yes
Font [Calibri, 10.0 pt]
Format None
Ceontent Percentage (With 1 Decimal Place)
Filling Transparent
Width 75%
Explosion Offset

Describes the explosion distance of the pie segment (in percent of the pie radius) respectively the funnel section.

The Explosion Offset property lets you specify a distance to the center for the segment. With the
Arcindex chart field, which numbers the segments according to their size, you can even display the
largest segment with a greater offset. Example:

Cond (LL.ChartObject.Arcindex=1,20,10)

On the Diagram tab, select the general diagram options. Various properties are available including:

e The degree of perspective, e.g., strong.
e The color mode, e.g., single color

On the Diagram Area tab, select the general layout options for the entire chart object. Various
properties are available for this including:

o Title
e Background including filling, border and shadow, e.g., border = transparent

On the Colors tab, you can specify the colors for the display:
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e Design Scheme: Specifies the colors and color sequences for the data rows that are not specified
by the Fixed Colors. You can select a predefined color set from the drop down list. These colors

can still be adjusted in the properties.

e Fixed Colors: You can assign fixed colors to particular axis values. If you click the New button,
you can create a new assignment e.g., Customers.Country = Germany.

11.  The pie chart now looks like this:

Total sales percentage of country

Country

Austria
W Sweden
M France
B Gemany
| UK
W Canada

Other

25.5%

Multi-Row Bar Chart

Let's assume that you want to evaluate the sales for various countries over the years, scaled by country. A
multi row bar chart is perfect for this. You get a diagram in which you can see the turnover achieved in the
respective country for each quarter. Proceed as follows in the Sample Application:

1.  As the data source, select the Customers > Orders > Order_Details table.

2. Choose Bar/Ribbon > Multi-Row (3D) as the diagram type.

3. First specify the coordinate value for the category axis, i.e., the value of the x-axis. Select the
Customers.Country field via the formula wizard.
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Category Axis (x) | Series Axis (y) | Value Axis (z) | Diagram Diagram Area | Colors

G @
CT— 2
Coordinate Value Customers.Country
Sort Coordinates Yes
Number of Records for Design 5
Filter No Filter (All Data)
Round Start and End Values Yes
4
> Axis Label “Customer”
Coordinate Label Cond(Len(LL.ChartObject.AxisCoordinate) > 25, Le... ¥
Data

4.  Now specify the coordinate value for the series axis, i.e., the value of the y-axis. In the Sample

Application, the order year is not supplied directly as a field so you must calculate it using the
Year$(Orders.OrderDate) formula.

If you want to evaluate the data by year, simply enter Year$(Orders.OrderDate) as the coordinate
value. Type Year as the text for the Axis Label.

Category Axis (x) | Series Axis (y) | Value Axis (z) | Diagram | Diagram Area | Colors

Use formula to determine the values

g 8 o o
4 ~
Coordinate Value Year$(Orders.OrderDate)
Sort Coordinates Yes
Number of Records for Design 5
Filter Mo Filter (All Data)
Round Start and End Values Yes
4
Aol akal LUV M
Data

5. Now specify the coordinate values for the value axis (z-axis), i.e., the height of the bars representing
the turnover. Double-click the Coordinate Value property.
Now select the aggregate function that you want for the contents in the Coordinate Value dialog
that follows. You want to create a sales evaluation so choose the Sum function.

6. Inthe upper part of the dialog, you can specify the contents by clicking the formula button to invoke
the formula wizard. In the Sample Application, the sales per order value is not supplied directly as a

field so you must calculate it using the Order_Details.Quantity * Order_Details.UnitPrice formula.
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Category Aws (x) | Series Axis (y) | Value Axis (z) | Diagram | Diagram Area | Colors

|

Primary Axis |Us= Diagram > Secondary Axis to enable,
4] th
4Data
Sum(Order_Details.Quantity * Order_Details.UnitPrice) Vo
Axis Scale 0 [Nene (Linear)]
4 Maximum Value Automatic True [Yes]
Threshold 1.0
4 Minimum Value Automatic True [Ves]
Thresheld D

Coordinate Value
This formula determines the coordinate value of the data.

7. Various other properties are available on this tab including the following layout options:

e Maximum Value Automatic: You can limit the height of the displayed area, e.g., to cater for
anomalies.

e Presentation: The data can be presented in various ways: cylinders, bars, pyramids, ribbons,
octahedrons, cones

e Thickness of the bars

e Zebra mode for the background

8.  On the Diagram tab, select the general diagram options. Various properties are available including:

e The Projection, e.g., flat.

e Color Mode: Specifies which axis determines the color, e.g., the y-axis values.

Category Axis (x) | Series Axis (y) | Value Axis (z) | Diagram | Diagram Area | Colors

G-
| fuis Color RGB(204, 204, 204)
I> Background Color Transparent

Color Mode Y Axis Values
llluminated No
Isotropic Ne
Perspective None
X Axis Rotation Angle 20
Z Axis Rotation Angle 13

Projection

Projection

©]
~

9.  On the Diagram Area tab, select the general layout options for the entire diagram. Various

properties are available for this including:
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o Title
e Background including filling, border and shadow, e.g., border = transparent

10. The multi-row bar chart now looks like this:

Sales per country and year
oo (Y
17505
12003 -
E:I.EJIIE Arpenting
E1pom 2 Canais
- . Il Framce
73008 W Gy
20005 m Mesice
u 3an
23003 S
2 m
s
T e iz

100% Stacked Bar Chart

The pie chart in the first example gave you an overview of the percentages for the entire evaluation
period. But in order to be able to recognize trends, it would be good to see how the percentages have
changed during the course of the evaluation period. The 100% stacked bar chart can be used for precisely
these types of applications. The respective percentage of the length of the bars relates directly to the
turnover percentage of the respective country.

Proceed as follows in the Sample Application:

1.  As the data source, select the Customers > Orders > Order_Details table.
2. Choose Bar/Ribbon > 100% stacked as the diagram type.

3. First specify the coordinate values for the category axis, i.e,, the values of the x-axis. Select the

Customers.Country field via the formula wizard.
4.  Now specify the coordinate values for the series axis, i.e., the values of the y-axis. In the Sample

Application, the order year is not supplied directly as a field so you must calculate it using the
Year$(Orders.OrderDate) formula.
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5. Specify the coordinate values for the value axis (z-axis), i.e., calculate the turnover with
Sum(Order_Details.Quantity * Order_Details.UnitPrice).

6.  On the Diagram tab, choose Left to Right for the Alignment to create a horizontal diagram.

7. The multi-row bar chart now looks like this:

Sales per country and year

Turnover
O  10me 20 30m A0 SO0%  E0%E YO B S0% 100%

areerces |

cre:

France I | v
£ ey I . o
§ veo [N "

sean I

secen [ I

D |

UK

Multi-Row Line Chart

A line diagram offers an alternative to a multi-row bar chart. You can read off the values faster here.

Sales development of categories by quarter

£4500
£4,000
£3,500 Category
£3,000 Beverages
§£2 500 W Condiments
' M Confections
2£2,000 M Dairy Products
£1,500 M Graing/Cereals
B Meat/Poultry
£1,000 Produce
£500 B Sesfood

4/2012 1/2013 2/2013 3/2013 4/2013 1/2014 2/2014
Quarter

Proceed as follows in the Sample Application:

1. As the data source, select the Customers > Orders > Order_Details table.
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2. Choose Line/Symbol > Multi-Row as the diagram type.

3. First specify the coordinate value for the category axis. Select the Orders.OrderDate field via

the formula wizard.

4.  Select the property Coordinate Label > Format and select %q/%y in the Date-section (user-defined).

5. Now specify the coordinate value for the series axis. Select the CategoryName field via the formula

wizard.

6.  Specify the coordinate values for the value axis and calculate the turnover with the
Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.

Stacked Area Chart

The stacked area chart is available as an alternative to the multi row line chart. This chart allows you to
compare statistical relationships more swiftly as the areas between the lines are colored in.

Sales per category

2012
W 2013
W 2014

Turnover

20
Bewrgges  Condiments Confectons DairyProducts Grans/Ceresls Mest/Poulty  Produce Seafood

Category

Proceed as follows in the Sample Application:
1.  Select the Customers > Orders > Order Details table as the data source.
2. Select Area > Stacked as the chart type

3. First specify the coordinate value for the category axis. Select the CategoryName field via the
formula wizard.
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4.  Specify the coordinate values for the series axis. In the Sample Application, the order year is not
supplied directly as a field, so you must calculate it using the Year$(Orders.OrderDate) formula.

5. Specify the coordinate values for the value axis (z-axis), i.e., calculate the turnover with the
Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.

Distributed Bubble Chart

Bubble charts allow for a four-dimensional representation of statistics in that, along with the position on
the y and x axes, the color and the size can be defined by statistical information. Diverse options are
available regarding how you would like the bubbles to be displayed.

Sales per year and country

520,000
51? 500 .513.235
515,000

=14, 183 .51-’_.57-3
512,500
510,000 i'lf?ﬁ 2012
57,500 S0 .35 m 2012

_ @ = W 2014
$5,000 5;;_.'52 .;:’3 %
52,500 SLim 52107 10
50 &z, osm2 5430

Canada France Germany Mexico Spain  Sweden UK

Proceed as follows in the Sample Application:

1.  Select the Customers > Orders > Order Details table as the data source.
2. Select Bubbles/Dots > Distributed as the chart type

3. First specify the coordinate value for the category axis. Select the Customers.Country field via the
formula wizard.

4.  Specify the coordinate values for the series axis. In the Sample Application, the order year is not

supplied directly as a field so you must calculate it using the Year$(Orders.OrderDate formula.

5. Specify the coordinate value for the value axis and the value for the Bubble Size and calculate for
both the turnover with the Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.
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6.  Under this tab you will also find the options for how you would like the bubbles to appear.
Funnel

With a funnel or a pipeline, you can e.g., display your sales processes in the various phases. There are a
variety of options for the way the data is presented.

To do so, proceed as follows:
1. Select the appropriate data source.
2. As the diagram type, select Funnel > Vertical Funnel.

3.  First of all, define the coordinate value of the data source, i.e., the value that will define the individual
funnel segments (the sales phase).

4.  Switch to the tab Funnel Segment to define the coordinate value for the size of the funnel segment
(number of sales opportunities). Double-click on the Coordinate Value property. Now, in the
subsequent dialog Coordinate Value, select the desired aggregating function Count for the content.

5. For the labeling of the funnel segments with percentage values, the option Label on Object has
already been set to Yes. Then, via the property Format, define the value as Percentage (Without
Decimal Places) or as Absolute Value.

6.  You can enter an offset for the funnel values via the property Explosion Offset.

7. In the Chart tab, select the general diagram options. The following properties are available (among

others):

e Relative Width of Funnel End/Start.
e Color Mode, e.g.,, monochrome

8. Inthe Chart tab, select the general layout options of the entire object. The following properties are

available (among others):

o Title
e Background incl. filling, border and shadow, e.g., border = transparent

9. Inthe Colors tab, you can configure the color options.
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Stage

1 Initial contact
B 2 Interest present
B 3 Evaluation desired
B 2 EBvaluation
B 5 Evaluation ok
B & Decision

7 verbal agresment
B B'Written order

Stage
1 Initial contact
W 2 Interest pressnt
B 3 Evaluation desired
a4 N 4 EBwaluation
W 5 Ewluation ok
B & Decision
7 verbal agreement
B EWritten order

Map/Shapefile

Shapefiles enable a diverse range of visualization options via a standardized vector description format. Via
corresponding templates, a wide range of maps, seating charts or floor plans can be generated. The
Shapefile determines the shape, and an associated attribute database enables the shapes to be referenced
to the properties (e.g., country names).

Tip: The availability of this chart depends on the application.

Example: A visualization of the temperature distribution of the earth is to be
generated.
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To do so, proceed as follows:
1.  Select the table ClimateData as the data source.

2. As the diagram type, select Map/Shapefile. At this point, a selection dialog appears for the Shapefile
templates provided with the software. Select World With Seas and Lakes.

Template Selection for Shapefile Chart

Which template shall be used as default?

The chart can display any Shapefile. For a quick start, select a template here. Afterwards, define an
assignment between the data and the Shapefile attributes on the ‘Assignment’ tab and set colors and
legend properties on the 'Colors' tab.

2 World With Seas and Lakes
World (scale 1:100.000.000) with country borders.

2 Europe With Seas and Lakes
Europe (scale 1:50.000.000) with country berders.

2 North America With Seas and Lakes
North America (scale 1:50.000.000) with country berders.

2 Asia With Seas and Lakes
Asia (scale 1:50.000.000) with country borders.

2 South America With Seas and Lakes
South America (scale 1:50.000.000) with country borders.

2 Oceania With Seas and Lakes
Oceania (scale 1:30.000.000) with country borders,

2 No Template

Free configuration, e.g. for particular states/countries or custom data.

3. You will now see the preconfigured data Shapefile in the tab Shapefile Selection. In addition to the
data itself, you can also select foreground and background Shapefiles in order to e.g., display the
oceans in the background and the rivers and lakes in the foreground.
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4.

Ly Chart Properties

‘ Circle/Donut
ﬁ Bar/Ribbon

"+ 7% Bubbles/Dots ' y 3

Funnel

“‘ Map/Shapefile

Shapefile Selection ‘ Assignment‘ Value ‘ Diagram Area | Colors

L) Map/Shapefile &

4 Data
4 Chart Definition N

+ Data Shapefile ne_110m_admin_0_countries

Projection Mercator (Cylindrical)
2 Shapefiles: ne_110m_ocean, ne_110m_admin_0_countries

1 Shapefile: ne_110m_lakes

Background Shapefiles
Foreground Shapefiles

|Chart Definition.Data Shapefile
This Shapefile will be used for the data (coloring etc.).

Cancel

=

Lo« |

Click on the Assignment tab in order to link the data with the shapes.

Shapefile Selection | Assignment | Value Diagram Area |Colurs

4 Data

Coordinate Value ClimateData.ISO_CODES

Filter No Filter (All Data)

Shape Assignment LL.ChartObject.Shape.Attribute.iso_a3
4 Labels

[ Axis Label -

- T s

Legend
Placement of the axis' legend.

Link the coordinate value ISO_CODES from the data with the attribute iso_a3 from the Shapefile. By
doing this, the data that is related to e.g., USA is linked to the outline of USA; the temperature from

United States of America is linked to United States of America, and so on.

Go to the tab Value and select the mean temperature as the Value, i.e., the field ClimateData.Tmean.
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6. Go to the tab Colors to define the legend. As the first entry, define the color via the function
HeatmapColor(LL.ChartObject.AxisCoordinate,-20,40) and set the condition to True. The value will
then be used for the actual color fill, and you will obtain a continuous fill color.

7. For the other discrete legend values, enter the corresponding functions, e.g., HeatmapColor(5,-20,40)
with the legend text 5° and set their condition to False. This means that the value will only be used
for the legend.

Shapefile Selection | Assignment | Value | Diagram Area Colors

Shape Legend
i X # B@B * Define the legend of the chart here by making a fix assignment of axis
values to color and text. 'LL.ChartObject.AxisCoordinate’ is the result value
Condition Legend Text Color of the current shape.
True HeatmapColor (LL.ChartObject.AxisCoordinate,-20,40)
False "o HeatmapColor (0,-20,40)
False "5 HeatmapColor (5,-20,40) Cendition:
False "10°" HeatmapColor (10,-20,40)
wqzan False va
False 15 HeatmapColor (15,-20,40)
False "20"" HeatmapColor (20,-20,40)
False 25 HeatmapColor (25,-20,40) Legend text:
False "30°" HeatmapColor (30,-20,40) n3gen va
False "35™ HeatmapColor (35,-20,40)
Color:
HeatmapColor (35,-20,40) va

Use Series to Determine the Values
With three-axis diagrams, you can also determine the values of the series axis (y-axis) by means of rows.
This means that you define the different rows (e.g., measured value/target value/actual value) with a

single data record and can show them parallel e.g., in a bar chart.

As an example, we will create a diagram which shows the currency percentages of the 3 economic areas.
Data for APAC, EMEA and NAFTA is supplied as rows.
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Percentage of the economy regions per year in percent

100%

=11 -4

a5

T
%60‘}: Ecomony region
:350‘5 APAC
o W EMEA

0% W MNAFTA

205

1%

2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014
Year

Proceed as follows in the Sample Application:

1.

Select the Sales table as the data source.
Choose Bar/Ribbon > 100% stacked as the diagram type.

First specify the coordinate values for the category axis, i.e,, the values of the x-axis. Select the

Sales.Year field with the formula wizard. Remove the 2 decimal places using the Str$(Sales.Year,0,0)
formula.

Now specify the coordinate values for the series axis, i.e., the values of the y-axis. Select the Use rows
as data source entry from the drop-down list above the properties.
Category Axis (x) | Series Axis (y) || Value Axis (z) | Diagram ‘ Diagram Area I|C<:»Icnrs|

Use series to determine the values v ‘

E Al 1

4 Data Lo}
Minimum Share 0%
Round Start and End Values Yes
E T £MEANAFTA B
4 Labels

I Axis Label "Ecomony region™
4 Coordinate Label Coordinate Value

v
B

. e an
Sets the properties for the different data series.

This option changes the properties of the series axis and displays a dialog for defining the rows
when you click the Row Definitions property. Create the individual rows choosing Sales.APAC,
Sales.EMEA or Sales.NAFTA in each case as the coordinate value.
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oy Series Definitions
Series: B X § | 4t
g Desion
EMEA Name
NAFTA 4 Dat

Coordinate Value
4 Calculation Type

F AJ eaArance
Color
Label on Object
Presentation
Width

4 Labels
Coordinate Label

4 la

Axis Assignment

Design

Move the series into the desired order by using the buttons or drag & drop.

Mixing Chart Types

Number of Values

APAC
Sales.APAC

normal

LL.Scheme.ColorD
No

Cylinder

60%

“APAC™

Primary Axis

Cancel

®

You can mix bar charts with line charts. In addition to the ability to display another data series as a line at

the same time as the bar chart, you may also make use of the calculation options such as moving

averages and aggregation options. This will allow you to see total turnover, trends in the data, or outliers

(both upwards and downwards) at a glance.

Example: Combining a straight line mean with a bar chart (turnover for each country)

1.  Select the table Customers > Orders > Order Details as the data source.

2. As the diagram type, select Bar/Ribbon > Clustered

3. First, define the coordinate value of the category axis. Use the formula assistant to select the field

Customers.Country.

Now define the coordinate value of the series axis. Use the combo box above the property list to

select the entry Use series to determine the values.

m © Resolver Inc. Confidential. Do not distribute.

Page 270 of 350



Perspective User’s Guide Custom Reports

Category Axis (x) | Series Axis (y) | Value Axis (z) | Diagram | Diagram Area |Colors

Use series to determine the values v
= 8 @
I 4 Data ~
Round Start and End Values Yes
Series Definitions Turnover:Mean g
4 Labels
b Axis Label “Year"
4 Coordinate Label Coordinate Value
[ Font [Calibri, 10.0 pt]

Series [ie-flm‘nns
Sets the properties for the different data series,

By doing this, the properties of the series axes change and a dialog appears for the property Series
Definitions for the definition of the series.

4.  Define a new series Single Turnover and calculate the turnover using the formula
Sum(Order_Details.Quantity * Order_Details.UnitPrice) with the calculation type normal and display
type Cylinder.

5.  Define another series named Mean and calculate the turnover using the formula
Sum(Order_Details.Quantity * Order_Details.UnitPrice) with the calculation type Average and display

type Line.

Ly Series Definitions ﬂ
Series: B X =l &) e
Turnover 4 Design ™

Name ean
O
Coordinate Value Sum(Order_Details.Quantity™...
i Calculation Type Average
4 Appearance
Color LL.Scheme.Color1
i Label on Object No
Presentation Line
4 Labels
Coordinate Label
4 Layout
Asis Assignment Primary Axis
Data

Move the series into the desired order by using the buttons or drag & drop.
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6.  The result is a turnover analysis with a mean line.

Sales per country (and average)

Framcs Garmany Maxicz Swadan UK

7. When using the calculation type Line of best fit, a trend line will be displayed:

Sales per country [and line of best fit)

France Germany Maxico Sweden UK

Create a Crosstab

Crosstabs are used for evaluating and presenting data in multiple dimensions. Crosstabs (or contingency
tables) are tables containing information about the frequency of the occurrence of combinations of

certain characteristics.

These frequencies are extended by their marginal totals which form contingencies. With a three-

dimensional crosstab, (three characteristics), the table includes an additional column grouping.
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For example, you can examine turnover trends per year and region, evaluating sales according to
quantities and customers, and create marginal totals for quarters and years.

A normal (flat) table has the attribute names in the first row and the occurrences of these attributes in all
other rows. A crosstab is different. The titles of both columns and rows receive characteristic occurrences
and, at the point of intersection of the respective column and row, a value is shown that depends on the
characteristics specified for the column and row in each case.

Customer turnover per year and quarter
2008 2009 2010

a3 Q4 Qi Q2 Q3 Q4 Q1 Q2 [

Germany 1,086 1,208 851 491 3636
Mexico 492 3,038 2,562 1,277 514 7883
Sweden 2,102 3,429 5531
UK 4380 1,352 2,143 1,704 5679
Total 2102 972 4781 3038 5791 4189 B51 1008 22729

For the schematic presentation of two-dimensional crosstabs, the 3D multi-row bar chart is the best
choice.

Create a Crosstab Object

Let's assume that you want to examine the development of turnover per year, quarter and country.
Proceed as follows in the Sample Application:

1. Crosstabs are elements in the report container. Therefore, you add these objects in the Report
Structure tool window. If you have not yet added a report container to the workspace, select Insert >
Report Container (Objects > Insert > Report Container) and pull the object to the right size in the
workspace while holding down the left mouse button.

2. A selection dialog will appear for the chosen element type. Choose the Crosstab element type.

3. Inthe following dialog, now select the data source. All available tables are shown hierarchically, in
other words, under the tables you will find the related tables in each case.
For our turnover analysis, e.g., choose the Customers > Orders > Order Details table so that you
have all three tables at your disposal. The Customers table contains the country, the Orders table the
order date and the Order Details table the turnover.

4. A wizard appears which will lead you through the 3 configuration dialogs for crosstabs.
Define Groupings

In the wizard's first dialog, or alternatively on the Axis Definition tab, you first define the grouping for the

rows and columns, i.e., the characteristics.
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1. In the Rows pane, click on the Insert a row grouping button.

2. Inthe formula wizard, you now enter the field or the expression for the row grouping e.g.,
Customers.Country. You have now created a row grouping and the data will be grouped by this
characteristic.

3. Inthe Columns pane, click on the Insert a column grouping button.
4.  Inthe formula wizard, you now enter the field or the expression for the column grouping.

5. Since you first want to group the data by year, you must enter an expression here that returns the
year of the order date. You have the Year() function in the formula wizard at your disposal; i.e., you
select this function from the list and insert the order date as the parameter by double-clicking. The
formula looks like this: Year(Orders.OrderDate).

6.  Since we also want to examine the data at another level, insert an additional column grouping via
the Insert a column grouping button.

7. Now enter an expression to return the quarter of the order date. You can use the Quarter() function
in the formula wizard for this. The formula then looks like this: Quarter(Orders.OrderDate).

Note: You can change the order of the groupings with the arrow button. The column at the bottom is the
inner grouping.

To swap lines and rows (Pivot function) use the button on the lower right on the Axis Definition tab. This
button is only available in the object dialog, not in the wizard.

Value of the result cells:

Sum(Order_Details.Quantity*Order_Details.UnitPrice) o4

T

| OK | Cancel

8.  You have now created the groupings and you can go on to define the value for the intersection of
the respective columns and rows. Click on the Edit group result formula button located under Value

of the result cells.
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10.

Now select the aggregate function that you want for the contents in the Cell Contents dialog that
appears. You want to create a sales evaluation so choose the Sum function. In the upper part of the
dialog, you can specify the contents by clicking the formula button to start the formula wizard.

In the Sample Application, the sales per order value is not supplied directly as a field so you must
calculate it using the Sum(Order_Details.Quantity * Order_Details.UnitPrice) formula.

oy Crosstab n
on || Cell Definition | Properties
2012
Total
4 Total
Germany 0
Total
Choose the groupings for the rows and columns here. For Columns: B & ¥ 3
example, to make a statistic about the turnover by year and
country, choose 'Year' as the group for the columns and Year$(Orders.OrderDate)
'Country’ as the group for the rows. For the value of the result Quarter{Orders.OrderDate)
cells, choose the sum over the turnover.
Rows: : ey x Value of the result cells:
Customers.CustomerlD Sum(Order_Details.Quantity*Order_Details.UnitPrice) A
=
@ U 0K Cancel

Define Cell Properties

In the wizard's second dialog or, alternatively, on the Cell Definition tab, you edit the properties of the

different cells.

You can select the cells directly in the drawing in the upper pane of the dialog and then edit their

properties. To select multiple cells, hold down the CTRL key or you can draw a border around the cells
with the mouse.

Let's assume that the countries shouldn't be listed alphabetically but descending by turnover. Select
the corresponding line header (here: Germany) and select the value Result Descending in the
property Sort Order then. In combination with the property Limit To you will get a Top-N analysis by
that.

Assuming that you want to prefix the number of the quarter with a Q as the title of a column. Select

the respective column title and then double-click on the Displayed Contents property.
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With this property, you can now specify the text that is to be displayed in this cell (independent of
the value that you have defined for this column grouping).

Now define either a suitable formula, e.g., Q + Str$(Quarter(Orders.OrderDate)) in the formula wizard

3. Alternatively use the Format property. Then remove the Quarter$() here, i.e., only the date field
remains in the field, and format the value by means of the property.

Ly Crosstab “

Axis Definition | Cell Definition | Properties

Germany 0 - -
Total = = =
E: %‘ [+1 (@) | |Edit the properties of the different areas
= here. You can select one or - by holding
g Data “ |culor by marking an area - more cells in
Displayed Contents "Q"+ToString$(Quarter(Orders.... the sketch above and then set their
Format None properties,
4 “,,"[" ce
4 Background Pattern/Block Color
Pattern 1 I
Data
| p—

To do this, click the Formatting property, choose Date as the formatting type, and finally select the User-
defined entry from the drop-down list. At the end of the list you will find an example for formatting a
quarter plus the number of the year. Since we don't need the number of the year, shorten the formula's
string to Q%q.
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No Format

Number

Currency

Date

Time

Date and Time
Date-/Time Difference
Percentage

Angle

(user-defined)

%D, %ed/ %M/ %y

%D, %d %M %y

%D %d %M %y

%D, %M %d, %y

%D, %M %d %y

%D, %d de %M de %y
%D %d de %M de %y
%D %d, %M %y

%D, %d.%m.%y

%D, %:02d.%02m. %y

%D, %y-%m-%d

%D, %y-%02m-%02d
%D, %m-%d- %y

%D, %:02m-%:02d- %y
%M %d %y

Fex

Joy-Q%q

Q%q %y

Friday, 9/August/2013
Friday, 9 August 2013
Friday 9 August 2013
Friday, August 9, 2013
Friday, August 9 2013

Friday, 9 de August de 2013
Friday 9 de August de 2013

Friday 9, August 2013
Friday, 9.8.2013
Friday, 09.08.2013
Friday, 2013-8-9
Friday, 2013-08-09
Friday, 8-9-2013
Friday, 08-09-2013
August 92013
09/08/2013
2013-Q3

Q32013

Preview

@

.

This cell is now formatted and you can go on to format all other cells in the same way. Various

properties are available including:

Rotation of the content in increments of 90°

Background

Frame

Font

Vertical and horizontal alignment

Maximum width, minimum width and minimum height

The Layout Option and Wrapping Behavior

In the wizard's third dialog or, alternatively, on the Properties tab, you edit the layout properties and

specify the wrapping behavior.

Various layout properties are available including:
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e Default frame

e  Minimum size (%) and minimum height

In addition, as crosstabs are often wider and higher than the specified page format, you can also specify
the wrapping behavior for columns and rows. It creates as many pages (shadow pages) as necessary. The

row labels are repeated on all pages as standard while the column labels are not repeated.

Various wrapping properties are available including:

e Repeat Labels: Specifies whether the labels of columns or rows are to be printed again in the case of

a page break.

e Break Level: Specifies the optimum break level, e.g., 0. This corresponds to the lowest group, i.e., the

quarter.

e Column > Page Break on Shadow Pages: If the cross table is too wide, the wrapped parts are printed

on shadow pages. A shadow page does not count as a real page and therefore does not have a page
number. The default setting specifies that the wrapped parts are to be output below the table.

(T¥} Crosstab

Axis Definition | Cell Definition | Properties

2012
Q1 Total
Germany 0 —
Total
B 8 e
" 4 Columns
4 Break Level 0
Force No
Page Break on Shadow Pages No
Distance Before 0.000 in
Repeat Labels Yes

Columns.Page Break on Shadow Pages

If the object is too wide, the remaining contents will be printed on shadow pages.

@ -

| 5
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Special Functions

Various additional functions are available in crosstabs including:
e Crosstab.Value() returns the content of the cell (as a value).
e Crosstab.Cells.Avg() returns the average value of the volume of data.

e Crosstab.Col$() or Crosstab.Row$() returns the description of the column or the row for the current
cell.

With this, you can, for example, assign a particular color to the background of a column or row. The
following example sets the background color to orange for all cells in a row where the cell descriptor
is Germany:

Cond(Crosstab.Row$()=Germany,LL.Color.Orange,LL.Color.White)

Customer turnover per year and quarter

2008 2009 2010 Total

Q3 Q4 Q1 Q2 &3 Q4 (u]| Q2
Germany 1,086 1,208 851 491 3636
Mexica 492 3,038 2,562 1,277 514 7883
Sweden 2,102 3,429 5531
UK 480 1,352 2,143 1,704 5579
Total 2102 972 4781 3038 Al 4189 851 1006 22729

e Crosstab.Cells.Max() or Crosstab.Cells.Min() returns the largest or smallest value in the entire crosstab.
With this, you can, for example, emphasize the largest or
smallest value of the volume of data or perform calculations. The following example sets the
background color of the cell with the largest value to green:
Cond(Crosstab.Value=Crosstab.Cells.Max(),LL.Color.Green,
Cond(Crosstab.Row$()=Germany,LL.Color.Orange,LL.Color.White))

Customer turnover per year and quarter

2008 2009 2010 Total

Q3 Q4 o1 a2 a3 Q4 o) Q2
Germany 1,086 1,208 851 491 3636
Mexico 402 3,038 2,562 1,277 514 7883
Sweden 2,102 3,429 5531
UK 480 1,352 2,143 1,704 5679
Total 2102 972 4781 3038 5791 4189 851 1006 22729

e Crosstab.Col() or Crosstab.Row() returns the index of the column or the row for the current cell. Here,
for example, you can set the background color of alternate rows thereby producing a zebra pattern.
Example: Cond(Odd(Crosstab.Row()),LL.Color.LightGray,LL.Color.White)
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Customer turnover per year and quarter

2008
a3 Q4 Qi
Germany
Mexico 492
Sweden 2,102 3,429
UK 480 1,352
Total 2102 972 4781

2009
o2 Q3
1,086
3,038 2,562
2,143
3038 5791

20
04 o
1,208 851
1,277
1,704
4189 851

10

a Total
491 3636
514 7883

5531
5679
1006 22729

e Join$() returns a collection of strings, separated by a particular character. For example, you can

output the individual turnover amounts in addition to the total turnover. Example:
Fstr$(Sum(Order_Details.Quantity*Order_Details.UnitPrice),-## ### ###) + [+
Join$(Fstr$(Sum(Order_Details.Quantity*Order_Details.UnitPrice),-## ### ###)) +]

Customer turnover per year and quarter

2008
03 Q4 Q1
Germany
i 492
Mexico [29; B89; 492]
2,102 [f’;ﬁ.
f248; 208, 2,222, 2,534;
Sweden 1,189; 1,489; ' 5 i
1,532; 1,916; 2,908; 3,023;
‘ 2 Jmé] ' 3,254 3,341;
' 3,429]
1,352
UK 480 [96; 291;
[90; 480] 899; 1,052;
1,352]
Total 2102 872 4781

2008
Q2 Q3

1,086
[684; 1,062;

1,086)]

3,038 2,562
[690; B&1; [70; 140;
1,931, 2,115; 480; 1,182;

2,213; 3,038] 1,742; 2,562]

2,143

[238; 1,208;

1,508; 2,008;
2,143]

3038 5791

Q4 al

1,208
[878; 938;
1,208]

851
[825; B851]

1,277
[320; 1,257;
1,277]

1,704
[S04; 1,284;
1,704]

4189 851

2010

az Total
491
[400; 491] *F
514
[42; 102; 78683
166; 514]
5531
5679
1006 22729

e You can use Total() for calculations across all cells. Otherwise, calculations are always made across all

values that affect the respective cell.
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Gateway

All new electronically submitted reports flow through the Gateway. It serves as an inbox, where
designated Gateway Administrators and Gateway Approvers assess each electronic report before
accepting it into Perspective or deleting it from the system.

Electronic reports in the Gateway can be submitted from a number of sources. If your organization uses
Perspective e-Reporting or Portal, Incident reports may be submitted from a workgroup'’s e-Reporting
Web page. Otherwise, Incident, Item, Person, Organization, and Vehicle reports may be imported using
Perspective’s built-in Import Manager. Imports may originate from a computer, Web site, PDA, mobile
phone, or any electronic medium that enables creation and transfer of files in XML format.

Once the Gateway Administrator and Gateway Approver have been granted appropriate user rights by the
System Administrator, they will have access to the Gateway and the electronic reports stored in it. Their
respective roles involve the authority to review these reports and perform their associated functions.

Gateway Administrator and Gateway Approver both can:

Edit Incident reports (or e-Incidents).

View imported Item, Person, Organization, or Vehicle reports.

Make the imported reports available for authorized users to add to the Perspective database.

Delete the imported reports from the system.

Only Gateway Administrator can: Only Gateway Approver can:

Assign e-Incidents to the Gateway Approver for = Accept e-Incidents into Perspective as valid
follow-up. incidents.

. Send e-Incidents back to the Gateway Administrator
Delete e-Incidents from the system. .
for reassignment.

Store e-Incidents in a Pending folder for review at a
later date, if they contain insufficient information to
accept or reject them.
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User Interface

The Gateway interface is divided into three sections:

1. Navigation pane: Allows you to move between various types of Gateway electronic reports
corresponding to the major Data Forms (i.e., Incidents, Items, Persons, Organizations, and Vehicles).
To display folders containing reports for a particular Gateway report type (i.e., New, Assigned,
Accepted, Pending, Rejected, and Deleted for Incidents; and New, Available, Added, and Deleted for
Items, Persons, Organizations, and Vehicles), choose the required banner from the Navigation pane.
Click on a folder in the Navigation pane to see all the reports contained within it listed in the Listing
pane. If more than one workgroup'’s electronic reports are contained in the folder, subfolders for the
appropriate workgroups will be listed beneath the folder name in the Navigation pane. Expand the
All Workgroups subfolder and select a workgroup to see only its particular reports in the Listing
pane.

2.  Listing pane: Provides a list of electronic reports selected in the Navigation pane for viewing. On the
right side of every report entry the system records a corresponding source of a report’s import (e.g.,
e-Reporting). Once you select an e-Report in the Listing pane, the report’'s contents will be displayed
in the Viewing pane on the right. (For Incident e-Reports, the submitted XML data is saved under the
Attachments tab.)

3. Viewing pane: Displays the contents of an e-Report selected in the Listing pane and provides
options for saving, editing, assigning, deleting, accepting, rejecting, and closing individual reports, as
well as transferring them into Available or Pending modes and viewing their XML versions. Every
Incident report consists of a set of tabs (i.e., General, Involvements, Narratives, Attachments,
Controls, and Audit History), while data for every Item, Person, Organization, and Vehicle report is

provided on one simple form.
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Note: If a folder in the Navigation pane contains more than 1000 e-Reports, you must first filter the report
list before viewing it in the Listing pane. Once you click on the folder in the Navigation pane, a pop-up
window will appear allowing you to filter the e-Incident list.

To display the top 1000 e-Reports (based on the reports’ identification numbers), click Start Search. Click
OK to transfer the list to the Listing pane.

To search for a particular e-Report or a set of e-Reports, set specific filtering criteria:

1. In the Field Name lookup list, select the field that you want to set as the main criterion for

narrowing your e-Report list.

2. Choose an Operator for the field (e.g., Equal, Not Equal, After, Begins With, Like, etc.).

3. Enter the compared criterion Value. If the Selector button = is available, click it to display a tree of
Value options in a separate window. Note that you may choose any node of the tree as the defining
criterion, making your comparison value as narrow hierarchically as you want.

4.  If you want to include a second field as an additional filtering criterion, select the And or Or radio

buttons and complete the Field Name, Operator and Value fields below. You may add as many

filtering criteria as you want. To remove a field from your filtering criteria, click the Delete button [i]
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5. By default, only the top 1000 reports matching the criteria that you set will be displayed. To display

more or less, adjust the number in the Top field (from 1 to 2000).

6. Click Start Search to generate a list of reports matching your filtering criteria. A count of the
number of e-Reports in the list, as well as the total number of e-Reports matching your filtering

criteria, will be displayed at the bottom of the window.

7. To make changes to the ongoing search, click Stop Search first, and then make the necessary

changes to the filtering criteria.

8.  When you are satisfied with the list of e-Reports displayed, click OK to transfer the list to the Listing

pane in the Gateway.

P =

Field Name Operators
Class =] [NotEaual =)  [NonCrmina [w]@m o
Fisd Mams Operstors
[elncident Number | [Begns Wih -] GpA ©® Ad @ or
Field Name Operators
Occuned From Date/Time v | [Before -] [1o0uzon - E| X ©Ad @ or
‘| - »
Top: [1000 = Start Search | | Stop Sesrch
elncident Number  Reported  Occurred  Class Rellup Site Rellup State SubmitID stiachment
GrpA-2008-10-00007 ‘277102009 27/10/2009 * Procedural/Emergency  Site ABuilding 2llocati.  New cReportng 1
Grpd-2006-10-00008 27102008 2711052009 ProceduraliE Hew BrunswickiSaint /. New eRepering 1
Grph2010-10-0000T 12702010 1210/610  Criminall ThetCampany New “eRepering ™
GrpA-2010-10-00002 1202010 1211072010  ProceduraliSecurity & S Alberta New cReporing 1
0 )
Sesrch Resuits: 4 of 4 Records oK Cancel
Incident

Under the Incidents banner, the following folders will be displayed:
) New: New e-Incidents that have not yet been assessed.
e Assigned: e-Incidents assessed and assigned to a Gateway Approver for follow-up.

e Accepted: e-Incidents that have been accepted into Perspective as valid Incident records by the
Gateway Approver assigned to them (the only e-Incidents not available for editing).

e  Pending: e-Incidents that require further information before being assigned or deleted.
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*  Rejected: e-Incidents that have been returned to the Gateway Administrator by the Gateway
Approver.

o Deleted: e-Incidents that have been marked for deletion upon purge. These can be re-assigned by
the Gateway Administrator before the purge occurs.

Note: Not all folders will be visible to the Gateway Approver.
After selecting an e-Report in the Incidents Listing pane of the New folder, you can use the buttons

available on the Viewing pane toolbar to perform a number of report functions.

Common functions available for both Gateway Administrator and Gateway Approver:

&l Save Preserves the changes you made to an e-Report.

¥ Edit Transfers an editable e-Report into the editing mode.

After clicking Edit, select the field you want to edit and make the necessary change.
Editing of e-Reports functions similarly to the data entry in Incidents data forms,
including the use of a similar set of sub-tabbed toolbar functions, like Edit, Add New,
Remove and Read/View. Remember to complete every report editing action with
saving the changes applied to the report by clicking Save on the Viewing pane
toolbar.

Note: For further details on the sections of the e-Incident report and functions
performed by the toolbar functions that are available for certain sub-tabs (i.e., Involved
Persons, Organizations, Vehicles, and Items), see the Incidents and Common Record
Functions chapters.

Note: The only editing function that is exclusively under the authority of the Gateway
Administrator is setting of the e-Incident’s security controls in the Controls tab (access
level, organizational rollup and workgroup visibility). Although the e-Incident will have
some default security controls, the Gateway Administrator may choose to re-set these in
order to restrict both the Gateway Approver the e-Incident is assigned to (the Approver’s
access rights must match those of the e-Incident in order to assess it), as well as users
who have access to the record within Perspective if it is accepted as a valid Incident
record.

k4 Close Exits the e-Report without saving changes.

Functions available for Gateway Administrator only:
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Assigns the e-Incident to the Gateway Approver for further review by transferring the

= Assign e-Incident to the Assigned folder.

Once you click the Assign button, a pop-up confirmation window will appear. Make
any necessary notes on the assignment of this e-Incident in the Comments text box.
Your notes will appear in the Reviews section of the e-Incident under the General tab.
Click Assign to confirm your choice.

Note: The Gateway Approver’s access rights must match those designated under the
e-Incident’s Controls tab.

Deletes an e-Incident as an invalid submission by transferring the e-Incident to the
@ Delete Deleted folder.

Once you click the Delete button, a pop-up confirmation window will appear. Make
any necessary notes on the deletion of this e-Incident in the Comments text box.
Your notes will appear in the Reviews section of the e-Incident under the General tab.
Click Delete to confirm your choice.

Note: e-Incident can be recovered anytime prior to the end of Deleted Retention
Period specified for the e-Incident’s workgroup by the System Administrator.

Functions available for Gateway Approver only:

€ Accept Accepts an e-Incident into Perspective as a valid Incident record, by transferring it to
the Accepted folder. The accepted e-Incident will be available to users whose access

rights match those designated under the e-Incident’s Controls tab.

Once you click the Accept button, a pop-up confirmation window will appear. Make
any necessary notes on the acceptance of this e-Incident in the Comments text box.
Your notes will appear in the Reviews section of the e-Incident under the General tab.
Click Accept to confirm your choice.

A dialog box will appear displaying the e-Incident’s new Perspective Incident
Number. For cross-referencing purposes, both the original e-Incident Number (e.g.,
INC-2010-000269) and the new Incident Number (e.g., EINC-2010-12-00001) will
appear under the Record Information in the General tab of both the e-Incident record
and the actual Incident data form. Click OK.
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Note: The accepted e-Incident will be purged from the Gateway at the end of the
Accepted Retention Period specified for the e-Incident’s workgroup by the System
Administrator. The original e-Incident form will remain in Perspective as an attachment

to the newly created Perspective Incident record.

& Reject

Sends an e-Incident back to the Gateway Administrator for further review by
transferring it to the Rejected folder, so that it could be re-assigned or deleted.

Once you click the Reject button, a pop-up confirmation window will appear. Make
any necessary notes on the rejection of this e-Incident in the Comments text box.
Your notes will appear in the Reviews section of the e-Incident under the General tab.
Click Reject to confirm your choice.

To evaluate the reasons for the e-Incident’s rejection by the Gateway Approver, edit
the e-Incident, and/or delete or assign it again, the Gateway Administrator hat to
access the rejected e-Incident from the Rejected folder.

Pending

Sets an e-Incident to Pending status, by storing it in the Pending folder. This function
is used when there is insufficient information to accept or reject the e-Incident, and
the Gateway Approver intends to make its review at a later date.

Once you click the Pending button, a pop-up confirmation window will appear. Make
any necessary notes on the pending of this e-Incident in the Comments text box.
Your notes will appear in the Reviews section of the e-Incident under the General tab.
Click Pend to confirm your choice.
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When an incident is submitted using e-Reporting or Portal, you must manually link the name of the driver
(Vehicles), supervisor (Incident General), notified by person (Organizations), or the owner, person, or
organization (Items), in Gateway. This is done by clicking the plus icon 5.

Then, select the corresponding record from the pick list. If a record does not already exist, use the Quick
Add function to create one.

Note: If this is not done before acceptance to Perspective, the information will not get transferred into
Perspective.

Driver - Full Name Driver 1D
[ John Smith e [&]l

Items, Persons, Organizations and Vehicles

Note: Item, Person, Organization, and Vehicle reports can only be imported to the Gateway using the Import
Manager.

To view imported Item, Person, Organization, or Vehicle reports, click on the appropriate banner in the
Navigation pane. The following folders will be displayed:

) New: New imported reports that have not yet been assessed.

e Available: Imported reports that have been deemed valid, and made available for authorized users
to add to the Perspective database.
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Added: Imported reports that were first made available within Perspective, and then added by
authorized users to the database as valid Item, Person, Organization, or Vehicle records.

Deleted: Imported reports that have been marked for deletion upon purge. These can be made
available for adding to the database before the purge occurs.

After selecting an e-Report in the appropriate Listing pane of the New folder, you can use the buttons

available on the Viewing pane toolbar to perform the three basic report functions that are available for

both the Gateway Administrator and the Gateway Approver.

> Available

Makes a report available for authorized users to add to the Perspective database,
while transferring it to the Available folder. If an authorized user chooses to add a
new record to one of the Data Forms components, the data in the added report will
be displayed as available for adding. Simultaneously, the report will be moved from
the Available folder to the Added folder.

At the end of the Added Retention Period specified for the report’s workgroup by
the System Administrator, the imported report will be purged from the Gateway.
However, the original XML report will remain in Perspective as an attachment to
the newly created Perspective Item, Person, Organization, or Vehicle record.

]

Delete

Deletes a report from the Gateway as invalid.

Once you click the Delete button, a pop-up confirmation window will appear.
Choose the Mark As Delete radio button to store the imported report in the
Deleted folder, where it can be recovered at any time prior to the end of the
Deleted Retention Period specified for the report's workgroup by the System
Administrator. Otherwise, choose the Immediate Delete radio button to

permanently delete the report. Click Delete to confirm your choice.

xran

XML View

Displays the imported report in its original XML format including hidden data, if
available. Click the XML View button again to return to the standard view.
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. Persons
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«{ii] Deleted(0] Workgroup B
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~

\_} Dispatchlog
B Data Forms
Hll| Repor=
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Note: When an incident is in the Gateway
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DispatchLog and Dispatch

For more information on DispatchLog, the built-in Perspective dispatch component, see the Perspective
DispatchLog User’s Guide on the Resolver Support site.

For more information on Dispatch, the separately managed application, see the Dispatch User's Guide
and Dispatch Administrator’s Guide.
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Visual Analysis

Welcome to Perspective Visual Analysis™, an optional component of Perspective by Resolver. Perspective
not only records and tracks incident data, but assesses and analyzes it to chart trends and report statistics.
Visual Analysis complements Perspective by enabling it to render data relationships into powerful visual

elements.

The resulting visual data can be easily analyzed and interpreted, bringing clarity to complex investigations
and scenarios. Seemingly unrelated events are mapped, and new connections are found. Perspective
Visual Analysis significantly increases the productivity of your investigators saving time and resources
along the way.

Use Visual Analysis to Build a Link Chart

Using dynamic link analysis, Perspective Visual Analysis reveals the complex, and seemingly disparate,
associations hidden amidst hundreds, even thousands, of incidents, cases, items, persons, organizations
and vehicles.

The complex relationships that exist between your data are mapped in easy-to-read link charts. You can
zero in on specific information, or keep expanding the web until all avenues have been explored. To save,
print, or copy your link charts, transfer them into IBM i2 ChartReader and continue to view the

associations in your Perspective data.

Perspective Visual Analysis was developed in an exclusive partnership between Resolver and IBM i2—the
world'’s leading provider of Visual Investigative Analysis software for law enforcement, intelligence,

military, and Fortune 500 organizations. All of the visualizations created in Perspective Visual Analysis can
be carried into IBM i2 applications, including Analyst’s Notebook. From there, you can connect to other

databases in your organization for advanced analysis and in-depth visual analytics.
For more information on IBM i2 products, or to download i2 ChartReader, visit the following links:

e Short link:
http://ibm.co/W8rK1l.

e Long link:

http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s
=&k=ALL&pid=8&q=Chart+Reader+&ibm-search=Search&pf=8&b=8q0=.
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Access Visual Analysis

1. Log on to Perspective.

2. In the Navigation pane, open the Data Forms component and choose the record entity that you
want to view (i.e., Activities, Incidents, Cases, Items, Persons, Organizations, or Vehicles).

3. Set your record view for the Listing pane using the Quick View, Saved Views, or All Records View
function. If your Perspective system contains a large number of records, it is recommended that you
use the Quick View or Saved Views function.

4. Inthe Listing pane, find and select the record you want to build your link chart from.

5. Click the Visual Analysis icon @'® on the Ribbon. A separate window for Perspective Visual Analysis
will open with the selected record displayed as an icon in the center.

Create a Link Chart

1. Right-click the icon in the center of the Visual Analysis window, and select Show Relationships.

5 Perspective Visual Analysis [= ===

AHDx a0 RISE B 3 41— o |

-

JEEOLINL

m

Invert Selection

‘Bhow Relationships
Show Record k

T

@)

&

< n r
Do more with this chart

2. Alink chart of related records will appear in the window, with the original record at the center.

Right-click any icon in the link chart, and then select one of the following options:

e Invert Selection: Selects all records except the current one.
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e Show Relationships: Displays all Incident, Case, Iltem, Person, Organization, or Vehicle records

linked to the selected record.

e Show Record: Opens the selected record in Perspective. (The Visual Analysis window may still

be open in the foreground. In this case, minimize the Visual Analysis window to view the record

in Perspective.)
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i/ ‘Show Relationships S
ADMI-2010-000124 Show Record le =
b (T b (7]
Do more writh this chart

3. Click on the top toolbar options to customize the appearance of your chart for clear visual analysis,

or to find, select, or remove a particular record from your chart:

=2 Print on Prints all details of your chart on a single page.
=
- Single Page
= Print at 100% Prints your chart at 100% scale, which would usually occupy more than
=

Scale

one page.

i Page Setup

Enables you to adjust margins and page setup settings before printing.

Delete
Selection

Removes the highlighted record(s) from the chart.

i} Undo Delete

Brings back the record(s) that were just deleted.

. Key Entity

Emphasis

Enlarges the central records in your link chart placing focus back on

them. Click again to restore the central records to regular size.
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. Enables dragging of the entire link chart allowing you to quickly view
o Panning Tool )
different areas of the chart.

Click the Zoom to Area button, and then click and drag on the chart to
N Zoom to Area | select an area with the help of the mobile zoom box. The window will fill
with an enlarged display of the selected area.

: . . Fits the entire link chart in the window, making it easier to see the
Fit to Window T
overall shape and the number of connections in the chart.

Click and drag on the chart to select an area of interest with the help of

) . a box. Alternatively, select multiple records holding down the Ctrl key
. Fit Selection o . . ) ) )
i . while clicking the record icons. Then, click the Fit Selection to Window

to Window . A ]
button. The window will fill with all records that are currently selected in

the link chart.

il Select All Selects all the records in the link chart.

) Changes the arrangement of the record icons restoring the link chart to
2 Reorganize ) -
its original layout.

Searches for a chart entity and/or link that contains a particular string of
text. The Find function only searches the text displayed in the window; it
does not search actual records. Once you click the Find button, the Find
dialog will open.

a. Type the search text in the Find Text field.

b. Choose to search Entities (e.g., incident numbers, person names,
license plate numbers), Links (e.g., suspects, associates, subjects of
interest), or Both.

13_‘;“ Find c. Select Exact Match to only search for text that matches the search

string precisely.

d. To execute your search, click OK. The window will select and zoom

in on any entities and/or links matching your search criteria.
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Zoom

Click and drag the slider back and forth to zoom the window in and out.

4.  Click the buttons on the right toolbar to hide particular entities from your link chart. By default, these
entities are displayed in your link chart. Click again to restore the original link chart layout and/or to

re-display the entities.

= Case Hides cases from your link chart.
¥y Incident Hides incidents from your link chart.
4 Activity Hides activities from your link chart.
== Item Hides items from your link chart.

Organization

Hides organizations from your link chart.

Person

Hides persons from your link chart.

Vehicle

Hides vehicles from your link chart.

Involvements

Hides involvements from your link chart. Involvements, represented
by red connecting lines, show that an item, organization, person, or
vehicle was involved in a particular incident (e.g., Suspect,
Responding Service, Indirectly Involved).

Associations

Hides associations from your link chart. Associations, represented by
black connecting lines, show that particular incidents, cases, items,
organizations, persons, or vehicles are associated with each other by
relationship or ownership (e.g., Alias, Contracted To/By, Similar
M.O.).

e

Timeline

Transfers your link chart into the timeline mode (see the image
below). All entities and links will be reorganized sequentially,

allowing for time series analysis.
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Use IBM i2 ChartReader to Manipulate Your Link Chart

After using Perspective Visual Analysis to build and develop your link chart—customizing its appearance
to suit your needs—you can use IBM i2 ChartReader to share your chart with other people in your

organization, or at the very least, to save or print your chart for access at a later date.

If ChartReader is not already installed on your computer, you can download the product from the IBM i2

website:

e Short link:
http://ibm.co/W8rK1l.

e Longlink:

http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=8&s
=&k=ALL&pid=8&q=Chart+Reader+&ibm-search=Search&pf=&b=8&q0=.

ChartReader offers many of the same navigation functions as Visual Analysis, allowing you to zoom in and

out on particular areas of your chart, resize your chart to fit your screen, and search for information

contained within your chart. However, ChartReader does not have any editing functionality. You cannot
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add, eliminate, or reorganize chart items, and you cannot access any of your Perspective data to
supplement your chart.

Ensure that your chart is complete when you transfer it into ChartReader, and then simply use
ChartReader to do the following:

. Save your chart for later access.
. Print your chart using a variety of page configuration and printing options.

. Copy and paste your chart into Windows® applications, including Microsoft® Word, PowerPoint®
and Excel®, for inclusion in reports and other documents.

In other words, use Perspective Visual Analysis to create and develop your visual research, and then
employ ChartReader to document it and distribute it to others.

Transfer Your Link Chart into IBM i2 ChartReader

1. Launch ChartReader.

2. Using the record selection options described in the Create a Link Chart chapter, select the chart
items you would like to transfer into ChartReader.

3. Drag and drop the link chart selection into the ChartReader blank window.
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4. A status bar will appear, indicating that ChartReader is in the process of transferring your link chart.
ChartReader uses another IBM i2 product, Online iLink, to retrieve data from online sources. When
the bar disappears, your link chart will appear in the ChartReader window. There may be some
differences in the icons used to represent the chart’s entities.

5. Open the ChartReader's Help menu to learn how to save, copy, and print your chart, as well as how

to perform other relevant charting functions.
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Additional IBM i2 ChartReader Resources

In addition to the online Help provided in ChartReader, the following documents are included with
ChartReader’s download in PDF format:

Embedding in a Web Page: Contains instructions for embedding charts into Web pages.

o User Guide: Provides detailed information about working with ChartReader.

o Release Notes: Includes information on ChartReader’s latest features and updates.

o i2 Online iLink Release Notes: Supplies details on Online iLink’s most recent release. Online iLink is
the program used to transfer data from Perspective Visual Analysis to ChartReader.

For more information on IBM i2 and its products, visit the links below:

e Short link:
http://ibm.co/W8rK1l.
e Long link:

http://www14.software.ibm.com/webapp/download/nochargesearch.jsp?S_TACT=&S_CMP=&s
=8&k=ALL&pid=8&q=Chart+Reader+&ibm-search=Search8pf=8b=8q0=.
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Appendix A: Dashboard Chart Types

The Dashboard component of Perspective can be populated with up to four charts that show trends and
statistics for a selected portion of records found in Perspective’s database for a specified period of time.
The data you may select for display include the following chart types.

Displays the number of incidents by the specified number of
Incident by Class incident classes (e.g., Criminal, Procedural, Policy Violation) that
have taken place during the specified period of time.

. ) Displays the number of incidents by the specified number of
Incident by Business ] ) ) )
business units (e.g., North America, Europe, Asia) that have taken

Unit . o . .

place during the specified period of time.

Displays the number of incidents by the specified number of sites
Incident by Site (e.g., Alberta, Ontario, British Columbia) that have taken place

during the specified period of time.

. Displays the number of incidents by the specified number of
Incident by o
L organizations (e.g., Edmonton, Leduc, Sherwood Park) that have
Organization . o . .
taken place during the specified period of time.

Incident By Class Rollup

. Criminzl
Men-Criminal

B Policy Viokat..

B s«

. Procedural

ceee

s Displays the number of activities with an Open status arranged by
Activities by Number of ] ] ) o
the set periods of time for which the Activity records have been
Days Open
open (e.g., >14-29 days, >30-59 days).
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Cases by Number of
Days Open

Displays the number of cases without a Closed Date/Time arranged
by the set periods of time for which the Case records have been
open.

Incidents by Number of
Days Open

Displays the number of incidents with an Open status arranged by
the set periods of time for which the Incident records have been
open.

Investigations by
Number of Days Open

Displays the number of investigations without a Closed Date/Time
arranged by the set periods of time for which the investigations
have been open.

When one of these charts is displayed on the Dashboard, you may choose to view the

Activity/Case/Incident/Investigation data filtered for a specific user. To filter the Activity data for

a Record Owner, the Case, the Incident data for a Case Investigator/Case Manager/Case

Supervisor, or the Investigation data for an Investigator, click on the plus icon & in the chart

section and select the required user from the entity list. To reset the filter and show the data

that applies to all users in the system, click the x icon =)

Activities By # of Days Open

B e

=30-59

B 0179

Activities by Month

Displays the number of the specified portion of activities that have
been recorded in each of the twelve months of the selected year. If
no data has been recorded for a specific month, it will be absent

from the chart.

Incidents by Month

Displays the number of the specified portion of incidents that have

been recorded in each of the twelve months of the selected year. If
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no data has been recorded for a specific month, it will be absent
from the chart.

Investigations by
Month

Displays the number of the specified portion of investigations that
have been recorded in each of the twelve months of the selected
year. If no data has been recorded for a specific month, it will be
absent from the chart.

Cases by Month

Displays the number of the specified portion of cases that have
been recorded in each of the twelve months of the selected year. If
no data has been recorded for a specific month, it will be absent
from the chart.

120

a0

0

83
B9
B1
16
Al May June July

Aciivities By Month

August Sepiember

Loss by Month

Shows the monetary losses (Total Loss, Total Recovered, and Net
Loss), in dollars, resulting from the selected portion of incident
activity in each of the past twelve months of the specified year. This
chart is only available in the bar chart form.

8000

6000

4000

2000

Loss By Month - 2010-$

B ol Loss

[ ol Recove..

[ vetLoss
Movember Dimcmmber
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Open Activities by
Disposition

This preset chart does not have any further chart settings and is
only available in the bar chart form. It displays the number of
activities with an Open status colour-coded for specific Disposition
(e.g., Under Investigation) and arranged by the set periods of time
for which the Activity records have been open (e.g., >14-29 days,
>30-59 days).

Open Incidents by
Disposition

This preset chart does not have any further chart settings and is
only available in the bar chart form. It displays the number of
incidents with an Open status colour-coded for specific Disposition
(e.g., Unsolved) and arranged by the set periods of time for which
the Incident records have been open.

Open Cases by
Disposition

This preset chart does not have any further chart settings and is
only available in the bar chart form. It displays the number of cases
without a Closed Date/Time colour-coded for specific Disposition
(e.g., Active) and arranged by the set periods of time for which the
Case records have been open.

When one of these charts is displayed on the Dashboard, you may choose to view the

Activity/Case/Incident data filtered for a specific user. To filter the Activity data for a Record

Owner, or the Case or Incident data for a Case Investigator/Case Manager/Case Supervisor,

click on the plus icon 5 in the chart section and select the required user from the entity list. To

reset the filter and show the data that applies to all users in the system, click the x icon =]

|I&' |§|
10

(2]

Open Activities By Disposition

. Unspecified
|:| Active
. Approved
. Inactive
|:t I I - Under Invest...
7 713 1429 3085 6089 SO-175 =180

Open Assignments by
Due Date

Displays the number of assignments that have not been checked
off as Completed arranged by their closeness to the Due Date (e.g.,
Overdue, Tomorrow, Others).
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Displays the number of assignments that have not been checked
T off as Completed arranged by specific assignment Type (e.g.,
e
yp Correction Notice, Information Request).

Open Assignments by

When one of these charts is displayed on the Dashboard, you may choose to view the Incident,
Case, and Activity assignment data that have been filtered for a specific recipient of
assignments. To filter the data for a specific Assigned To user, click on the plus icon 5 in the

chart section and select the required user from the entity list. To reset the filter and show the

data that applies to all users in the system, click the x icon 2]

|c'.'lu||§| Open Assignment By Type
80
61
£0
40
28 3
= 11
.
0 —_— el
g g z z 7 3
Resembles an automobile speedometer gauge, displaying the
proportion of the number of incidents that has been recorded for
the current year to the number of incidents that had been recorded
in the year of your selection effectively comparing the two values.
You can change the compared to year using the chart’s attached
lookup.
The Total Year diagram compares the number of incidents for the
Perspective Gauge total calendar years (e.g., the periods of January 1 to December 31).

The Year to Date diagram compares the number of incidents for
the years to the current date (e.g., if today’s date is October 1, then
it will compare the periods of January 1 to October 1 only).

The This Month diagram compares the number of incidents for
the current month (e.g., if today is October, then it will compare the

months of October only).
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Appendix B: Text Editor Navigation

In Perspective, there are four types of text editor windows: Narrative Editor, Summary Editor, Interview
Editor, and Send Message. The corresponding editors enable entering and editing of (typically) large
texts that convey incident or case narratives, investigation summaries and interviews, and descriptive
email messages. Typing the content of a narrative, summary, interview, or email, you can format your text
with any of the options available under the editor’s tabs (e.g., Narrative, Import/Export, Tools, and

Spelling).

[Zr | [ = | Marrative Editor = | B ||
MNarrative ImportiExport Tools Spelling
J g @% s ]il I undo (g ;g ) . - Author  Richards, Keith 5| | © Sealed
u i Redo Narrative Type
A t& Cancel & Cut Copy Paste = — -
ég?fm Return P MNormal Page Siyle Float el -
Document Edit Text Style Narrative
Brial Namow - 12 v = [ i [ T 100%  ~ [Nomal] -
1 Z 3 4 5 Gl T
L '""'..F"""..""".."""i.""".."""..""".'.""".."""L""‘...'"'

November 25, 2010

+  Onthe 23rd of November, 2010, securty receved a call from the complainant Kathy Howard. Howard stated that her
corporate laptop had been stolenduring a break the previous day, 22nd of November, 2010, while she was away from
her desk.

«  On returning from her lunch break, she found her laptop missing.

m

+ Her PDA was still on her desk. Miss Howard advised that there were noother employees around her area except for
Jeff Bidivn, who is seated in Section 3B of the same office (diredtly across from section 44). Howard stated that she
asked Jeff Brown of he ha